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Notices

BioTek Instruments, Inc.

Highland Park, P.O. Box 998

Winooski, Vermont  05404-0998  USA

All Rights Reserved

© 2012, BioTek® Instruments, Incorporated.  No part of this publication may be 
reproduced, transcribed, or transmitted in any form, or by any means electronic 
or mechanical, including photocopying and recording, for any purpose other 
than the purchaser’s use without written permission of BioTek Instruments, Inc.

Trademarks

BioTek® is a registered trademark and MultiFlo™ Microplate Dispenser is a 
trademark of BioTek Instruments, Inc. 

Microsoft®, Internet Explorer®, Windows®, Windows 7, Windows Vista®,  
Windows XP, and Excel® are either registered trademarks or trademarks of 
Microsoft Corporation in the United States and/or other countries. 

All other trademarks are the property of their respective holders.

Restrictions and Liabilities

Information in this document is subject to change and does not represent a 
commitment by BioTek Instruments, Inc. Changes made to the information in 
this document will be incorporated in new editions of the publication.  No 
responsibility is assumed by BioTek for the use or reliability of software or 
equipment that is not supplied by BioTek or its affiliated dealers.
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Contact Information

BioTek Instruments, Inc.
Highland Park, P.O. Box 998

Winooski, Vermont  05404-0998  USA

Customer Service and Sales

Internet: www.biotek.com

Phone: 888-451-5171 (toll free in the U.S.)

802-655-4740 (outside the U.S.)

Fax: 802-655-7941

E-Mail: customercare@biotek.com

Service/TAC

Phone: 800-242-4685 (toll free in the U.S.)

802-655-4740 (outside the U.S.)

Fax: 802-654-0638

E-Mail: tac@biotek.com

European Coordination Center/Authorized European Representative 

BioTek Instruments GmbH

Kocherwaldstrasse 34

D-74177 Bad Friedrichshall

Germany

Internet: www.biotek.de

Phone: +49 (0) 7136 9680

Fax: +49 (0) 7136 968 111

E-Mail: info@biotek.de
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Document Conventions

This manual uses the following typographic conventions:

 n This note format calls attention to important information.

Warnings are presented in this style to call attention to potential hazards and other 
safety concerns.

 

This icon calls attention to important safety information.

 Tips and suggestions for improving performance are formatted this way.

 n Water: Daily maintenance is the key to keeping the liquid handler performing 
to specifications. In the maintenance procedures provided in this manual, the 
requirement to use distilled (dH2O) or deionized (DI) water can be met by 
numerous water purification methods, including MilliQ™. A minimum water 
purity of 2mOhm is expected.

Revision History

Rev Date Changes

A 10/2010 First Issue

B 9/2012 Added support for 0.5 µL dispensing. Added more precise 
instructions for handling 1536-well flanged plates (153F). Added 
warning about the effects of exposing silicone tubing to DMSO and 
Acetonitrile to the chemical compatibility table. Revised the 
Syringe dispenser performance specifications to correct for minor 
mismatches with BioTek's published specifications. Defined the 
water purity expectations for maintenance procedures and 
changed all references to "DI water" to "deionized or distilled 
water." Updated IVD notice.

BioTek Instruments, Inc.
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Warnings

Use the instrument on a level, stable surface away from excessive humidity.
When operated in a safe environment, according to the instructions in this 
manual, there are no known hazards associated with the MultiFlo. However, the 
operator should be aware of certain situations that could result in serious 
injury:  Do not reach into the instrument during operation, as the peristaltic 
pump (Peri-pump) pump barrel may pinch your fingers. Do not reach for the 
microplate carrier until it is in its home position.

 Strict adherence to instrument maintenance and qualification procedures is 
required to ensure accurate dispense volumes and risk-free operation. 

Intended Use Statement

 l The MultiFlo™ Microplate Dispenser can operate as a stand-alone instrument or with 
standard robotic systems, such as BioTek’s BioStack™ Microplate Stacker.  

 l If the instrument has an "IVD" label it may be used for clinical and non-clinical purposes, 
including research and development. If there is no such label the instrument may only be 
used for research and development and non-clinical purposes.

Quality Control

It is considered good laboratory practice to run laboratory samples according to 
instructions and specific recommendations included in the assay package insert for 
the test to be conducted. Failure to conduct Quality Control checks could result in 
erroneous test data.

Warranty and Product Registration

Please take a moment to review the Warranty information that shipped with your 
product. Please also register your product with BioTek to ensure that you receive 
important information and updates about the product(s) you have purchased. 

You can register online through BioTek’s Customer Resource Center (CRC) at 
www.biotek.com or by calling 888/451-5171 or 802/655-4740.

Repackaging and Shipping

If you need to ship the instrument to BioTek for service or repair, contact BioTek 
for a Return Materials Authorization (RMA) number and use the original packing 
materials. Other forms of commercially available packaging are not recommended 

MultiFlo™ Microplate Dispenser
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and can void the warranty. If the original packing materials have been damaged or 
lost, contact BioTek for replacement packing.

BioTek Instruments, Inc.
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Hazards and Precautions

Hazards

The following hazards are provided to help avoid injury:

 
Warning! Power Rating. The instrument’s power supply or power cord must 
be connected to a power receptacle that provides voltage and current within the 
specified rating for the system. Use of an incompatible power receptacle may 
produce electrical shock and fire hazards.

  Warning! Electrical Grounding. Never use a two-prong plug adapter to 
connect primary power to the external power supply. Use of a two-prong 
adapter disconnects the utility ground, creating a severe shock hazard. Always 
connect the power cord directly to an appropriate receptacle with a functional 
ground.

  Warning! Internal Voltage. Always turn off the power switch and unplug the 
power supply before cleaning the outer surface of the instrument  or removing 
its top case.

  Warning! Liquids. Avoid spilling liquids on the instrument; fluid seepage into 
internal components creates a potential for shock hazard or instrument 
damage. If a spill occurs while a program is running, abort the program and 
turn the instrument off. Wipe up all spills immediately. Do not operate the 
instrument if internal components have been exposed to fluid.

Warning! Potential Biohazards. Some assays or specimens may pose a 
biohazard. Adequate safety precautions should be taken as outlined in the 
assay’s package insert. This hazard is noted by the symbol shown here. Always 
wear safety glasses and appropriate protective equipment, such as chemically 
resistant rubber gloves and apron. 

  Warning! Unspecified Use. Failure to operate this equipment according to 
the guidelines and safeguards specified in this manual could result in a 
hazardous condition.

Warning! Pinch Hazard. Some areas of the instrument or its components can 
present pinch hazards when the instrument is operating. These areas are 
marked with the symbol shown here. Keep hands/fingers clear of these areas 
when the instrument is operating.

  Warning! Software Quality Control. The operator must follow the 
manufacturer’s assay package insert when modifying software parameters and 
establishing reading, washing, or dispensing methods. Failure to conduct 
quality control checks could result in erroneous test data.

  Warning! Service. Only qualified technical personnel should perform service 
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procedures on internal components.
  Warning! Accessories. Only accessories which meet the manufacturer’s 

specifications shall be used with the instrument.

Precautions

The following precautions are provided to help avoid damage to the instrument:

Caution: Service. The instrument should be serviced by BioTek authorized 
service personnel. Only qualified technical personnel should perform 
troubleshooting and service procedures on internal components.

  Caution: Environmental Conditions. Do not expose the instrument to 
temperature extremes. For proper operation, ambient temperatures should 
remain within the range listed in the Specifications section. Performance may 
be adversely affected if temperatures fluctuate above or below this range. 
Storage temperature limits are broader.

  Caution: Sodium Hypochlorite. Do not expose any part of the instrument to 
the recommended diluted sodium hypochlorite solution (bleach) for more than 
20 minutes. Prolonged contact may damage the instrument surfaces. Be certain 
to rinse and thoroughly wipe all surfaces. 

  Caution: Buffer Solution. Although many precautions have been taken to 
ensure that the instrument is as corrosion-proof as possible, the instrument is 
not sealed and liquids can seep into sensitive components. Make sure that any 
spilled buffer solution is wiped off the instrument. Prolonged exposure to salt 
solution may corrode parts of the microplate carrier, movement rail, springs, 
and other hardware.

  Caution: Chemical Compatibility. Some chemicals may cause irreparable 
damage to the instrument. The following chemicals have been deemed safe for 
use in the instrument: buffer solutions (such as PBS), saline, surfactants, 
deionized water, 70% ethyl, isopropyl, or methyl alcohol, 40% formaldehyde, 
and 20% sodium hydroxide. Never use acetic acid, DMSO, or other organic 
solvents. These chemicals may cause severe damage to the instrument. 
Contact BioTek  prior to using other questionable chemicals.

  Caution: Bovine Serum Albumin. Solutions containing proteins, such as 
bovine serum albumin (BSA), will compromise the instrument’s performance 
over time unless a strict maintenance protocol is adhered to. See 
Maintenance procedures regarding BSA.

  Caution: External Power Supply. Only use the power supply shipped with 
the instrument. Operate this power supply within the range of line voltages 
listed on it.

  Caution: Disposal. This instrument contains printed circuit boards and wiring 
with lead solder. Dispose of the instrument according to Directive 2002/96/EC, 
“on waste electrical and electronic equipment (WEEE),” or local ordinances.

BioTek Instruments, Inc.
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  Caution: Warranty. Failure to follow preventive maintenance protocols may 
void the warranty.

  Caution: Shipping Hardware. All shipping hardware (e.g., shipping bracket 
etc.) must be removed before operating the instrument and reinstalled before 
repackaging the instrument for shipment.

  Caution: Do not run the Peri-pump without a cassette installed on the pump.

Caution: Electromagnetic Environment.  Per IEC 61326-2-6 it is the user’s 
responsibility to ensure that a compatible electromagnetic environment for this 
instrument is provided and maintained in order that the device will perform as 
intended.

  Caution: Electromagnetic Compatibility. Do not use this device in close 
proximity to sources of strong electromagnetic radiation (e.g., unshielded 
intentional RF sources), because these may interfere with the proper operation.

 Caution: Spare Parts. Only approved spare parts should be used for 
maintenance. The use of unapproved spare parts and accessories may result in 
a loss of warranty and potentially impair instrument performance or cause 
damage to the instrument.

CE Mark

Based on the testing described below and information contained 
herein, this instrument bears the CE mark.

 n Note: See the Declaration of Conformity for specific information.

Directive 2004/108/EC: Electromagnetic Compatibility

Emissions—Class A

The system has been type-tested by an independent, accredited testing 
laboratory and found to meet the requirements of EN 61326-1: Class A for 
Radiated Emissions and Line Conducted Emissions. 

Verification of compliance was conducted to the limits and methods of EN 55011 
(CISPR 11) Class A. In a domestic environment it may cause radio interference, 
in which case, you may need to mitigate the interference.

MultiFlo™ Microplate Dispenser
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Immunity

The system has been type-tested by an independent, accredited testing 
laboratory and found to meet the requirements of EN 61326-1 and EN 61326-2-6 
for Immunity. Verification of compliance was conducted to the limits and 
methods of the following:

EN 61000-4-2, Electrostatic Discharge

EN 61000-4-3, Radiated EM Fields

EN 61000-4-4, Electrical Fast Transient/Burst

EN 61000-4-5, Surge Immunity

EN 61000-4-6, Conducted Disturbances from RFI

EN 61000-4-11, Voltage Dips, Short Interruptions and Variations

Directive 2006/95/EC Low Voltage (Safety)

The system has been type-tested by an independent testing laboratory and was 
found to meet the requirements of this Directive. Verification of compliance was 
conducted to the limits and methods of the following:

EN 61010-1,  “Safety requirement for electrical equipment for measurement, 
control and laboratory use. Part 1, General requirements.”

EN 61010-2-081, “Particular requirements for automatic and semi-automatic 
laboratory equipment for analysis and other purposes.”

Directive 2002/96/EC: Waste Electrical and Electronic Equipment

Disposal Notice: This instrument contains printed circuit boards and wiring with 
lead solder. Dispose of the instrument according to Directive 2002/96/EC, “on 
waste electrical and electronic equipment (WEEE)” or local ordinances.

Directive 2002/95/EC: Reduction of Hazardous Substances (RoHS)

This instrument is exempt from RoHS requirement per Article 2, Category 8.

Directive 98/79/EC: In Vitro Diagnostics (if labeled for this use)

 l Product registration with competent authorities.
 l Traceability to the U.S. National Institute of Standards and Technology (NIST).

BioTek Instruments, Inc.
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EN 61010-2-101 Particular requirements for in vitro diagnostic (IVD) medical 
equipment.

Electromagnetic Interference and Susceptibility

USA FCC CLASS A

RADIO AND TELEVISION INTERFERENCE

NOTE: This equipment has been tested and found to comply with the limits 
for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits 
are designed to provide reasonable protection against harmful interference 
when the equipment is operated in a commercial environment. This equipment 
generates, uses, and can radiate radio frequency energy and, if not installed 
and used in accordance with the instruction manual, may cause harmful 
interference to radio communications. Operation of this equipment in a 
residential area is likely to cause harmful interference, in which case the user 
will be required to correct the interference at their own expense.

In order to maintain compliance with FCC regulations shielded cables must be 
used with this equipment. Operation with non-approved equipment or 
unshielded cables is likely to result in interference to radio and television 
reception.

Canadian Department of Communications Class A

This digital apparatus does not exceed Class A limits for radio emissions from 
digital apparatus set out in the Radio Interference Regulations of the Canadian 
Department of Communications.

Le present appareil numerique n'émet pas de bruits radioelectriques depassant 
les limites applicables aux appareils numerique de la Class A prescrites dans 
le Reglement sur le brouillage radioelectrique edicte par le ministere des 
Communications du Canada.

User Safety

This device has been type-tested by an independent laboratory and found to meet 
the requirements of the following:

MultiFlo™ Microplate Dispenser
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 l Underwriters Laboratories UL 61010-1 “Safety requirements for electrical 
equipment for measurement, control and laboratory use; Part 1: general 
requirements.”             

 l Canadian Standards Association CAN/CSA C22.2 No. 61010-1 “Safety 
requirements for electrical equipment for measurement, control and 
laboratory use; Part 1: general requirements.”

 l EN 61010 Standards, see CE Mark on page xiv.

BioTek Instruments, Inc.
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Safety Symbols

Some of these symbols appear on the instrument or accessories:

Alternating current
Courant alternatif
Wechselstrom
Corrientealterna
Correntealternata

Both direct and alternating current
Courant continu et courant alternatif
Gleich - und Wechselstrom
Corriente continua y corrientealterna
Corrente continua e 
correntealternata

Direct current
Courant continu
Gleichstrom
Corriente continua
Corrente continua

Earth ground terminal
Borne de terre
Erde (Betriebserde)
Borne de tierra
Terra (difunzionamento)

On (Supply)
Marche (alimentation)
Ein (VerbindungmitdemNetz)
Conectado
Chiuso

Protective conductor terminal
Borne de terre de protection
Schutzleiteranschluss
Borne de tierra de protección
Terra diprotezione

Off (Supply)
Arrêt (alimentation)
Aus (TrennungvomNetz)
Desconectado
Aperto 
(scon-
nessionedallaretedialimentazione)

Caution (refer to accompanying 
documents)
Attention (voir documents 
d’accompanement)
AchtungsieheBegleitpapiere
Atención (vease los 
documentosincluidos)
Attenzione, consultare la doc annessa

Warning, risk of electric shock
Attention, risque de choc électrique
Gefährlicheelektrischeschlag
Precaución, riesgo de 
sacudidaeléctrica
Attenzione, rischiodiscossaelettrica

 

Warning, risk of crushing or pinching
Attention, risqued’écrasement et 
pincement
Warnen, Gefahr des Zerquetschens 
und Klemmen
Precaución, riesgo del 
machacamiento y sejeción
Attenzione, 
rischiodischiacciareedintrappolarsi

Warning, hot surface
Attention, surface chaude
Warnen, heißeOberfläche
Precaución, superficiecaliente
Attenzione, superficiecalda

Warning, potential biohazards
Attention, 
risquesbiologiquespotentiels
Warnung! 
MoeglichebiologischeGiftstoffe
Atención, riesgosbiológicos
Attenzione, rischiobiologico

In vitro diagnostic medical device
Dispositif médical de diagnostic in 
vitro 
Medizinisches In-Vitro-Diagnostikum
Dispositivo médico de diagnóstico in 

Separate collection for electrical and 
electronic equipment 
Les équipements électriques et 
électroniques font l’objet d’une 
collecte sélective
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Safety Symbols|  xix

vitro
Dispositivo medico diagnostico in 
vitro

Getrennte Sammlung von Elektro- 
und Elektronikgeräten
Recogida selectiva de aparatos 
eléctricos y electrónicos 
Raccolta separata delle 
apparecchiature elettriche ed 
elettroniche

Consult instructions for use
Consulter la notice d’emploi
Gebrauchsanweisung beachten
Consultar las instrucciones de uso
Consultare le istruzioni per uso
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xx | Preface

MultiFlo™ Microplate Dispenser



Chapter 1

Introduction 

Thank you for purchasing the MultiFlo™ Microplate Dispenser. 
This chapter describes the instrument's features and 
specifications and includes important contact information. 
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Introducing the MultiFlo™ Dispenser

The MultiFlo offers up to three devices in one instrument: one or two peristaltic 
pump dispensers called the Peri-pump, and a dual Syringe pump dispenser. 

 Device/Component Description

1 Peri-pump Dispenser Peristaltic, 8-channel dispenser with entirely visible fluid 
path.

2 Syringe Dispenser Two distinct syringe-pump dispensers, each with an 8-, 16- or 
32-tube manifold.

A Dispense arm Holds the Peri-pump’s Tip Holder and the Syringe dispensers’ 
manifolds.

B Priming trough Waste reservoir for collecting priming fluid for the Peri-pump 
and Syringe dispensers.

MultiFlo™ Microplate Dispenser
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 Device/Component Description

C Plate Carrier Holds standard microplates for processing.

D Keypad One of two ways to control the instrument; the other way is 
LHC.

 Features of the MultiFlo

 l Supports all microplate-based assays, including ELISA, fluorescence, 
chemiluminescence, RIA, DNA probes, and cellular assays.

 l A variety of solutions, including buffered saline and reagents can be dispensed.

 l The intuitive onboard software allows you to create and store up to 99 dispense 
protocols. BioTek provides numerous predefined protocols for maintenance and 
instrument qualification purposes.

 l Compatible with BioTek’s BioStack™ Microplate Stacker for automated plate processing.

 l A robot-accessible carrier that can be interfaced into some robotic systems.

 l Computer control using BioTek’s Liquid Handling Control™software (“LHC”).

 l A low-maintenance design, the result of BioTek’s long history with liquid-handling 
instruments. 

Peri-pump Dispenser

 l A peristaltic pump with eight individual tubes transfers fluid from a supply bottle, or up 
to eight different supply bottles, to various vessels. The pump has four rollers over which 
the tubing is stretched. 

 l The tubing is contained in an easy to load and unload cassette that is attached to the 
pump head. The pump’s protective cover must be in place to run a dispense routine.

 l Three cassette sizes are available: 1 µL, 5 µL, and 10 µL for the most precise dispensing 
of volumes from 1 to 3000 µL and 0.5 µL dispenses with certain models using a 1 µL 
cassette.

 l Autoclavable tubing (steam temperatures and pressures of 121° C and 1 bar 
(750 mmHg)) is compatible with 70% ethyl or isopropyl alcohol and 0.5% sodium 
hypochlorite (bleach) solution for easy maintenance.

Syringe Dispensers

 l The Syringe dispenser has a long-lasting seal that ensures precise and accurate fluid 
delivery, as well as reproducibility for repeated dispenses.

 l Two syringes support distinct fluid sources:

BioTek Instruments, Inc.
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 o 16-channel: one tube per well for 384-well plates and two tubes per well for 96-
well plates.

 o 32-channel: one tube per well for 1536-well plates,

 o 8-channel (two manifolds in one block): one tube per well for both 96- and 384-
well plates.

 l Autoclavable components can be used with organic solvents and provide easy 
maintenance.

 l Does not require recalibration.

Liquid Handling Control™ (LHC) Software

BioTek’s Liquid Handling Control (LHC) software lets you control the instrument 
from your computer. You’ll enjoy the convenience of programming assay-specific 
dispense protocols in a familiar Windows environment (Microsoft® Windows® 7, 
Vista, and Windows XP). 

For high-throughput applications, the LHC supports BioStack™ integration.

Please refer to the LHC Installation Guide and Help system to learn about:
 o Installing the LHC software on the controlling computer

 o Running Maintenance protocols

 o Running Qualification protocols

 o Special considerations when operating with the BioStack Microplate Stacker

MultiFlo™ Microplate Dispenser
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MultiFlo Dispenser Comparison

The MultiFlo   offers two types of dispensers to choose from. Here is a comparison   
of the devices:

 n For precious reagents use the Peri-pump   to preserve unused fluids. It has 
the shortest, most visible fluid path,   and a Purge capability to reverse the fluid 
flow and recover fluid from   the tubing. Another advantage is the ability to 
dedicate usage of a dispense cassette   to one reagent only, reducing the 
amount of priming required   prior to use.

Device
Volume 
range 
µL/well

Precision Accuracy Approximate Dead
volume

Peri-pump 0.5‡, and 
1-3000*
 

<10% CV 
@ 1 
µL/well  
(typical 
<3% CV)

+/-10% 
(typical 
+/-3%) @ 
1 µL/well

Cassette Type:

1 µL 1.20 mL

5 µL 4.23 mL

10 µL 7.36 mL

Syringe 8-tube 10-3000 <5% CV @ 
20 µL/well

±2 µL @ 
10 
µL/well

For all manifold types:
12 mL.

Syringe 16-tube 5-3000 <10% CV 
@ 5 
µL/well

±2 µL @ 
10 
µL/well 

Syringe 32-tube 3-3000 <12% CV 
@ 6 
µL/well 

±5% @ 6 
µL/well   

*1 µL cassettes' maximum recommended dispense volume is   50 µL/well. 
‡ 0.5 µL dispensing is supported by some late-model instruments using a 1 µL cassette.

BioTek recommends priming a dispenser with three times its dead volume to 
prepare it for accurate dispensing.

Processing Time §  

Protocols were optimized for speed to obtain the following   processing times, 
including the fastest flow and travel rates. Some of   these parameters are listed in 
the Parameters column of the table. 

BioTek Instruments, Inc.
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Device Plate 
Type

Volume 
(µL/well)

Parameters Time in 
seconds
   ¥

Peri-pump - 5 µL 96 10 High flow rate 3 
Peri-pump - 1 µL 384 1 High flow rate 6 

1536 1 High flow rate 21
Syringe 8-tube 96 20 Flow rate 1 6.5
Syringe 16-tube 96 20 Flow rate 1 5.25 

384 20  Flow rate 1 14
Syringe 32-tube 1536 3 One SB manifold 16.5

1536 14 Both SB manifolds 27

§ Review the Specifications   for more details.

¥ Excluding plate carrier and manifold homing movements.

SB = small bore Syringe manifold

BioStack Compatibility

The MultiFlo   is compatible with BioTek’s BioStack Microplate Stacker.  The 
BioStack can rapidly transfer microplates one-at-a-time to and from the instrument, 
and includes: 

 l Removable stacks (one input and one output).

 l Optional restacking of plates to maintain correct sequencing.

 l The ability to continue processing plates following the aborting/failure of 
one plate.

 l The ability to pause processing to allow the user to add more plates to the 
input stack or to remove some from the output stack.

If you have purchased the BioStack to operate with the MultiFlo, refer to the 
BioStack Operator’s Manual for instructions on configuring the MultiFlo to run with 
the BioStack. To help you get started: See  Operating with the BioStack on page 
66.

If you are interested in purchasing the BioStack, contact your local BioTek dealer 
for more information or visit our website at www.biotek.com.

MultiFlo™ Microplate Dispenser
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Package Contents

 n Part numbers and package contents are subject to change and vary according 
to instrument model. Please contact BioTek Customer Care if you have any 
questions.

Description                     PN

Power cord (part numbers vary   by country of use)                     Varies                     

Power supply 76077

RS-232 serial cable                     75034                     

USB cable (USB Virtual COM Port   Driver Software & instructions)                     75108                     

Priming trough insert (2) for   Peri-pump                     7182043                    

Priming trough insert (2) for   Syringe dispensers                    7182044                    

Strip plate (12x1)                     98265                     

Screwdriver, Phillips                      98268                     

Stylus: for cleaning   Syringe manifold dispense tubes 2872304                    

10 cc syringe and tubing for   Peri-pump cassette maintenance                     49919                     

Shipping brackets (2) 7172073
7212012

Hex wrench: 3/32”   for removing syringe pumps                    48570                     

Hex wrench: 1/16”        for removing magnets from syringe dispense 
manifolds      

48713      

Hex wrench: 7/64" for removing shipping brackets 48169

Peri-pump Reservoir Holder (2) (+2 straps) 7210509

MultiFlo™ Getting Started Guide   (and Operator’s Manual on CD - 
PN 7211000)              

7211004

 n Some components are model specific, they ship only with certain instrument 
models. 
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Optional Accessories

 n Part numbers and package contents are subject to change and vary according 
to instrument model. Please contact BioTek Customer Care if you have any 
questions.

General Instrument Accessories 

Description PN       

BioTek liquid testing solutions for        
instrument qualification tests      

Wetting 
Agent                     

7773002      

Blue Test 
Dye                     

7773001      

Special plate carrier for mini-tubes 7212042

Large size priming trough insert 7182109

Liquid Handling Control™       Software LHC2

BioStack™ Microplate Stacker and integration kit                 Biostack      

Installation-Operational-Performance        Qualification (IQ-
OQ-PQ) package      

7210512 

Peri-pump Optional Accessories

 n Part numbers and package contents are subject to change and vary according 
to instrument model. Please contact BioTek Customer Care if you have any 
questions.

Secondary Peri-pump assembly: PN 7210010

Dispense cassettes and accessories:

MultiFlo™ Microplate Dispenser
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Cassette Type Cassette Tips Replacement 
tubing kit*

Tubing 
extension 

kit

1 µL plastic tips 7170012 7172150

7170009
 
 
 

7170022
 
 
 

1 µL 1536-well, plastic tips 7170018 7172150

1 µL sapphire jeweled 
stainless steel tips*

7170015 48692

1 µL 1536-well, sapphire 
jeweled stainless steel tips*

7170016 48692

5 µL plastic tips 7170011 7172059 7170008
 
 

7170021
 
 

5 µL  stainless steel tips 7170014 7172128

5 µL plastic, large bore tips 7170024 7172039

10 µL plastic tips 7170010 7172059 7170007
 
 

7170020
 
 

10 µL stainless steel tips 7170013 7172128

10 µL plastic, large bore tips 7170024 7172039

*Save your stainless steel tips for reuse with a replacement kit, they ship with plastic tips.

Accessory PN

Cassette Calibration Kit 7170017

Peri-pump Reservoir Holder 7210509

40 mL Priming Trough Insert 7182109

Syringe Dispenser Optional Accessories

 n Part numbers and package contents are subject to change and vary according 
to instrument model. Please contact BioTek Customer Care if you have any 
questions.

Accessory PN

Non-Autoclavable Syringe Dispenser Module 7210009

Autoclavable Syringe Dispenser Module 7210008

8-Tube (2 x 8 channel) Manifold (1) 7180548S

16-Tube Manifolds (2) 7180543S

32-Tube Small Bore (SB) Manifolds  (2) 7180533S
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Accessory PN

32-Tube Large Bore (LB) Manifolds  (2) 7180534S

Stylus – for cleaning 8-/16-tube dispense manifold tubes 2872304

Stylus – for cleaning 32-tube LB dispense manifold tubes 7182095

Stylus – for cleaning 32-tube SB dispense manifold tubes 7182102

Inline Filters (2) 48705

Spare tubing sets (2 - 1/dispenser), autoclavable 7183006

DMSO- & Acetonitrile-safe tubing sets (2 - 1/dispenser) 7183002

 

Physical Specifications

Labware

Microplates  96-well standard, half-height, deep; 384-well standard, deep, PCR; 
1536-well standard and flanged. The Peri-pump also supports 6-, 
12-, 24-, and 48-well plates when special handling instructions are 
followed. Corning® 96-Well Cluster Tubes (PN: 4410, 4411), called 
Mini-tubes in this application, are supported using a special plate 
carrier.             

Microstrips                     1 x 8, 1 x 12                     

Microwells                     Flat, round, "V” bottom                     

Hardware & Environmental

User Interface                     2-line x 24 character LCD screen,                                                  26 alphanumeric soft keys 

Power   Supply                     The instrument uses two internal power supplies:   24-volt 60 watt and 
48-volt 60 watt. These supplies are compatible with   100-240 V~; 50-
60 Hz.                     

Dimensions                    
(W x D x H)

Approximately 10 3/5 x 16 x 7 ½ inches (27 cm x 41 cm x 19   cm)                          

Weight  (≤)                14 1/4 lb (6.5 kg)                         

Operating 
Conditions                     

10° - 40°C (50° - 104°F)                     

MultiFlo™ Microplate Dispenser
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Hardware & Environmental

Relative Humidity
                     

The instrument should be operated in a non-condensing humid 
environment having a maximum relative   humidity of 80% at 
temperatures up to 31°C decreasing   linearly to 50% relative humidity 
at 40°C.                     

Peri-Pump

Peristaltic pump: Positive-displacement peristaltic pump with 4 rollers that stretch 
the 8 tubes   (one per channel) to deliver fluid.        

Cassette 
Types

Dispense range
                     Cassette Life                     Dead Volume

1 µL                     0.5, 1 - 3000 µL 1000 384-well   plates @ 5 µL/well                     1.2 mL                    

5 µL                     5 - 3000 µL 1000 96-well   plates @ 50 µL/well                     4.2 mL                     

10   µL                    10 - 3000   µL 1000 96-well   plates @ 100 µL/well                     7.4 mL                     

Syringe Dispenser

Two external positive-displacement syringe pump dispensers which support 
various manifold types.

Manifold   Type

8-Tube                     2 x 8-channel non-autoclavable manifold with replaceable stainless 
steel   tubes to process 96- and 384-well plates.

16-Tube 1 x 16-channel autoclavable manifold with replaceable stainless steel 
tubes to process 96- and 384-well plates. Tubes are angled 7 degrees 
to minimize turbulence in the wells when dispensing.

32-Tube                     1 x 32-channel manifold cannot be autoclaved, and does not support 
non-factory   tube replacement. An inline 90-micron filter is included 
to minimize clogs. For 1536-well plates only.

Performance Specifications

Peri-Pump Dispenser

Precision is measured for a whole 96-well or 384-well plate using room-temperature 
deionized or distilled water with 0.1% Tween 20 with FD&C #1 blue dye. Precision is 
measured for 1536-well plates by dispensing to 384 wells, 12 columns with a 15% isopropyl 
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alcohol solution. The absorbance of the solution is read at 630 nm and 450 nm reference. 
Specifications apply to volumes that are full unit increments for the cassette to which they 
apply, except the 1 µL cassette also supports 0.5 µL increments when dispensing this volume. 
For example: the precision specification for a 10 μL cassette is valid at 10, 20, 30, ..., 3000 
μL; the 1 µL cassette precision specification is valid at 0.5, 1, 2, 3, ..., 3000 µL.

Accuracy is measured   gravimetrically when dispensing room-temperature deionized water. 
Specifications   apply to volumes that are full unit increments for the cassette to which   they 
apply. For example: the accuracy specification for a 10 µL cassette is valid at 10, 20, 30, ... 
3000 µL.

Cassette Precision Accuracy

1 µL
 

10%CV  @ 1 µL per well ± 10% @ 1 µL per well 

5%CV  @ 2 µL per well* ± 5% @ 2 µL per well*                     

10%CV  @ 0.5 µL per well n/a

5 µL
 

5%CV  @ 5 µL per well                     ± 4% @ 5 µL per well                    

2.5%CV  @ 10 µL per well*                     ± 2% @ 10 µL per well*                     

10 µL                    
 

4%CV  @ 10 µL per well                    ± 4% @ 10 µL per well                     

2%CV  @ 20 µL per well*                     ± 2% @ 20 µL per well*                     

* These specifications   are for these dispense volumes and higher.                     

Cassette Expected Lifetime

Cassette Types Cassette Life Total Volume

1 µL 1000 384-well plates @ 5 µL/well 2,000 mL

5 µL 1000 96-well plates @ 50 µL/well 5,000 mL

10 µL 1000 96-well plates @ 100 µL/well 10,000 mL

With strict adherence to best practices and maintenance recommendations, this is 
the typical longevity of the dispense cassettes.

MultiFlo™ Microplate Dispenser
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Syringe Dispensers

Precision is measured   for a whole 96-well or 384-well plate using room-temperature 
deionized or distilled water with 0.1%   Tween 20 with FD&C #1 blue dye. Precision is 
measured for 1536-well plates by dispensing to 384 wells, 12 columns with a 15% isopropyl 
alcohol solution. The absorbance of the solution shall   be read at 630 nm and 450 nm 
reference. 

Accuracy is measured   gravimetrically when dispensing room-temperature deionized water. 

Dispense   Precision                       

8-Tube: ≤   2% CV   when dispensing 100 µL/well                            
≤ 5% CV precision at 20 µL/well
≤ 5% CV precision at 40 µL/well **
**  Tested in-house to <4.0% CV.

16-Tube: ≤   2% CV   when dispensing 100 µL/well
≤ 2.5% CV   precision at 80 µL/well***                    
≤ 5% CV precision at 20 µL/well                           
≤ 10% CV   precision at 5 µL/well*
*unspecified for non-autoclavable syringe pumps.
*** Tested in-house to <1.6% CV.

32-Tube: < 12% CV when dispensing 6 µL per tube 

Dispense   Accuracy                     

8-Tube For all volumes 2 µL or 1%, whichever is greater, at flow rate 2.

16-Tube: For all volumes 2 µL or  1%, whichever is greater,                    at flow rate 2.

32-Tube: ± 5% when dispensing 6 µL/well at flow rate 3. 

BioTek Instruments, Inc.



14 | Chapter 1: Introduction

BioTek's Customer Resource Center

BioTek's Customer Resource Center (CRC) continues our tradition   of superior 
service and support. After an easy registration process, you   can access lots of 
useful information about your BioTek microplate instrumentation   and software. On 
the secure CRC website, you can:

 l Track   orders              

 l Access   warranty information, user manuals and software updates             

 l Download   technical and application information             

 l Maintain   equipment inventory (product registration)             

 l Request   service and technical support             

 l View   service history             

 l And   much more!             

Register at https://customer.biotek.com

 n Dispense cassette data sheets are available for download at the CRC.

MultiFlo™ Microplate Dispenser
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Unpack and Inspect the Instrument

Important: Save all packaging materials. If you need to ship the instrument or 
accessories to BioTek for repair or replacement, you must use the original packaging. 
Using other forms of commercially available packaging is not recommended and can void 
the warranty. Improper packaging that results in damage to the instrument  may lead to 
additional charges. Refer to the operator's manual for repacking instructions.

Inspect the shipping box, packaging, instrument, and accessories for signs of 
damage.

If the MultiFlo™ Microplate Dispenser is damaged, notify the carrier and your 
BioTek representative. Keep the shipping cartons and packing material for the 
carrier’s inspection. BioTek will arrange for repair or replacement of your 
instrument immediately, before the shipping-related claim is settled.

 1. Unpack the boxes containing the instrument and other equipment:

 l MultiFlo™ Microplate Dispenser and accessories

 l Dual Syringe Dispenser and accessories

 l Additional Peri-pump Dispenser and accessories

 2. Place all packing materials back into the shipping boxes for reuse if necessary.
 3. Syringe Dispenser models: when the Syringe dispenser is a component of your 

instrument, review the placement options for it (as described on page 34) and decide 
which one best suits your lab before proceeding with the installation. 

Refer to the Package Contents on page 7 to make sure you have all expected 
equipment.

MultiFlo™ Microplate Dispenser
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Install the Waste Tubing

A length of tubing and a bracket to hold it is provided to drain the priming trough 
into a waste container. It's safer to perform this task  before removing the shipping 
hardware.

Underside of MultiFlo showing priming trough waste tubing

Important note: The waste 
tubing must lay flat to 
properly drain the priming 
trough. The side bracket 
provided with the instrument 
supports this goal, but it may 
not be needed in your lab, 
depending on where you 
position the dispenser and its 
waste receptacle.

You will need:
 l Philips head screwdriver (small)

 l Waste tubing: 4' provided (PN 7213010)

 l Possibly scissors or knife to cut tubing to desired length

 l Side bracket provided

 l Waste vessel: to capture discarded fluid 

To install the tubing:

Install Side Bracket for Waste Tubing

BioTek Instruments, Inc.
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 1. Turn instrument onto its back to access its 
underside.

 2. Remove the two screws  in the lower left 
corner. You will use them to install the 
bracket.

 3. Align the side bracket with the screw holes 
so its hook opens towards you and use the 
screws to install the bracket.

 You may or may not use the side bracket, depending on where you place the waste 
vessel.

Attach the Tubing to the Priming Trough

 

 1. Thread the waste tubing under the 
bracket and onto the priming trough's 
spout.

 Remove the bracket and/or use water or 
alcohol to help the tube slide onto the spout.

 2. Snake the tubing around the 
instrument to the side bracket.

 3. Return the instrument to normal 
position.

Position Waste Container and Tubing

When all the installation steps are completed:

 1. Place the waste container under the instrument's work surface.

 2. Position the waste tubing to drain into the waste container, cutting it to the 
optimal length, if necessary.

Next, remove the shipping hardware. 
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Remove the Shipping Hardware

Two shipping brackets (and a rubber band when a Peri-pump is included) protect 
the MultiFlo during shipping. After installing the waste tubing for the priming 
trough, place it upright on a level work surface to remove the shipping hardware. 
(Store the shipping brackets on the back of the instrument in slots provided for this 
purpose.)

You will need:
 l Allen (or hex) wrench taped to plate carrier.

Remove shipping brackets:

 1. First remove the dispense arm shipping bracket: use the Allen wrench to 
remove the two screws that hold it to the dispense arm, lift the arm slightly and 
slide the bracket forward off the back post.
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 2. Next, remove the plate carrier shipping bracket: use the Allen wrench to remove 
the two screws that hold it to the plate carrier. Tilt the bracket downwards 
slightly, and release it from the post.

 3. Attach the shipping brackets to the back of the instrument for storage. They will 
be needed again if the dispenser must be shipped in the future.

Storage area for shipping hardware on back of instrument

 4. Insert the brackets into their respective slots on the back of the instrument, 
below the fan. Slide the bracket's longest arm into the slot and use the Allen 
wrench to screw it in place.

Store the Allen wrench  for future use.
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Set Up the Peri-pump Dispenser

Install these items to use the Peri-pump dispenser:
 l Install the second Peri-pump, if applicable

 l Dispense cassette

 l Fluid supply vessel

 l (Optional) Prime trough insert

Install the Secondary Peri-Pump

An optional secondary Peri-pump dispenser is available for the MultiFlo. It ships 
as a kit with its own accessories. Inspect and unpack the shipping   container and 
follow these installation instructions if applicable. Otherwise, skip this part of the 
installation process.

The secondary Peri-pump dispenser is designed to sit on top of the MultiFlo 
dispenser. The second pump will be positioned above and slightly right of the 
primary pump.
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Kit components include:
 l 1 - additional Peri-pump
 l 2 - small tab to secure unit to the instrument
 l 3 - additional dispense cassette bracket
 l 4 - interface cable to connect unit to the instrument
 l Also note the screwdriver, Allen (hex) wrench, and shoulder screw shipped  with 

the accessories. 

You will need:
 l Second Peri-pump Kit components (shown above)

 l Philips head screwdriver (small)

 l Small flat screwdriver
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Install the Secondary Peri-Pump |  23

Install the additional Peri-pump:

 1. First, remove the support bracket 
stored on the back of the instrument. 
It will be used to secure the 
dispenser on top of the instrument. 
Remove the two screws holding the 
bracket in place.

 2. Two more screws needed for the 
installation are shipped on the back 
of the Peri-pump unit. Remove the 
two screws and keep with the 
bracket.

 3. Place the second Peri-pump unit on 
top of the dispenser.

 4. Position the dispenser so the screw 
hole in the small tab attached to its 
front aligns with the right-hand 
screw hole on the primary Peri-
pump.

 5. Use the Philips screwdriver to fully 
tighten the shoulder screw to ensure 
the unit is secured.
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 6. On the back of the instrument, 
secure the Peri-pump unit in place 
with the support bracket and  the 
four screws removed from the 
instrument earlier. Partially tighten 
the screws until all 4 are in place, 
then tighten all the screws.

The support bracket can be installed two 
ways, to provide foot holds for a Syringe 
dispenser module, or not. 
Hide the bracket's foot holds inside the case 
when a Syringe dispenser will not be 
installed on top of the second Peri-Pump. 

Install the additional dispense cassette bracket:

  This task is easier to perform when the cassette bracket is well lit. It's a tight space and 
the second cassette bracket fits snugly onto the original bracket.                

 1. First, remove the four screws and 
washers from the additional cassette 
bracket using the small Allen 
wrench supplied in the kit.

 2. Slide the plate carrier to the left, out 
of the way. Lower the dispense arm 
to a workable position.

 3. Use the text on the front of the  
additional cassette bracket to orient 
it correctly and place it around the 
original bracket. 

 4. Use the four screws to secure the 
bracket over the existing bracket. 
Place and partially tighten the 
screws until all four are in place, 
then tighten all the screws.
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Install cable to connect the dispenser:

 1. On the back of the instrument, 
connect the interface cable to the 
Peri-pump Dispenser port on the 
back of the instrument and to the 
port on the back of the Peri-pump 
unit. Use the small flat screwdriver 
to secure the cable.

 n If you are installing a Syringe dispenser also, you may find it easier to 
complete that installation before connecting the cable, turning on the 
instrument, and installing the dispense cassettes.

Turn on the instrument:

 1. Plug in the MultiFlo and turn it on (switch on side).

 2. A "Hardware Change Detected" message will display. After a few moments the 
main menu will be shown signaling the installation of the additional Peri-pump:

PRI-#    SEC-#     
RUN   QUICK    DEFINE  UTILS 

Main Menu

PRI-# represents the primary or original Peri-pump, and SEC-# represents the 
additional or secondary Peri-pump. The # represents the cassette type. These 
designations are used in all instrument commands to control the dispenser. 

Important: Make sure the installed dispense cassette matches the cassette type 
number displayed in the menu. Change the cassette type setting on page 29.
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Dispense Cassette Diagram

Tubing Cassette Diagram

 1. Tip   Holder: The cassette’s easiest   part to identify, the tip holder fits into the 
dispense arm to the right   of the pump for positioning above the plate.              

 2. Center   Holder: The center holder is labeled   to identify the size of the cassette 
tubing. It also has a serial number   for tracking purposes. It fits in between the 
tip holder and the tube   tensioner and fixes the tubes in place. It slides into 
grooves on the   underside of the pump.             

 3. Tube   Tensioner:   The transparent 5-mm scale on its front surface identifies the 
tube tensioner.   It has 8 internal screws for stretching the tubing, one for each 
tube.   The tube tensioner’s scale is useful when calibrating the cassette.             

 4. Tube   Organizer: At the opposite end of   the cassette from the tip holder, the 
tube organizer holds the 8 tubes   together for inserting into the fluid vessel. 

 5. Tip Guard: Remove the tip guard before installing the cassette. The tip guard 
protects the tips during shipping. It is not a permanent part of the cassette.
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Install the Dispense Cassette

Prerequisites:
 o Review the Dispense Cassette Diagram on previous page to learn the names

   of the components.             

 o Move the Pump Cover away from the pump   to its OFF position.             

 o When you have two Peri-pumps installed, put the Primary pump's Tip Holder in the 
left bracket and the Secondary pump's Tip Holder in the right bracket. 

 o Release the pump’s   stainless steel plate: Use your right hand to release the 
spring-loaded cassette  latch (on the right side of the caution symbol on the pump) 
and use   your left hand to lift the stainless steel plate up and out.             

 n Note: The BioTek logos on the Tip Holder and Center Holder face each other 
when installed properly. Similarly, the 1µL 1536 cassettes' steel plate on the 
front of the Tip Holder faces the pump.
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 1. Slide the Tip Holder   into the 
dispense arm. The Tip Holder’s 
front plate with the BioTek   logo 
or steel plate faces the pump. 
Make sure the tip holder is level 
and snapped into   place.

 l Two Peri-pumps: use left bracket for 
Primary, right bracket for 
Secondary.  

 2. Extend the rest of the cassette   
under the Peri-pump, so you 
can slide the   Center   Holder into 
its slot on the underside of the 
pump. A tab on the   back of the 
center holder fits into a notch 
on the pump. The label   on the 
center holder faces down. 

 3. Align the Tube Tensioner with   
the stainless steel plate as it 
wraps around and up against 
the pump.   Be sure the knobs on 
top of the tensioner fit correctly 
into the grooves   in the stainless 
steel plate as you move both 
parts up and around the   pump 
and click the steel plate into 
place.              
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 4. Return the Pump   Cover to its RUN   position covering the pump.             

 5. Lift the Tube   Organizer over the pump cover. Place it in the fluid vessel, when   
you’re ready.             

 n Make sure the instrument's Cassette Type setting matches the installed 
cassette. See Change the cassette   type setting below.

Change the cassette   type setting

The Peri-pump Cassette   Type setting must be correct. The current setting is 
displayed on the   keypad's Main Menu: PRI or SEC-(#). 

LHC Keypad

 1. Select   Tools>Instrument 
Utilities

 2. Select   the Peri-pump tab.             

 3. Select   the correct button for the 
Cassette Type   installed for the 
primary or secondary Peri-pump, 
if applicable.             

 4. Click   Send to update the 
instrument.             

 1. Press   Setup Menu.             

 2. Select   PERI.             

 3. Select PUMP and Primary or 
Secondary, if applicable.

 4. Select   CASS. 

 5. Select   the matching setting. 
Optionally, use the Prime and 
Purge buttons to prepare the 
cassette for dispensing.                     

 6. Press   Main Menu to verify the 
change.           

 Tip: You may want to employ the Cassette Requirement Mode feature (as described on 
page 101) to automatically update the instrument's Cassette Type setting when you run a 
protocol. For advanced users with well organized procedures, the MultiFlo provides the 
ability to change the cassette type setting on-the-fly.   It uses the "Require a specific 
cassette" parameter in  a Peri-pump step to automatically change the cassette type setting 
if it does not match the required   cassette.    
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Prime Trough Inserts

The MultiFlo ships with special reservoirs that fit into the dispensers’ priming 
trough to capture expensive reagent after priming, rather than discarding it. 

Up to three Prime Trough Inserts are provided:

 l PN 7182043 (2) for the Peri-pump dispenser holds approximately 12 mL

 l PN 7182044 (2) for the Syringe dispensers holds approximately 6.5 mL

 l PN 7182109 large priming trough insert, holds approximately 40 mL

 n Without the prime trough insert, the priming trough empties into the regular 
waste bottle.
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Peri-pump Reservoir Holder

Peri-pump Reservoir Holder attached to Peri-pump

MultiFlo models with a Peri-
pump dispenser include the 
convenient Peri-pump 
reservoir holder (PN 
7210509). The simple bracket 
clips onto the front of the 
Peri-pump to hold a variety 
of vessels. 

You can significantly reduce 
the dead volume,  saving 
precious fluid, by cutting 
the cassette tubing to make a 
shorter fluid path. See 
Shorten the Dispense 
Cassette Tubing below.

 

The reservoir holder has two components, a bracket and 
a strap. 

 1. Clip the bracket onto the front of the Peri-
pump. When properly installed the bracket 
hides the hazard label.

 2. Place the supply vessel (reservoir) on the 
bracket and wrap the strap around both the 
vessel and the bracket: fit the strap's molded 
balls  into the round slots. 

Depending on the size of the vessel, it may be necessary to tuck the ends of the 
strap into the bracket, too, to keep the slack out of the way.

 n Important: Always remove the tubing from the fluid before releasing the 
tension on the cassette or changing cassettes.

Shorten the Dispense Cassette Tubing

Shortening the fluid path reduces the dead volume when dispensing, which helps 
preserve expensive reagents. BioTek offers the Peri-pump Reservoir Holder above as 
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an accessory to the Peri-pump dispenser for this purpose. The cassette tubing can 
be shortened by as much as 10½ inches (26.67 cm) when using the reservoir holder.

Recommendations for cutting the tubing:

 l Prepare a clean, lint-free work area to lay out the cassette;

 l Remove the Tube Organizer;      

 l Use a ruler as a guide to determine where to cut the tubing;

 l Cut one tube at a time using a razor blade, Exacto® knife, or sharp scissors; make as 
clean a cut as possible;

 l Cut the tubing as evenly as possible, limiting the difference between the tubes to less 
than 1/4" (6.35 mm).

  To may make this job easier, use   the cassette’s packaging to hold the cassette   parts, 
keeping them out of your way.
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Install the Syringe Dispenser Component

The Syringe dispenser is an optional component and ships   separately. Inspect and 
unpack the shipping   container. Skip this part of the installation process if it is not 
applicable.

 l 1 - Syringe Dispenser module (autoclavable)
 l 2 - interface cable
 l 3 - tubing bracket
 l 4 - priming trough inserts
 l 5 - dispense manifolds
 l 6 - shelf
 l 7 - supply bottles and tubing with check valves
 l Not shown: thumbscrews (2), large priming trough insert.

Install the Syringe Pumps

Review the placement options for the Syringe dispenser and follow the applicable 
instructions: 
Syringe Dispenser Placement Options on next page
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Syringe Dispenser Placement Options

There are two 
major 
placement 
options for the 
dual Syringe 
dispenser 
module: in 
back of the 
instrument on a 
shelf provided 
for the purpose 
or on top of the 
instrument. 
When installing 
the Syringe 
dispenser on 
top, placement 
of the tubing 
bracket varies 
slightly 
depending on 
how many 
other 
dispensers are 
installed. 

 

Follow the 
installation 
instructions for 
your preferred 
placement of 
the dispenser:

Install the Syringe Dispenser on Back Shelf on the facing page

 Install the Syringe Dispenser on Top on page 37
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Install the Syringe Dispenser on Back Shelf

Follow these instructions to install the dual Syringe Dispenser module on a shelf 
attached to the back of the MultiFlo.

 

First, reposition the shelf's feet: 

 1. Remove the shelf shipped with the 
Syringe dispenser from its plastic bag 
(PN 7212038).

 2. Unscrew the rubber feet that are 
shipped in the wrong position.

 3. Install the feet in the correct position: 
screw the feet into the two outer holes 
on the bottom of the shelf. (The third 
hole is for BioStack integration.)

 4. Remove the two screws on the left side 
of the back of the instrument.

 5. Use the screws to install the shelf.
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 6. Install the tubing bracket (using the 
black-capped screws) in the two holes 
next to the shelf. First insert the bottom 
screw part way. Position the bracket 
over the screw and tighten both screws. 

 7. Put the syringe pump module on the shelf.

 8. Plug the 26-pin high-density   cable into the back panel of the MultiFlo in the 
port labeled Syringe Pump Dispenser. Plug   the other end into the syringe 
pump unit.             

Next steps:
 l Update the instrument to use the Syringe Dispenser on page 44

 l Install Tubing and Manifolds for Syringe Dispenser on page 39
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Install the Syringe Dispenser on Top

Follow these instructions to install the dual Syringe dispenser module on top of the 
instrument. 

Syringe dispenser on top of secondary Peri-pump

Support bracket with foot holds
 for the Syringe dispenser.

The MultiFlo ships with a support bracket attached to the back of the instrument. 
The support bracket has foot holds for the Syringe dispenser. The bracket's flexible 
design  supports either one or two devices, the secondary Peri-pump and the 
Syringe dispenser, alone or in combination.

 1. Remove the support bracket from the back of the instrument by releasing the 
two screws that hold it in place.

 2. Align the bracket with the screw holes on the back of the instrument so that the 
foot holds sit above the instrument or second Peri-pump's top.

 3. Install the tubing bracket in the appropriate location using the two black-capped 
screws:

Tubing Bracket

When installing the Syringe dispenser on top of the 
instrument, the placement of the tubing bracket 
varies slightly depending on how many other 
dispensers are installed. Always position the 
bracket as close as possible to the syringe pump 
unit.
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1 Peri-pump:
Install the bracket using the two 
empty screw holes on top of the 
Peri-pump.

2 Peri-pumps:
Install the bracket using the 
screw holes on top of the 
secondary Peri-pump, the 
pump closest to the Syringe.

Syringe Only
(no Peri-pump)
Remove the two screws in the 
filler plate on the front of the 
instrument and replace them 
with the tubing bracket.

 4. Plug the 26-pin high-density   cable into the back panel of the MultiFlo in the 
port labeled Syringe Pump Dispenser. Plug   the other end into the syringe 
pump unit.             

Next steps:
 l Update the instrument to use the Syringe Dispenser on page 44

 l Install Tubing and Manifolds for Syringe Dispenser on the facing page
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Install Tubing and Manifolds for Syringe Dispenser

For each dispense pump, a set of two tubes with check    valves and two supply 
bottles are provided. The 32-tube dispense manifolds also ship with an optional 
inline filter.

 n The supply bottles have Luer fittings.     Finger-tighten only!

 l Rinse all bottles with deionized or distilled water before use to eliminate 
particles that may have entered during packing or unpacking.

 l Place the supply bottles on the same horizontal plane as the instrument. This 
ensures optimum pump performance.

 l Make sure the tubing is not crimped during installation.

Perform these steps twice, first for Syringe A and then for Syringe B:

 1. First install the inline filter for 32-
tube dispensers, if applicable, (as 
described on page 42). Locate the 
tubing with a      Luer fitting on one 
end. Gently screw the Luer fitting 
into the top of      the supply bottle. 
Finger-tighten only.     

 2. Attach the other end of      the tubing 
from the supply bottle to the bottom 
port of one of      the Syringe pumps.    

 n Make sure the flow-direction arrows      point in the direction that the fluid moves.
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 3. With the check valve’s      flow-direction arrows pointing away from the pump, 
connect the other tube (without fittings) to the      top port of the Syringe pump.    

 4. Slide the manifold onto      the 
two posts on the dispense 
arm with the tubing end 
closest to the instrument.      
Except for the dual 8-
channel manifold that has 
two manifolds in one 
block, install Syringe A’s 
manifold first. Syringe B’s 
manifold must      be installed 
after Syringe A’s. 

 5. Connect the supply tube  to 
the dispense manifold.   

 n Images of syringes on the instrument, labeled A and      B,  indicate the placement 
of each dispenser’s manifold:      A slides on first, then B.    

 n Special procedure required for magnetic bead assays! A magnet holds 
the two manifolds in place on the dispense arm. You can remove the magnet 
when necessary for certain assays (as described on page 108).
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 6. Make sure the manifold has enough slack in the tubing to move down to the 
priming trough and then press the tubing into the black tubing bracket to keep 
the tubing out-of-the-way. 

 n When the Syringe is installed on the back shelf, you must temporarily move 
the pump unit to get access to the tubing bracket.          

 7. Repeat the      tubing and manifold installation for Syringe B.

 8. (Optional)    Insert the thumbscrews into the posts that hold the manifolds. 
(Magnets keep the manifolds attached to the dispense arm. The thumbscrews 
are provided in case the magnets interfere with operation, e.g. for magnetic 
bead assays.)

 n Important! You must Update the instrument to use the Syringe Dispenser on 
page 44to tell the instrument which manifold is installed.

Syringe Dispenser Check Valves

Note the flow direction arrows on the check valves. Some   are harder to see than 
others. The valves are made of a translucent plastic,   in which the flow direction 
arrows are engraved.
 l PN 68083 — Autoclavable   valves for use with non-organic substances. The direction 

arrows are difficult   to see.              
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 l PN 68073 — Check   valves recommended for use with organic substances. They cannot be 
autoclaved.   Direction arrows are easy to see.             

 n Note: If the check valves are replaced,   it may be necessary to recalibrate the 
syringe backlash to achieve optimum   accuracy performance. See Calibrate 
the Backlash for Syringe Dispenser on page 153 for instructions. 

Make sure the flow-direction arrows on the check valves   point toward the pump 
from the supply vessel, and towards the dispense   manifold from the pump.  

Install Inline Filter for 32-Tube Dispensers

BioTek ships two 90-micron inline filters with the 32-tube dispense manifolds to 
reduce the chances of clogging the dispense tubes. It is especially important for the 
SB – small bore models.

To install the filters:

 1. Locate and layout the length of tubing that goes between the supply bottle and 
the Syringe pump; it has the Luer fitting on one end. 

 2. Cut the tubing approximately one to two inches (3-5 cm) above the Luer fitting.

 3. Slide the filter’s nozzle ends into the two ends of the tubing, reconnecting it.

Install Software/Connect to Computer 

If you purchased BioTek's Liquid Handling Control™ (LHC) Software to control the 
MultiFlo using your personal computer (PC), please refer to the LHC Installation 
Guide for complete installation and setup instructions.

Connect to Host Computer

Two cables are shipped with the MultiFlo:

If using the serial cable: Plug one end into the RS232 serial port on  the 
instrument and the other end into an available port on the computer.
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If using the USB cable: Plug one end into the USB port on the instrument and 
the other end into an available port on the computer. 

 l If the computer is connected to the Internet, turn on the instrument. Let 
Windows® automatically locate and install the necessary USB drivers (follow 
the online instructions), if applicable or open the link below to download the 
drivers. 

 l Virtual Com Port (VCP) drivers for all Windows operating systems are 
available at http://www.ftdichip.com/Drivers/VCP.htm

 l If the computer is NOT connected to the Internet, install the drivers using the 
supplied “Virtual USB Com Port” driver software CD. 

 n The keypad must be displaying its “Main Menu” for the LHC to communicate 
with the instrument.

Technical Note: Only one of the two communication ports (COM port) on the  
instrument can be used at a time. They cannot be used simultaneously. You 

can use USB  to connect the MultiFlo to the computer or the RS232 serial port to 
connect to a BioStack or similar robotic device. But you cannot use both ports 
simultaneously, i.e. make sure only one cable is plugged in at a time.

Connect to Power

Warning! Power Rating. The MultiFlo must be connected to a power receptacle that 
provides voltage and current within the specified rating for the system. Use of an 
incompatible power receptacle may produce electrical shock and fire hazards.

Warning! Electrical Grounding. Never use a two-prong plug adapter to connect 
primary power to the MultiFlo. Use of a two-prong adapter disconnects the utility 
ground, creating a severe shock hazard. Always connect the system power cord directly 
to a three-prong receptacle with a functional ground.

 

The MultiFlo supports voltage in the range of 100-240 V~ at 50-60 Hz.  

 1. Connect the power cable to the power supply.

 2. Plug the power supply cable into the power socket in the side panel of the 
MultiFlo.

 3. Insert the three-prong plug into an appropriate receptacle. 
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Define Instrument Settings

LHC Users Only

When using the LHC to control the MultiFlo, an important first step is 
defining your instrument’s settings. After installing the LHC, you can use the 
desktop icon or the Windows Start button to launch the LHC:

 > All Programs> BioTek> Liquid Handling Control

 1. Click the Name link on the main page and, if required, select the MultiFlo.

 2. Specify the COM Port used to connect the MultiFlo to the computer (use the 
drop-down list to select the port) and click Test Communication. 
 o Pass: proceed to the next step.

 o Fail: check the Com Port setting. See “About Com Ports” in the LHC Help.

 3. In the Target Instrument Settings dialog that opens, click Get actual settings now, 
and click OK.

Update the Instrument to use the Syringe Dispenser

An important part of installing the dual Syringe Dispenser is updating the 
instrument's basecode (internal software) with its calibration data. A data sheet is 
affixed to the bottom of the Syringe pump unit and to the front page of the 
installation instructions. Enter the calibration values that match the installed 8- 
or 16-tube manifold; for 32-tube manifolds enter either data set.

LHC Keypad

 1. Connect the syringe pump 
unit to the instrument with its 
serial cable. 

 2. Turn on the instrument, 
launch the LHC  and make 
sure it is communicating with 
the MultiFlo (define the 
correct COM port).

 3. Select Tools>Instrument 
Utilities>Syringe Dispenser.

 1. Connect the syringe pump unit to 
the instrument with its serial 
cable. 

 2. Turn on the instrument, and press 
Setup Menu.

 3. Select SYR > MAN and specify the 
installed manifold type.

 4. Select SYR > CAL.

 5. Press ENTER to skip over the 
Checksum. (You will check this 
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LHC Keypad

 4. Under Syringe Dispenser 
Assembly, specify the 
installed manifold type and 
click Send to download the 
data to the instrument.

 5. In the Calibration Data section, 
enter the data points on the 
label in the corresponding 
fields, including the Serial 
Number and click Send. 

 6. Wait for the confirmation 
message and verify the 
Checksum displayed matches 
the Checksum on the label. 
This ensures the data was 
input correctly.

 l Click Retrieve at any time to 
check the Checksum.

code at the end of the procedure.)

 6. Enter the Serial Number (SN) and 
all the data points by pressing 
ENTER after each value. Make sure 
the CAL VOL number onboard 
the instrument matches the Cal Pt 
number on the label.

 7. When finished, select CAL again at 
the Syringe setup menu and 
confirm that the Checksum 
displayed onboard matches the 
Checksum on the label.  This 
ensures the data was input 
correctly.

 n Important: If the Checksum does not match there was a data input error and 
dispense accuracy will be compromised. Redo the procedure, carefully 
comparing the data points on the label to the values entered. 
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Define Startup Preferences (LHC users only)

You can save enormous time creating protocols by following these steps to define a 
New Protocol template and use it at startup.

Create a protocol template

 1.  Click the New button or select File>New. 

 2. Click Name. Select the MultiFlo and define its Port and Settings.

 3. Optionally, select the Plate Type, fill in the text fields, and add any steps that 
you want all new protocols to include.

 4.  Click Save and assign a unique name, e.g. Template.LHC.

 5. Select Tools>Preferences>New Protocol.

 6.  Select the button for Protocol selected below to use as a template.

 7. Click selected and select the protocol you created as a template.

Define startup behavior:

 8. After completing the steps above, select the Startup Options tab.

 9. Select the button for New Protocol.

 10. Click OK to save your new preferences.
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Verify Performance

Before using the MultiFlo for the first time, verify that it is operating properly. 
 l When using the LHC, make sure the MultiFlo is connected to the PC and both are powered 

up. 

 l When running standalone, turn on the MultiFlo.

Using the keypad:

 1. Select UTILS at the main menu.

 2. Select TESTS >       SLFCHK.

Using the LHC:

 1. Click the Name link on the main page and, if required, select the MultiFlo.

 2. Define the COM Port used to connect the MultiFlo to the computer and Test 
Communication. 

 3. In the Target Instrument Settings dialog that opens, click Get actual settings now, 
and click OK.

 4. Select Tools>Instrument Utilities

 5. On the General Settings tab, click the Perform Self-Check link.

Test results:
 l Pass: no error message is  displayed. 

 l Fail: an error message is displayed. If this happens, note the error code and refer to 
Troubleshooting on page 186 to determine its cause. If the problem is something you can 
fix, turn off the instrument, fix the problem, and then turn the instrument back on. 
Otherwise, contact BioTek’s Technical Assistance Center.

The Qualification Chapter in the operator’s manual provides Installation and 
Operational Qualification procedures to perform after the instrument is installed 
and before the instrument is used in a laboratory environment.  

 n Note: An instrument qualification package (PN 7210512) for the MultiFlo 
is available for purchase from BioTek. The package contains thorough 
procedures for performing Installation Qualification, Operational Qualification 
and Performance Qualification (IQ/OQ/PQ) and preventive maintenance (PM). 
Extensive Checklists and Logbooks are included for recording results. 
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 n Important! Before operating the instrument, review Optimize Performance 
on page 57. The guidelines include necessary steps to perform before running 
a protocol,  and issues to consider when creating or editing protocols.
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Repacking the MultiFlo

Prior to sending your instrument to us for repair, log into the Customer Resource 
Center (www.biotek.com) to submit a Service Request for a Return Material 
Authorization (RMA). Your serial number is needed to process an RMA.

 n Failure   to comply with the following instructions will void the instrument’s   
warranty.              

 n Decontaminate the instrument before returning it: See Decontamination on 
page 146.             

If the original packing materials have been damaged or lost, contact BioTek to 
order replacements. Part Numbers: 7213006 for the main instrument, and 7213008 
for the secondary Peri-pump and 7213007 for other accessories, if applicable. 

Prepare the instrument for shipping bracket   installation: 

 1. Remove the Peri-pump’s   cassette and the Syringe dispensers’ manifolds, if 
applicable.              

 2. Uninstall and repack separately the Syringe pump and its accessories, if 
applicable.

 3. Slide the transport rail   into position next to the dispense arm. It will be secured 
in place by   one of the shipping brackets. 

View the illustrations provided:
 l Repacking   illustration 1: install the shipping brackets.             

 l Repacking   illustration 2: put the instrument into shipping boxes. 

 l Repacking the Syringe Dispenser (if applicable)            

Obtain an RMA number:
 l Contact BioTek TAC to obtain a Return Materials Authorization number,

 l Write "RMA" on the shipping box in large, clear letters,
 l And, include the RMA number in the shipping address label:

BioTek Instruments, Inc.
ATTN: RMA# xxxxx 
15 Tigan Street
Winooski, Vermont  05404  USA

BioTek Instruments, Inc.
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MultiFlo Repacking Illustration 1 

 n The instrument’s   packaging design is subject to change over time. If the 
instructions in   this section do not appear to apply to the packaging materials 
you are   using, please contact BioTek’s Technical Assistance Center for 
guidance.             

Multiple accessory modules are available for the MultiFlo. Foam blocks are used as 
space fillers in the packing containers when the modules, like the secondary Peri-
pump, are not shipped. 

Uninstall the Secondary Peri-pump

 1. Reverse the installation procedure: 
Install the Secondary Peri-Pump on page 
21 to remove the Secondary Peri-
pump from the top of the MultiFlo. 

 2. Wrap a rubber band around the pump 
itself.

 3. Place the module in the plastic bag 
and put it in its shipping box.

 4. Pack other accessories and the power 
cord in the box. 

 5. Repack the cardboard and foam 
shipping materials to secure the items 
in place.

 6. Tape the box closed. This box will fit 
into the box with the instrument. 
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MultiFlo Repacking Illustration 2 

 1. Reverse the 
steps 
described to 
Remove the 
Shipping 
Hardware
page 19. First 
remove the 
two shipping 
brackets         from 
the back of the 
instrument, 
then install 
them.

 2. Put a rubber 
band around 
the Peri-pump.

 3. With the 
shipping 
hardware 
installed, sit 
the instrument 
in the foam 
edged box 
bottom.

 4. Place the end 
caps on either 
side and put 
all items inside 
the interior 
shipping box.

 5. Place accessory 
boxes inside 
interior box.

 6. Tape the box 
closed.
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 7. Put the eight 
foam corner 
blocks on the 
interior box  
and put it 
inside the 
outer box.

 8. Tape the outer 
box closed.

 9. Write "RMA" 
in large, clear 
letters on the 
outer box. 

 10. Include the 
RMA number 
in the address 
label.
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Repacking the Syringe Dispenser

After preparing the instrument for shipping, and reversing the installation steps, 
pack the Syringe dispenser as shown here:

Fill the foam tray with 
the Syringe dispenser 
accessories and place 
the tray on top of the 
inner foam box 
containing the pump 
and supply bottles.                         

BioTek Instruments, Inc.



54 | Chapter 2: Installation

MultiFlo™ Microplate Dispenser



Chapter 3

Operation 

This chapter provides instructions for controlling the MultiFlo. 

Basic Operation 56
Optimize Performance 57
Predefined Protocols Listing 60
Predefined Sample Protocols 61
Protocol Parameters Tables 62
Operating with the BioStack 66
Introducing the MultiFlo Keypad 68
Define Instrument Settings (Using the Keypad) 76
Using LHC to Control MultiFlo™ Dispenser 79
Introducing the LHC Workspace 80
MultiFlo Steps 81
LHC Protocols 82
LHC Protocols Explained 83
Target Instrument Settings 84
Plate Types and Processing Patterns 87
Handling Special Plates and Mini-tubes 89
Dispense Processing Patterns 93
Peri-pump Peristaltic Dispenser 96
Peri-pump: How it works 97
Peri-pump Dispense Step 100
Require a Specific Peri-pump Cassette 101
Dual Syringe Dispenser 103
Syringe Dispense Step 105
Syringe Dispenser Settings 109
Syringe Dispenser Settings (Keypad) 109
Syringe Dispenser- Autoclavable vs. Non-autoclavable 110
Changing the Instrument's Settings 111
Adjust Utility 112
AutoPrime 114

 



56 | Chapter 3: Operation

Basic Operation

Two ways to control the MultiFlo

You can control the MultiFlo using its built-in keypad or with BioTek's Liquid 
Handling Control™ (LHC) software. 

To use the LHC to control the instrument, it must be attached to and 
communicating with your personal computer (PC), and its main menu must be 
displayed. Basic protocols can be created or modified using the LHC, and then 
downloaded to the instrument for stand-alone operation. Learn about 
transferring protocols from the LHC to the instrument in the LHC Help system: 
select the Help menu or click a Help button in a window.

 l Find instructions for using the LHC beginning page 80.

 l Keypad instructions begin on  page 68.

Two ways to dispense fluid to a plate

The MultiFlo offers two ways to dispense fluid:
 l Quick Dispense: using the keypad you can dispense to a plate by defining the fluid 

volume and relying on default parameters for the more advanced options. See Quick 
Dispense (Keypad only) on page 70.

 l Run a Protocol: using either the keypad or the LHC you can run a dispense protocol to 
fill a plate. You can run a predefined protocol or define your own protocol to specify the 
optimal parameters for your assay. See RUN: Running Predefined Protocols on 
page 58.

Turn On the Instrument

To turn the instrument on or off, press the On/Off switch on the side panel:

| = On  ¡ = Off

The MultiFlo performs a self-test. 

 l If the test passes, the Main Menu will appear and the instrument is ready for 
use. 

 l If the self-test fails, the MultiFlo  will beep and display an error code. Make sure 
nothing is obstructing the movement of the plate carrier and the devices and restart 
the instrument. If the error persists, look up the code in Appendix A: Error Codes 
of the operator’s manual, shipped on CD.
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Optimize Performance

Here are some guidelines to ensure optimal performance and to prevent problems.

Keep the devices clean and the tubing wet

The most critical factor for ensuring optimal performance is to adhere to the 
Recommended Maintenance Schedule on page 124. Enable AutoPrime to keep tubes 
from clogging.

Prime the tubing to remove air bubbles
 l See Recommended priming volumes for the Peri-pump on page 98

 l See Recommended prime volumes for the Syringe dispensers on page 104

Peri-pump
 l See Release the tension on the dispense cassette on page 99

Best Practices for all MultiFlo Devices
 l Fill the supply bottles with sufficient fluid.

 l Make sure the bottles, solutions, and tubing are clean and do not contain any particles or 
mold. Solutions that are recycled over several days will grow algae, bacteria, molds, or 
other undesirable organisms.

 l Prime before dispensing. Priming the tubing is the most critical factor in assuring optimal 
performance.

 l Put microplates on the carrier with well A1 in the left rear corner as you face the 
instrument, and firmly seat the plate in the carrier.

Before using the Peri-pump
 l For top performance and to preserve precious fluids, Purge the fluid at the end of a 

dispense run and Prime the tubing before dispensing. The tubing is permeable to air. 
When 20 minutes or more have elapsed between dispenses, or less than 20 minutes 
when using 1 µL cassettes, it is important to thoroughly prime the tubing before 
dispensing.

 l Use the priming trough insert to capture expensive reagents for reuse. The Peri-
pump’s insert can hold up to 12 mL.

 l Filter the dispense fluid to 50 microns before dispensing with the 1 µL cassettes. The 
dispense tips are very small. Filtering the fluid helps prevent clogging.

 l Select the right cassette for the job: match your desired dispense volume to the 
recommended cassette. The smallest recommended volume for a cassette type is one 
aliquot. An aliquot matches the cassette type, 1 µL for the 1 µL cassette, 5 µL for the 5 µL 
cassette, and 10 µL for 10 µL cassette.
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 l Dedicate cassettes for specific fluids or applications. Reserving specific cassettes 
for specific uses avoids contamination.

 l When the dispenser is idle, release the Tube Tensioner element of the cassette from 
its place on the pump to minimize unnecessary stretching of the tubing. This is especially 
true for the 1 µL tubing. The best practice is to unload the 1 µL cassette when dispensing 
is completed.

 l To more quickly dispense to 384- and 1536-well plates, use the Instrument Utilities to 
change the Dispense Pattern to Row. If precision is more important than speed, keep 
the pattern set to Column.

Before using the Syringe Dispenser
 l Sufficiently prime the Syringe dispenser to ensure precision and accuracy: increase the 

number of prime cycles to adequately remove all air bubbles from the tubing.

 l Use the priming trough insert to capture expensive reagents for reuse. Each Syringe 
dispenser’s insert can hold up to 6 ½ mL.

RUN: Running Predefined Protocols

BioTek provides numerous predefined protocols for maintaining the instrument 
in top condition and for qualifying its performance. Review  the Predefined 
Protocols on page 60.

To run a defined protocol:

LHC Keypad

 1.  Select Open and locate the 
MultiFlo folder.

 2. Open the MultiFlo folder to 
access the more folders.

Important: Be sure to Customize the 
Predefined Protocols on the facing page

 1. At the main menu, press RUN.

 2. Press Options to scroll to the 
desired protocol or use the arrow 
and number keys to enter its 
number.

 3. Press ENTER and follow the 
prompts.

Creating Protocols: Dispensing Fluid

In addition to the quick routines available from the keypad’s main menu, you can 
define and run protocols. Protocols offer more parameters, giving you the ability to 
fine-tune instrument performance, and perform more complex processing. 
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Keypad Control    

  Find instructions for creating and modifying protocols using the keypad 
beginning  page 71.  

Liquid Handling Control™ (LHC) Software

 Launch the LHC software to create or modify protocols,  see page 80.

 Select Help>Help Topics to learn about the LHC.

LHC Users Only: Customize the Predefined Protocols

BioTek provides predefined protocols for maintenance   routines and instrument 
qualification tests. You can quickly customize the   protocols for regular use. 

  The LHC keeps track of the  last-used COM port for an instrument type. For example, 
when an EL406 runs a protocol, the LHC logs the COM port used and the next time an EL406 
is used, the LHC applies the same COM port setting. You can disable this feature by defining 
your Ports preference: select Tools>Preferences>Ports. 
To correct the COM port for the current protocol, click the Port link  and use the drop-down 
list to select the correct value. The LHC stores the COM port value in the protocol file. 

With the MultiFlo connected to and communicating   with the host computer (i.e. 
make sure the instrument is turned on and not busy):

 1. Click   the Open button, locate the MultiFlo   folder and click Open.             

 2. Open   the Maintenance or other folder   and select the desired protocol.             

 3.  Change the COM port   if necessary: click Port and enter the   correct value 
or select from the drop-down list.             

 4.    Click Settings, which opens the Instrument   Settings dialog.             

 5. Under   Get settings from: click the instrument   link.             

 6.  Click Validate.              

A "Validation successful"   message is displayed unless the protocol cannot be 
run on your instrument.   See LHC Protocols Explained on page 83.

 7.  Save the protocol.             
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Predefined Protocols Listing

Maintenance Protocols

Daily 
Maintenance Description

S-DAY_
RINSE_A&B

Two-step protocol to flush tubing for both syringe pumps (A & B).   40 mL 
per syringe.

P-#UL_CASS_
RINSE  

Where # matches the cassette in use. Simple one-step protocol to flush   
Peri-pump tubing. (P2 protocols are for the secondary Peri-pump)

Periodic Maintenance

S-Decontaminate
S-DECON 
(onboard)

This protocol includes prompts for first running disinfectant and later   
running water through the system; for Syringe A only. It can be easily   
modified to suit any major cleaning effort.

S-LONG_
SHUTDOWN

Prepares the instrument for long-term storage. This protocol includes   
prompts for running disinfectant, then water, and lastly, air through   
the system. Defined to use Syringe A. 

S-DAY_RINSE Identical to S-DAY_RINSE_A&B except only Syringe A is defined.

QC (Quality Control) Protocols

Manifold-Specific  

SA-1536_DISP_
TEST

Dispense precision test protocol for 32-tube Syringe A manifold.

SB-1536_DISP_
TEST

Dispense precision test protocol for 32-tube Syringe B manifold.

P-1536_DISP_TEST Dispense precision test protocol for Peri-pump 1 µL cassette and 
1536-well       plate. (P2 protocols are for the secondary Peri-pump)
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Predefined Sample Protocols

The "Sample" protocols are provided to facilitate   learning. Some samples are model 
specific.

 

LHC users: You may need to customize the protocols (as described on page 59) to 
match your instrument's settings. 

Serial dilutions

P-96_
DILUTION

Peri-pump serial dilution protocol dispenses 20 µL to 240 µL in 20 µL        
increments to each column of the plate. 20 µL to column 1; 40 µL to 
column       2; 60 µL to column 3; and so on till 240 µL to column 12.

P-384_
DILUTION

Serial dilution protocol dispenses 2 µL to 94 µL in 2 µL increments        to 
each column of the plate. 2 µL to column 1; 4 µL to column 2; and so       on 
till 94 µL to column 24.

S-96_
DILUTION

Syringe dispenser serial dilution protocol dispenses 240 µL to 20        µL in 
20 µL increments to each column of the plate. 240 µL to column 1;        220 
µL to column 2; 200 µL to column 3; and so on till 20 µL to column       12. 
Defined for Syringe A.

S-384_
DILUTION

Serial dilution protocol dispenses 98 µL to 6 µL in 4 µL increments        to 
each column of the plate. 98 µL to column 1; 94 µL to column 2; 90        µL 
to column 3; and so on till 6 µL to column 24. Defined for Syringe       A. 
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Protocol Parameters Tables

Peri-pump Parameters

Step Option Description/Values range Default 
values

Prime  To remove air from the tubing.  

  Volume: 1-3000 µL 300

 Duration: 1-300 seconds 3

Dis-
pense

   

 Volume The per-well volume to dispense: 10

    1 µL cassette = 1 - 50 µL and 0.5 µL (HLF-D) for 
some models*

 

    5 µL cassette = 5 - 2500 µL  

    10 µL cassette = 10 - 3000 µL  

 Flow rate: The rate, μL/second/tube, that fluid is dispensed for 
each cassette type:

Cassette Type 1 μL 5 μL 10 μL
 (μL/sec/tube)
Low 50        120 140
Medium 60 140 160
High 64 160 180

When dispensing 0.5 µL with the 1 µL cassette 
the average flow rate values are:

1 μL Cassette 0.5 μL Dispense
 (μL/sec/tube)
Low 52        
Medium 54      
High 56      

High

 Cassette 
type 
required?:                  

To require a specific cassette type for this protocol. If 
yes, select the type, if no, select ANY. See Peri-
pump Settings to learn more.

ANY

 Plate type: Select the plate type, and optionally, limit the 
columns dispensed to. For high density plates, 

96
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Step Option Description/Values range Default 
values

skipping certain "Rows" sections is supported, see 
Peri-pump Dispense Pattern on page 94. 

 Posi-
tioning:

X- and Y- horizontal axes, Z- height (vertical) axis 
can be adjusted to improve performance. X- and Y-
axes default to 0 steps for all plate types.

Z = plate 
type 
depend-
ent

 Pre-
dispense:

Also called "tip priming," pre-dispense normalizes the 
tips to ensure precise fluid distribution. It dispenses 
into the priming trough immediately before filling the 
plate. Pre-dispense is recommended for most 
applications.  Set volume and number of pre-
dispenses, except, when dispensing 0.5 µL, the 
volume is preset: 0.5 µL for 4 cycles by default.

10 µL
2 cycles

Purge  To preserve fluid in the tubing by pumping it back into 
the supply vessel, i.e. reverses the flow direction.

 

  Volume: 1-3000 µL 300

 Duration: 1-300 seconds 3

Note: *Half-microliter (0.5 µL) dispensing requires a 1 µL cassette. The Cassette 
Requirement Mode behavior is implemented whenever a 0.5 µL volume is requested. 
Make sure a 1 µL cassette is installed and the Cassette Type setting matches it. 
When supported, only a 0.5 µL dispense volume can be requested, not 1.5 or 2.5 µL, for 
example. Perform two dispense steps, one for the half microliter and another at a full 
increment to achieve these volumes.

Syringe Dispenser Parameters

Step Option Description/Values range Default 
values

Prime    

 Flow rate: 1-5 (See dispense step description below) 5

 Volume: 80-8000 µL. To remove air from the tubing. 5000

 Syringe: A or B A

 Cycles: Number of prime cycles to perform 2

 Pump 
delay:

0-5000 msec. 0
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Step Option Description/Values range Default 
values

  When dispensing highly viscous fluids, the tubing's 
check   valves perform more slowly. Delaying the 
syringe pump sufficiently to   allow the specified 
amount of fluid to pass through the check valves 
before   being pumped into the syringe has been shown 
to improve dispense accuracy.   
Begin by setting the delay to 500 msec. Experiment 
with   different settings to determine the optimal value 
for your fluid.

 

 Submerge 
tips:

To soak dispense tubes in the priming fluid for a 
specified duration for cleaning or maintenance 
purposes. If yes, set duration, up to 24 hours, in 
minutes. See Syringe Prime Step to learn more.

0

Dispense    

 Flow rate: Rates 1-5 are dependent on the volume and plate 
type, except for 1536-well plates. See below.

2

 Dispense 
Volume:

5-3000 µL depending on the plate type. 10

 Syringe: A or B or Both A

 Columns: Select the plate type, and optionally, limit the columns 
dispensed to.

96

 Pump 
delay:

(Same as Prime step description above.)  

 Positioning: X- and Y- horizontal axes, Dispense height (Z- or 
vertical) axis can be adjusted to improve 
performance. Default values plate type dependent; 1 
mm higher than the plate height.

 

 Pre-
dispense:

When enabled, dispenses into the priming trough 
immediately before filling the plate. Pre-dispense is 
recommended for most applications. It normalizes the 
tips to ensure precise fluid distribution. Set volume 
and number of pre-dispenses.

10 µL
2 cycles

Syringe Dispenser Flow Rates:

Rates are volume and plate-type dependent:

For example, rate 1 must be   used when dispensing between 10-19 µL to a 96-well 
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plate. When dispensing   20-49 µL to a 96-well plate, you can use rates 1 or 2. And, 
when dispensing   50-59 µL to a 96-well plate, you can use rates 1, 2, or 3. And so 
on,   as shown in these tables.

96-well plate 16-Tube 8-Tube

Volume 
(µL)

Rate µL/sec/well

10-19 1 450 140
20-49 1-2 600 209
50-59 1-3 750 279
60-79 1-4 900 350

80-3000 1-5 1000 420

384-well plate

Volume 
(µL)

Rate µL/sec/well

5 -9 1 225
10-24 1-2 300
25-29 1-3 375
30-39 1-4 450

40-1500 1-5 500

 n Note:   For 16-channel syringes the µL/sec/well rate accounts for   2 tubes/well 
when addressing 96-well plates and one tube/well for 384-well plates.             

1536-well plate

Volume (µL) 3-3000
The 32-tube manifold flow rates do 
not have minimum   volumes.
The µL/sec/well for each type of 
manifold, Small Bore (SB) and Large 
Bore (LB), is shown:

Rate SB LB

1 56 125
2 58 150
3 60 162
4 62 174
5 64 187

The default rate is 3. 

See Plate Types Table on page 87 for default Z-axis values or dispense heights.
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Operating with the BioStack

If you purchased BioTek’s BioStack Microplate Stacker to operate with the 
MultiFlo, here is some important information about running it:

LHC Control:         

 l LHC users: connect both the BioStack and the MultiFlo to the computer and control them 
with the LHC.

 l The LHC lets you design protocols that integrate BioStack controls with MultiFlo steps. 
LHC protocols must contain a BioStack loop.

 l In the LHC, select Help>Tutorials, click Sections in the toolbar for a drop-down menu, 
select Controlling the Bio-Stack with LHC. It only takes a couple minutes to 
complete this interactive demo. It is a great way to learn about the special BioStack 
features offered with the LHC.

Keypad Control:

 l The Quick Dispense options do not function with the BioStack, i.e. the BioStack will not 
deliver a plate. You must create a protocol to process plates using the BioStack.

 l You can use the Quick Dispense Prime options. This is recommended especially prior to 
processing plates, to remove air from the tubing. 

 n Only one of the MultiFlo's communication ports can be used at a time: you can 
plug in either the USB cable to connect it to the PC or the serial cable to 
connect it to the BioStack (but not to both at the same time).

Install and Align the BioStack:

 1. Set up the BioStack according to instructions in your BioStack Operator’s 
Manual to interact with the MultiFlo. Connect it to the:

 o Host computer (PC) when using the LHC to control the MultiFlo.

 o MultiFlo when using the keypad to control the instrument. 

 2. Align the BioStack’s gripper with the MultiFlo’s plate carrier: 

LHC: Keypad:

 1. Select Tools> BioStack 
Utilities.

 2. Use the Alignment Utility.

Click the Help button for 
detailed instructions.

 1. Press Setup Menu.

 2. Select à

 3. Select BIOSTK.

 4. Select ALIGN.

 3. Set the BioStack operating mode:
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LHC: Keypad:

 1. Press Setup Menu.

 2. Select à

 3. Select BIOSTK.

 4. Select CONF.

 5. Select BIOSTACK.

Fill the BioStack checkbox in the 
main view to enable the BioStack 
action buttons and use them to 
design a protocol that delivers and 
retrieves plates. 

Important: When using LHC to 
control the MultiFlo and the 
BioStack, the instrument's BioStack 
configuration setting must be set to                           
MANUAL, not "BIOSTACK."

 n To Restack or not? Yes: to keep plates in the same order. No: to save time 
when the plate sequence is unimportant.

 5. Verify the setup: perform a protocol with 1 or 2 plates. 

 At the start of the day, power up the BioStack first, and then the MultiFlo. 
BIOSTACK2WR: Lift the BioStack’s gripper before turning it on.

Robotics integrators: CAD drawings of the  physical dimensions of the MultiFlo are 
available upon request. Contact BioTek customer service. 

Technical Note: Only one of the two communication ports (COM port) on the  
instrument can be used at a time. They cannot be used simultaneously. You 

can use USB  to connect the MultiFlo to the computer or the RS232 serial port to 
connect to a BioStack or similar robotic device. But you cannot use both ports 
simultaneously, i.e. make sure only one cable is plugged in at a time.

Keypad Control: When the BioStack is connected to your  MultiFlo, you are 
controlling both instruments using the keypad. Before connecting the MultiFlo to 
your computer to download basecode or for other reasons, you must first 
disconnect the BioStack from the MultiFlo and change the Instrument Setting for 
the BioStack:  Press Setup Menu> g> BIOSTK> CONF>MANUAL.
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Introducing the MultiFlo Keypad

The keypad on the MultiFlo™ Microplate Dispenser features 26-keys and a 2 x 
24-character LCD. The main menu is shown below.

Starting at the top of the keypad, note the main menu and the Soft-keys. Use the 
Soft-keys to make selections. To return to the main menu, press the Main Menu key.

At the main menu, the top line displays AP when AutoPrime is enabled.

 l RUN - to run a previously defined protocol. Use the Options key to select a 
protocol or enter its number. See Predefined Protocols Listing on page 60.

 l QUICK – leads to the Quick Dispense menus. Depending on the devices 
installed, press Pump to scroll to the     PRI or SEC for Peri-pump, and when 
the Syringe dispenser is installed, SYR-A, SYR-B, or SYR-BOTH quick 
dispense menus, if applicable:

 l See Quick Dispense (Keypad only) on page 70:

 o Peri-pump Dispenser (PRI or SEC) options:

 l First, make sure the PRI-# and SEC-# matches its installed cassette 
type. If not, change the setting: See Change the cassette   type setting 
on page 29.
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 l Press and hold the Prime and Purge keys to execute these actions for 
as long as you hold the key.

 l Set the dispense VOLume using the arrow and number keys, put a 
plate on the carrier, and press Start.

 o Syringe Dispenser: When the dual Syringe dispensers are installed press Pump 
at the quick menu to toggle through the list of dispensers, Syringe A, Syringe B, or 
Syringe-BOTH.

 l Press the Prime key to prime the tubing with 5000 µL of fluid.

 l Set the dispense VOLume using the arrow and number keys, put a 
plate on the carrier, and press Start.

 o PUMP – to select the device to perform a quick routine.

 o PLATE – to select the plate type for a quick routine. The default plate type  is 96-
well. Press PLATE to  scroll through and select a plate type. See Define the 
Plate Type and Plate Map (or Partial Plate) on page 73 and the Plate 
Types Table on page 87 to learn about the types of microplates supported.

 l DEFINE –  leads to the protocol creation and editing mode: Create or Edit a 
Protocol on page 71.

 l  UTILS – to run system tests, the Adjust Utility, and to define AutoPrime 
parameters.

 l Setup Menu: press this key to access the instrument’s general settings and the 
settings for each of the devices and the BioStack. 

 l The Options key (and sometimes the arrow keys) scroll through the available 
options or settings for the current focus. Shift+Options reverses the scrolling 
direction.

"Hardware Change Detected" - you may need to update the instrument's settings 
when this message is shown. See Define Instrument Settings on page 44.
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Quick Dispense (Keypad only)

 1. Select QUICK at the main menu to perform a quick dispense. 

 2. Press PUMP (if necessary) to select the dispenser you want to use. Depending 
on how many dispensers are installed, pressing Pump scrolls to the      PRI or SEC 
for Peri-pump (for primary and secondary pumps), or when the Syringe 
dispenser is installed, SYR-A, SYR-B, or SYR-BOTH quick dispense menus, if 
applicable.

96    SYR-A     VOL:0100 uL
PRIME        PUMP  PLATE 

Quick Dispense Menu

The MultiFlo displays the last Quick Dispense that was run for the selected device:

 l 96 (displayed above) is the plate type. Select PLATE to change it; scroll 
through the compatible choices for plate with the currently installed 
hardware and press Enter to select the desired plate.

 l PRI-# or SEC-# is the Peri-pump cassette setting. Make sure it matches the 
currently installed cassette:          See Change the cassette   type setting on page 
29. Refer to  instructions for physically changing the cassette: Install the 
Dispense Cassette on page 27. 

 n 0.5 µL dispensing is not an option via the Quick menu. You must 
define a protocol (Half microliter)

 l SYR-A            or SYR-B or SYR-BOTH identifies the Syringe dispenser to be used in 
the Quick Dispense. 

 l VOL:0010 uL shows the dispense volume (not the priming volume) per well 
in microliters (µL). 

 To change the dispense volume, use the arrow keys to 
move the cursor to the desired number position. The cursor appears to 
underline a number: 0010. When the correct position is selected, use the 
number pad to enter the desired value.

 l Prime: At the Peri-pump dispense screen, press and hold the prime key to 
prime the tubing. Fluid flows into the prime trough for as long as you press 
the key. For the Syringe dispensers, PRIME pumps 5000 µL each time it is 
selected.
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 l Purge: At the Peri-pump dispense screen, press and hold the Soft-key to 
purge the tubing. Fluid is pumped back into the supply vessel as long as 
you press the key.

 l Plate: lets you to change the plate type and plate map or, more accurately, 
the columns of the plate to dispense to. See Define the Plate Type and Plate 
Map (or Partial Plate) on page 73.

 n  153F: For best performance with this plate type use SYR-BOTH (both 
Syringe A and B) and remove the Peri-pump dispense cassette, or remove 
the Syringe manifolds when dispensing with the Peri-pump.

 When the desired values are entered, put a plate on the carrier and press 
Start to run the routine. Up to 10 quick dispense routines are saved for each 
dispenser. When 10 have been defined, the newest replaces the oldest. When the 
desired dispenser is displayed onscreen, press the Options key to scroll through 
the quick routines to select one.

Create or Edit a Protocol (Keypad Only)

At the main menu:

 1. Select DEFINE, and then, CREATE or EDIT.

  CREATE EDIT

2. Name the protocol and select the 
Plate Type.  Press Enter after 
making selections to proceed. See 
 How to name a protocol 
(Keypad only) on next page

Select the protocol to edit: enter 
its number or use the Options key 
to scroll through the stored 
protocols to select one. Then, you 
can edit the name and plate type, 
if desired. Press Enter to proceed. 

3. Define or modify the plate type using the Previous and Next buttons to 
scroll through the supported Plate Types.

4. Select ADD to define the first 
step: then, select the device to use 
or SHAKE to mix or soak the 
plate’s contents.

EDIT the first step or press the 
Options key to scroll to the step 
you want to change in a multi-step 
protocol.

 5. Select the device to use:

 
PERIP To dispense fluid using the Peri-pump dispenser. Select 

HLF-D for 0.5 µL, if applicable.

 
SYRNG To dispense fluid using one or both of the Syringe 

dispensers, A or B.
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SHAKE To mix the contents of the plate and/or soak or steep the 

fluids for a specified time period.

 

5.
6.

Select the action you want the device to perform and then define the 
step’s parameters.  Press Enter to proceed.

6.
7.

Keep Added Step? Save Step Changes? 

  Select Yes or No using the Soft-keys to save or discard your inputs for 
the current step.  

* 
Press Main Menu to end the session at any time. Then, select RUN 
and select the protocol to run it. 

See Protocol Parameters Tables on page 62 for valid ranges.

How to name a protocol (Keypad only)

NAME:
- % & _

 

At the Name screen when you are creating or editing a protocol, you can enter 
up to 16 alphanumeric characters to name the protocol:

 l Press Shift + the number key for A-H, or scroll through the alphabet with the 
Options key for A-Z.

 l Press Shift +Options to reverse direction.  

 l Use the arrow keys ◄ ► on either side of the Options key to move the 
cursor within the display. 

 l Press its Soft-key to add one of the four symbols (- % & _) in the display to 
the protocol name. 

 l Press ENTER when you are finished to store the protocol name.

 n If the name already exists, an Invalid Protocol Name message displays and 
you must enter a unique name.
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Define the Plate Type and Plate Map (or Partial Plate)

The MultiFlo, depending on the currently installed hardware, can process 96-well, 
384-well, and 1536-well plate types. Dispensing to a part of the plate is limited by 
the foot print of the hardware. When dispensing you can skip certain columns in 
any plate type. This requires defining a “plate map.” By default, the whole plate is 
processed. 

Quick Dispense

 l When defining a quick routine, select Plate with the Soft-key to set the plate 
type, and to define the plate map. 

Protocols

 l When creating or editing a protocol (Define mode), set the Plate Type after 
naming the protocol.  Use the                     Next or Previous button to scroll through the 
options. 

 l To define the plate map (i.e. the columns, and rows when using the Peri-
pump):

 o Dispense step: press Enter to proceed to the plate map screen. 

To change the plate type:

 l Quick Menu: Repeatedly press the Soft-key under the plate type (in the right corner of 
the display) to scroll through the available options. Hold the Shift key while pressing the 
button to reverse direction. 

Plate Map          Plate Type
g c g g g g g g g g g g                    
  —                                        

Column: 02 . . 12                     96  
                          l

The two-line display changes to show a representation of the current plate type’s 
columns in the top line. The display shows each column as a filled or empty 
square; empty columns will not be dispensed to. For the current plate type, 
shown in the right corner, the left corner shows the selection range, beginning 
with the currently selected column. (In the example above, column 2 is currently 
selected to be skipped.)

 l DEFINE mode: When defining a protocol, press Next or Previous to specify the plate 
type.
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The two-line display changes to show a representation of the current plate type’s  
sectors in the top line, with each sector as a filled or empty square; empty 
sectors will not be  washed. Press the Options button to toggle the sector to filled 
or empty.

Press the Clear button once to empty all the columns. Press it again to fill all the columns. 
This is useful when you want to dispense to only a couple columns.

g g g g g g g g g g g g g g g g g g g g g g

—                                          
Columns: 01 . . 24       à             1536  
       l                   l

1536-well plates require two screens to show all 48 columns. Select the à key to toggle 
between the two screens to select the columns to dispense to.

1536F - 1536-well Flanged Plates

Important: Crashes can occur! Remove unused manifolds when dispensing to 153F 
plates. 

To prevent an unused Peri-pump cassette  or  Syringe manifold from colliding with 
the plate flange during dispensing:

 l use both Syringe manifolds simultaneously, and,

 l unload the Peri-pump cassette when it is not being 
used;

 l alternatively, remove the Syringe manifolds while 
using the Peri-pump;

 l limit protocols to one dispenser only, either the 
Syringe or Peri-pump, i.e. run multiple protocols on a 
plate when the assay requires using more than one 
device.

To change the plate map (selected columns):

 1. When defining a protocol, press Enter until the plate map screen is shown.

 2. 34 Use the arrow keys to move the cursor to the column you want to change. 
The cursor underlines the currently selected column and its number is shown 
in the display. (In the top example, column 2 is currently selected.)
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 3. Press the Options key to toggle between filling the column or not. When the 
image of the column is filled it will be dispensed to. Conversely, when the 
column image is blank or unfilled, the column will not be dispensed to.

 4. Press Enter to save the settings and continue. 

Skip "rows" when Peri-pump Dispensing

The Peri-pump offers an additional way to limit dispensing to a plate:        See 
Dispense Processing Patterns on page 93 .

How to shake the plate

These instructions are for keypad control. 

The shake command is tied to the Soak option. These instructions apply to soaking 
or incubating the plate at room temperature, as well as shaking. 

To specify a shake period:

 l Shake step: create a protocol to shake the plate, it can be a one-step, shake-
only protocol, or you can ADD a Shake step before or after another step.

 n See Create or Edit a Protocol (Keypad Only) on page 71

 n Soak is not the same as "submerge" the tips. You must define a prime step or 
use the AutoPrime feature to soak the tips in the priming trough.

 n Soak is equivalent to incubating the plate at room temperature or delaying the 
protocol.

How to enter negative numbers (Keypad only) 

Some protocol parameters, like Horizontal Dispense Position (X-axis), require 
inputting a negative number to improve performance.

To enter a negative value:

 1. Using the number pad, start at 00 (zero) and press Shift +Options to display 
the minus sign.

 2. Use the number pad to enter the desired value. The minus sign will remain, 
making it a negative value.
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How to copy a protocol

You can save significant time creating protocols by copying a protocol that shares 
some of the same protocol parameters and then editing the copy to meet your 
needs.

LHC users: Open the protocol you want to copy and select File>Save As. Assign 
unique file and protocol names to it. Consult the Help to learn more.         

Keypad users: 

 1. Select DEFINE at the main menu.

 2. Select Copy. 

 3. Choose the type of protocol  you want to copy. 

 4. Use the Options key or enter the protocol number to select it.

 5. Enter a unique name for the new protocol you are creating. 

 6. Select Yes to copy the protocol. Then, you can edit the protocol, as needed.

How to delete a protocol

You can delete protocols to prevent other users from running them.

LHC users: use Windows Explorer or My Computer to delete the protocol file from 
your PC.         

Keypad users: 

 1. Select DEFINE at the main menu.

 2. Select DELETE. 

 3. Use the Options key or enter the protocol number to select it.

 4. Select Yes to delete the protocol. 

Define Instrument Settings (Using the Keypad)

Press the Setup Menu button in the middle of the keypad

Use this menu map to navigate the Setup Menu:

PERI SYR g BIOSTK CARR PLTCLR

Pump: 
Prime/Cass/Purge

Manifold type  BioStack Plate 
Carrier

Plate 
Clearance
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PERI SYR g BIOSTK CARR PLTCLR

Pattern: Row or 
Column

CAL: Calibration Data  CONF 
(Mode)

STD/VAC Offset in 
mm

Mode: 
Prompt/Error/Set

Type: Autoclavable 
/Non-
autoclavable/None

 ALIGN   

Because variations in the hardware have a big effect on the instrument's 
performance, you must ensure the instrument's settings match the installed 
hardware. 

Change the Peri-pump Dispense Pattern (Keypad)

LHC users: Change this setting in the Instrument Utilities.

Select the fill pattern: by column or row for   processing 384- and 1536-well plates.  

 Choose row for faster throughput or column for more precision.             

For high-density plates, the 8-tip manifold must address   the plate multiple times to 
fill it. Column-wise dispensing fills each   column before moving to the next. Row-
wise dispensing fills the first   8 rows, then reverses direction to fill the next 8 rows, 
and so on.  Once it is defined, your pattern preference will apply to   all runs, Quick 
Dispenses and protocols.

 1. Press Setup Menu (button in center of keypad).

 2. Select PERI and then   PATRN.

 3. Select the desired dispense pattern by pressing its Soft-key: 

 l COL - column

 l ROW - row.

Change the Plate Carrier Setting (Keypad)

For LHC instructions see Change the Plate Carrier Setting using the LHC 

The instrument's onboard settings must match the installed hardware. 

When you physically change the plate carrier to perform special assays,  you must 
also change the instrument carrier setting to direct the devices to higher or lower 
positions to accurately address the wells:
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 1. Press Setup Menu (button in center of keypad).

 2. Select g and then CARR.

 3. Select the currently installed carrier by pressing its Soft-key: 
 o STD - Standard (Magnet Ready) carrier

 o MTUBE - Mini-tube carrier.

Change the Plate Clearance Setting (Keypad)

The Plate Clearance setting adds the specified (input) value to the travel height for 
the selected plate type, i.e. it adds this number to the "Plate Height" value cited in 
the Plate Types Table. The manifold rises to this height to move from one column 
to the next and whenever repositioning is needed.     This setting does not affect 
dispense and aspirate heights.

Use this setting to accommodate plates that are slightly taller than standard     plates 
to make sure the manifolds rise high enough    above the plate to prevent crashes 
when the plate carrier moves. 

To change the setting using the keypad:

 1. Press Setup Menu (button in center of keypad).
 2. Select g and ADVANC then PLTCLR.

 3. Enter an offset value in millimeters (mm).          
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Using LHC to Control MultiFlo™ Dispenser

BioTek's Liquid Handling Control (LHC) software, which works   with the MultiFlo 
Interface Software (IS), is a more graphically rich way   to design protocols and 
control the instrument. The MultiFlo must be attached   to and communicating with 
your personal computer (PC) for the LHC to function.

Predefined Protocols.

BioTek provides predefined protocols for maintenance   routines, instrument 
qualification, and other purposes like serial   dilutions. 

 Click the Open button and locate the   MultiFlo folder to open a predefined   
protocol. 

Learn   how to Customize the Predefined Protocols on page 59 for your lab.

Communications Port

Click the Port link in the main screen

The LHC needs to know the COM   Port - Communications Port: USB or Serial component 
on the instrument used to connect the dispenser to the computer.   

 n Make sure the MultiFlo is connected to   the computer, turned on, and not busy.             

 n Learn more About   COM Ports in the LHC Installation   Guide or select 
Help>Help Topics.             

Click Test Communications after   entering the number to verify its accuracy. The 
LHC will display a message.   

If communication is unsuccessful:
 l Check   the cabling: make sure you're using a new/undamaged BioTek-supplied   cable 

and it is properly inserted into the instrument's USB or serial   port.              

 l Turn   on the dispenser: make sure the instrument is on and not   busy processing a 
plate, running AutoPrime, or performing a system test,   for example.             

 l Retry:   contact BioTek TAC if you are still unable to establish communication   between 
the instrument and the PC.             
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Introducing the LHC Workspace

 Instrument Settings: Click the Name link and select your instrument.

 MutliFlo Steps: see below.

 Define a Protocol: select Help>Help Topics to learn how.
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MultiFlo Steps

Because the MultiFlo offers  two dispensers in one instrument:   a peristaltic pump 
dispenser called the Peri-pump,   and dual Syringe pump dispensers, there are 
action buttons for   each component. You will only see buttons that correspond to 
the devices and options available on your configuration of the instrument (as 
defined in Target Instrument Settings.)

Click the action button and define the parameters to add   that step to the 
protocol:

P- for   steps performed by the Peri-pump   dispenser. One or two 
Peri-pumps can be installed: PRI for primary and SEC for 
secondary.

S- for   steps performed by one of the Syringe   dispensers, when 
installed. 

Shake and soak are device-independent.

Each step is executed sequentially.   You can combine steps performed by 
different devices in one protocol.    Invalid   combinations of steps will be identified 
when you press the Validate   button.
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LHC Protocols

BioTek provides predefined protocols for maintenance   routines, instrument 
verification, and general samples for common applications   like serial dilutions. 

Review  the Predefined Protocols on page 60

Customize the Protocols

Typically, you must modify the predefined protocols to   match your instrument 
configuration and to meet your assay requirements.

Instrument Settings:   In addition to action steps, every protocol file contains 
instrument   settings, including COM port, manifold type, and so on. Edit the 
protocol   to match your instrument's COM Port and other configuration details: 
 l Customize the Predefined Protocols on page 59

 l Power Users: If you create protocols   for multiple instruments or for other LHC users, 
read   this more detailed description of how the MultiFlo validates a protocol   to be run on a 
specific instrument.             

 n Recommended:   Before changing  a predefined protocol, select File>Save   As 
and give it a unique name. This practice preserves the custom protocol   in the 
case of a future upgrade.             

File Location

The LHC installs the protocols   in the Windows Common Applications Data Folder:
 l Windows®   XP: C:\Documents and Settings\All Users\Application Data\             

 l Windows®   Vista™ and Windows 7: C:\ProgramData\             

The file location path continues:

[CommonAppDataFolder]\BioTek\Liquid   Handling Control 
v.#\Protocols\MultiFlo

Three folders are provided:
 l \Maintenance: the recommended daily   and periodic maintenance routines;

 l \QC: some of the quality control or   performance verification procedures;             

 l \Samples: examples of common applications,   including washing 96- and 384-well 
plates, performing serial dilutions,   and a cell wash protocol.             
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LHC Protocols Explained

Prerequisite

This discussion about MultiFlo protocols will be easier to   follow if you are already 
familiar with the LHC. Read "Understanding the LHC" in the Help.

Protocol Files

In addition to the "Protocol Steps" (the actions you tell the MultiFlo to perform to 
process plates), each protocol file contains "Instrument Settings."   

The LHC must know an instrument's settings in order to create a protocol that will 
run on that instrument. This virtual "Target Instrument Settings" feature lets you 
write protocols when the instrument is not connected to your computer.                  

Generally, and especially when you are managing only one instrument,   the best   
practice is to always match the instrument settings to your instrument. (Select "Get 
actual settings" from the connected instrument. Unless the instrument is not 
connected to the computer, then, you must specify the settings.)

The "Instrument Settings" stored in the protocol file include the COM port and 
configuration details like the type of manifold/dispense cassette installed, the 
presence of a Peri-pump or Syringe dispenser, and other details that are critical to 
controlling the instrument.

  The LHC keeps track of the  last-used COM port for an instrument type. For example, 
when an EL406 runs a protocol, the LHC logs the COM port used and the next time an EL406 
is used, the LHC applies the same COM port setting. You can disable this feature by defining 
your Ports preference: select Tools>Preferences>Ports. 
To correct the COM port for the current protocol, click the Port link  and use the drop-down 
list to select the correct value. The LHC stores the COM port value in the protocol file. 

Managing Multiple Instruments

The target instrument settings feature is useful for those managing multiple 
instruments. In addition to the flexibility of being able to create protocols for non-
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connected instruments, you can create and save an instrument settings file for each 
of your liquid handlers, another time saver.

Protocols are considered valid when an instrument can successfully perform  the 
protocol. The   LHC will run a protocol even when the instrument settings do not 
match the physical   configuration of the instrument. For example, a protocol with 
instrument  settings that include Buffer Switching can be run by an instrument 
without   Buffer Switching when none of the steps actually call for different   buffer 
valves, i.e. all steps use the same buffer.

Similarly, a   MultiFlo that does not have the Syringe dispenser   installed can run 
protocols with instrument settings that include the   Syringe, as long as the protocol 
does not include any Syringe dispenser   steps. This flexibility is useful when you 
are designing protocols   for multiple instruments. 

Validate versus Run

 Validate checks the action steps against the protocol's   Target 
Instrument Settings.

 Run talks to the instrument to check the action steps   against the 
instrument's onboard settings. 

Validate will catch   errors when the Instrument   Settings have been changed after the 
protocol steps have been defined   and there is a mismatch. Run performs   a similar 
validation before executing the protocol. Errors are not reported   unless the steps 
cannot be performed.  

Target Instrument Settings

 n For LHC users only.

Click the Settings link in the main workspace

Actual Instrument or Simulated Instrument? That is the question for the Target 
Instrument Settings dialog. 

When the MultiFlo is:
 l connected to the computer: it is best to "Get (the) actual settings" from it;           

 l not connected to the computer: you must define the settings.

One vs. Multiple Instruments
 l If you are running only one instrument, always "Get the actual settings" to identify the 

exact configuration of your MultiFlo to ensure   it can successfully perform the dispense 
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protocols.

 l If you are managing multiple BioTek instruments (or one instrument with multiple 
configurations): you can create and save a "settings file" for each instrument to help 
create protocols for that instrument when you are not connected to it. See below. 

The "instrument settings" tell the LHC what the instrument can do, e.g. fill a 384-
well plate or not. It is impossible to create a protocol without this information. Read 
this   to understand the correlation between the Target Instrument Settings and the 
protocol.

Get settings from:
 l Instrument:   BioTek configures and tests the MultiFlo at the factory before shipping it.   If 

you have not changed the instrument's onboard settings, you can safely   click the Get 
actual settings now link to upload the correct settings from the instrument.

 l Settings   file: If you have previously saved the instrument's settings to   a file (using the 
Save link), click this link   to import them.

 l This   screen: manually define the instrument's settings and click OK. This option does 
not affect the instrument's onboard configuration settings. It lets you define protocols for 
an instrument with the specified components.                                       

Configured with: 

Select the appropriate devices to identify your instrument's   components:
 l Syringe   Dispenser: when a dual syringe pump dispenser is installed, identify   the 

dispense manifold type:

 l Non-Autoclavable: the black plastic casing of the non-autoclavable syringes 
are easy to distinguish from the glass and stainless steel autoclavable 
syringes. This model only supports the 8-channel and 32-channel manifolds.

 l Autoclavable: glass and stainless steel autoclavable syringes.

8-tube Double manifold with two sets of 8 tubes.

16-tube 16-channel manifolds.

32-tube 1536-well plates only;
Model: Large Bore (LB) or Small Bore (SB) 

 l Peri-pump Dispenser: when the instrument is equipped with a peristaltic pump for 8-
channel dispensing. 

 l Optional Second Peri-pump

Save Settings File

If you have multiple instruments or use one instrument in   multiple configurations, 
you can create unique settings files for each   configuration and save time when 
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defining protocols for that configuration.   

Click the Save link and use Windows'   file-saving dialog to create a .SET file based 
on the currently-selected   parameters. Then use the Get "settings from a previously 
saved" link to load the   parameters.

How to define a Protocol (LHC only)

 n For keypad instructions: Create or Edit a Protocol on page 71

Review this topic: Define a Protocol   in the LHC's Help for more details. Or, for an 
in depth description of   MultiFlo protocols read   this.

In short:
 o Select the Plate Type and assign a unique Protocol Name Limit the name to 16 

alpha-numeric characters if you want to run the instrument using the keypad 
only, i.e. disconnected from the computer..

 o Click a button in the Add Step area.             

 o Define the parameters for   the step in the dialog that opens.             

 o Continue adding steps, if   desired.             

 o Save   the file and/or click Run to execute the protocol.             

 Double-click   a step in the protocol to open it for editing.
 •  Highlight   a step and press Delete to remove it. 
 •   Click   and drag a step to change its sequence order.
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Plate Types and Processing Patterns

Depending on the type of hardware installed on the instrument, e.g. manifold type, 
the MultiFlo can process several plate types. The default parameters for dispense 
steps represent the optimal positioning of the hardware for the plate type. And, the 
dispense heights and horizontal positions can be adjusted when necessary for 
special situations and to optimize assay performance.
 l Review the Plate Types Table below for a listing of supported plates and their 

geometries;

 l See Dispense Processing Patterns on page 93 in the Help system  or operator's 
manual.             

 l Review these instrument settings that may improve your work flow:
 o Plate Carrier Setting

 o Plate Clearance Setting

 o Peri-pump Dispense Pattern

Plate Types Table

Only the Peri-pump can process all plate types.          Only the 32-tube Syringe dispenser 
manifolds can dispense to 1536-well plates.

Plate Type
On board

Name
Columns x   

Rows

Plate 
Height

 
Default Dispense   

Height

mm Washer Dispensers

96 Well 96 12x8 14.35 121 336

 96 Deep Well  96D 12x8 41.50 335  929

 96 Half Well^ 96H 12x8 14.20 120  332

96 Mini Tubes 96MT 12x8 49.53 398 1105

384 Well 384 24x16 14.22 120 333

384 Deep Well 384D 24x16 44.08 355 986

384 PCR² 384P 24x16 9.50 83 230

1536 Well 1536 48x32 10.41 250

1536 Flanged‡ 153F 48x32 10.26 196
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Peri-pump Only Plates

Plate 
Type

Onboard 
name

columns x 
rows

Plate Ht. 
(mm)

Dispense Ht. 
(steps)

Tubes/  
well

6 Well 6 3x2 20.20 464 4*

12 Well 12 4x3 20.20 464  2*

24 Well 24 6x4 20.50 470 2

48 Well 48 8x6 20.10 461  1*

^ Only available for 8-channel manifolds
‡ Only 1536 Flanged (153F) plates have a "flange height" greater than zero. These plates require 
special handling.

 n *Important:   when dispensing to  6-, 12- and 48-well plates some dispense   
tubes must be removed from the fluid supply vessel. See Handling Special 
Plates and Mini-tubes  on the facing page

Plate Geometry Diagram

Plate height = physical measurement 

Default Dispense Height = (plate height - flange height + 1.0 mm)

Travel Height = (plate height - flange height + Plate Clearance)

 n If Dispense Height > Travel Height (greater than), the travel height is changed 
to match the dispense height.
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Handling Special Plates and Mini-tubes 

Note: Also see the Plate Types Table on page 87.

Peri-pump Only Plates

The Peri-pump supports several plate types, but vessels with fewer than   8 rows 
require special handling. Some adjustment of or consideration of   how the 8-channel 
dispense head will address the plate is needed.  

The Peri-pump’s dispense volume is per tube or channel,   not per well. This is the 
most important fact to consider when using these   special plates. The volume 
defined in a Quick Dispense or protocol is   the amount each tube will dispense to 
the well. 

When you use multiple tubes to address a well, specify the   desired volume with 
this multiple in mind. For example, two tubes can   address each well in a 24-well 
plate, so the "defined" volume must be half   the desired volume. As always, be sure 
to also consider the Peri-pump’s   optimal performance settings when designing the 
dispense protocol, i.e.   full aliquots are more accurate than fractions of an aliquot. 

Another tool to consider using with special plates is the   X- or Y-axis Dispense 
Position setting. You may be able to use it to aim   the dispense tubes to a certain 
region of the well.

6-, 12-,   24-, and 48-Well Plates

BioTek recommends experimenting with different dispense-tube-to-well   
configurations when using these special plates. For some plates, multiple   tubes can 
dispense to a single well. Conversely, dispense tubes can (and   sometimes, must) be 
removed from the supply vessel or from the cassette   to prevent them from missing 
the wells.

Testing at BioTek found the following capabilities:

Plate   Type Columns/Rows Tubes   per Well Tubes   removed

6 Well 3 x 2 3 or 4 (4 and 5) or   0
12 Well 4 x 3 2 3 and 6
24 Well 6 x 4 2 0
48 Well 8 x 6 1 3 and 6
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 l 6-well   plates with 2 rows: three or four tubes can fit in the wells. Remove   tubes 4 and 
5 to use just three tubes per well. Fewer tubes may be preferred   to preserve cells in 
certain assays.              

 l 12-well   plates with 3 rows: two tubes can fit in the wells, so 6 tubes will   be used. 
Remove tubes 3 and 6.             

 l 24-well   plates with 4 rows and large enough wells to support two tubes are   the easiest 
of these special plates. All 8 tubes can be used, 2 per well, for standard microplates. 
Exception: the special 24-vial rack, PN 7212058, requires removing the even numbered 
tubes from the cassette or fluid supply.               

 l 48-well   plates with 6 rows: requires two tubes, 3 and 6, to be removed.              

 n Remember, when defining a run: dispense   volume is per tube, not per 
well. Divide the desired volume by the   number of tubes in a well.             

 If you regularly use 6- or 48-well plates, which require  dispense tubes to be removed 
from   the fluid supply before dispensing, you should consider dedicating certain   cassettes 
for the purpose. Removing the unused tubes from the cassette,   rather than from the fluid 
supply, will preserve them for future use and   make the cassette easier to handle. Review 
the instructions to Replace Peri-pump Dispense Cassette Tubing on page 151.

1536F - 1536-well Flanged Plates

Important: Crashes can occur! Remove unused manifolds when dispensing to 153F 
plates. 

To prevent an unused Peri-pump cassette  or  Syringe manifold from colliding with 
the plate flange during dispensing:

 l use both Syringe manifolds simultaneously, and,

 l unload the Peri-pump cassette when it is not being 
used;

 l alternatively, remove the Syringe manifolds while 
using the Peri-pump;

 l limit protocols to one dispenser only, either the 
Syringe or Peri-pump, i.e. run multiple protocols on a 
plate when the assay requires using more than one 
device.

To achieve the best dispense performance when processing 1536-well flanged 
plates, the MultiFlo's default protocol settings specify a low dispense height to 
position the dispense tubes as close as possible to the wells. When the dispense 
arm holds multiple dispense manifolds, the manifolds not addressing the wells can 
collide with the plate flanges during a dispense.
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Mini-Tube Racks 

The MultiFlo supports a special mini-tubes rack, which is available from BioTek as 
an accessory item: 
 l 96 Mini-Tubes (96MT), in standard 12 column x 8 row format   

Before dispensing to the mini-tubes, install the Special Plate Carrier for Mini-tubes 
below provided for this vessel. You can use the Peri-pump and 8- and 16-tube 
Syringe dispensers to fill the mini-tubes.

 n Note: Position adjustments in the Y-axis are prohibited with the special plate 
carrier for mini-tubes.

Special Plate Carrier for Mini-tubes

An optional accessory for the MultiFlo, a 
special plate carrier is needed to support 
certain special vessels, like a box of mini-
tubes. (PN 7212042)

96 Mini Tubes (96MT) is the Plate Type 
name we give to Corning® 96 Well Cluster 
Tubes (PN: 4410, 4411). 

Special 24-Vial Rack  

To dispense to the mini-tubes the special plate carrier must be installed to 
accommodate the extra height.   You can also use the carrier for other oversized 
vessels that may not otherwise be addressed by the dispensers by increasing the 
Plate Clearance setting. The maximum height supported with the combination of 
special carrier and Plate Clearance is about 49-50 mm.            

To install the special carrier:
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 1. Remove the standard carrier: 
loosen the thumbscrew on the 
left side of the carrier to 
release the little support arm 
and lift the carrier up and off 
the transport rails.

 2. Orient the special carrier so 
the small cavity for the 
support arm is on the left, 
align the hollows under the 
carrier with the transport 
rails, and install the carrier.               

 3. Change the Plate Carrier Setting to match the currently installed plate carrier:

 o Change the Plate Carrier Setting (Keypad) on page 77

 o Change the Plate Carrier Setting (LHC)

 Remember to select the proper PLATE in the Quick menu and when creating a protocol. 

MultiFlo™ Microplate Dispenser



Dispense Processing Patterns |  93

Dispense Processing Patterns

When dispensing to high-density plates, 384- and 1536-well, the 8-channel Peri-
pump and the various Syringe dispensers employ a dispensing pattern to fill the 
plate. The dispenser's footprint determines the pattern required to fill a plate and 
provides the ability to process a partial plate, skipping some sections.

Columns

 

To skip an entire column toggle the radio button off. With this feature you can 
dispense to odd columns in one dispense step, change fluids or use another 
dispenser and dispense to even columns in another dispense step.

Rows

The Peri-pump offers another way to control the dispense pattern to high-density 
plates. See Peri-pump Dispense Patterns.

32-Tube Syringe Dispenser Manifolds

One 32-tube dispense manifold addresses one column at a   time. When both 32-tube 
manifolds are used simultaneously, they align   with every 5th column, in a pattern 
like this: 

Columns 
1       5       9       13  
  2       6       10       14
    3       7              
      4       8     and so on...
                           

Columns 1 and 5 are dispensed to first, then columns 2 and 6, 3 and 7, and so on.
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Peri-pump Dispense Pattern

When addressing high density plates, 384- and 1536-well, the 8-channel cassette 
moves in the pattern described here to fill the plate. With Advanced Dispense 
Options, you can skip certain rows and columns.

Because the Peri-pump cassette addresses every column during a dispense, you 
can specify which columns to skip during a dispense step. 

384-Well Plate 

Rows: You can skip one of the two "rows" sections:

When the 8-channel cassette addresses a 384-well plate, it first dispenses to odd 
numbered rows, and then dispenses to even numbered rows. With this feature you 
can dispense to odd rows in one dispense step, change fluids or use another 
dispenser and dispense to even rows in another dispense step.

In addition, you can combine a selection of  columns with one of the two row 
sections (odd or even) to define a complex distribution pattern.

1536-Well Plate

Rows: You can skip up to three "rows" sections:
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When the 8-channel cassette addresses a 1536-well plate, it first dispenses to rows 
1, 5, 9, 13, 17, 21, and 25. The next section of rows dispensed to includes 2, 6, 10, 14, 
18, 22, 26, and 30. And so on, creating 4 sections of rows. 
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Peri-pump Peristaltic Dispenser

 n Some models do not include a Peri-pump dispenser.

Quick Dispense-Prime-Purge

In addition to controlling the Peri-pump with defined protocol steps, the MultiFlo 
keypad offers a Quick Dispense-Prime-Purge option using the keypad. (0.5 µL 
dispensing is not available; you must create a protocol to dispense this volume.)

Dispense Cassettes

 n Important: It is imperative that the cassette type setting onboard the 
instrument match the installed cassette! The cassette type is displayed in the 
Main Menu and Quick Dispense menu: PRI or SEC-# 

 l Install the Dispense Cassette on page 27

 l Change the cassette type setting on page 29

 l Dispense Cassette Diagram on page 26

 l Release the tension on the dispense cassette on page 99
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Peri-pump: How it works

The Peri-pump component dispenses fluid using a peristaltic pump. It works by 
expelling a portion of fluid trapped between advancing rollers. The tubing is 
pinched by the rollers to form a full aliquot or slug. 

Peri-pump drum

The volume of fluid in a single slug depends on the tubing size and linear distance 
between rollers. As the rollers spin, the fluid advances and is expelled at the tip in 
finite aliquots or slugs. The volume of each slug is the amount of fluid squeezed 
between two adjacent rollers.

The stepper motor turns the pump a determined number of steps. The pump drum 
can be advanced in smaller increments than the distance between rollers to expel a 
fraction of the full aliquot. However, the volume of the fractions is variable, 
depending as it does on many factors (exact rotor position, tubing tension, tip 
geometry, etc.). The variation between volumes of fractional aliquots is significantly 
higher than between dispenses done with full aliquots. Thus, the best possible 
performance and reproducibility from dispense to dispense is done in full 
aliquot increments. That is, specifying a 1 µL dispense volume when using the 1 
µL cassette, 5 µL dispense volume when using the 5 µL cassette, and 10 µL 
dispense volume when using the 10 µL cassette. The exception is for instruments 
that support 0.5 µL dispensing. These late-model instruments apply an  offset to the 
stepper motor to ensure precise and repeatable dispenses using a 1 µL cassette to 
dispense 0.5 µL aliquots, which is the only half increment permitted.  Only a 0.5 µL 
dispense volume can be requested, not 1.5 or 2.5 µL, for example.

The tubing cassettes are calibrated by stretching the tubing to the size required to 
accurately dispense the expected volume per aliquot. BioTek calibrates cassettes to 
meet the specifications before shipping them. Over time the tubing’s properties 
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will alter slightly, but the cassettes can be recalibrated to restore expected 
performance, in most cases. 
 l See Performance Specifications on page 11.

 l See Recalibrate the Peri-pump Dispense Cassette on page 151.

Recommended priming volumes for the Peri-pump

Generally, the recommended prime volume is three times the dead volume, where 
dead volume is the total internal volume of the fluid path. 

Cassette Type Dead Volume

1 µL 1.20 mL

5 µL 4.23 mL

10 µL 7.36 mL

However, a primary advantage of the Peri-pump dispenser is its entirely visible 
fluid path. This allows you to prime the tubing until all visible signs of air bubbles 
are dissipated.             

  Use BioTek's Peri-pump Reservoir Holder on page 31 and Shorten the Dispense 
Cassette Tubing on page 31  to significantly reduce the dead volume to preserve expensive 
reagents.

At   the start of the day:

Prime the tubing to prepare for a dispense run.

 1. Reload   the cassette and fill the supply vessel:             
 l When dispensing solutions   not effected by water, prime with the dispense fluid.             

 l When dispensing protein   solutions, first prime the tubing with a buffered saline 
solution to remove   any traces of water in the tubing, then, prime with the dispense 
fluid.             

 2. Hold   the Prime button on the keypad   until fluid flows into the priming trough 
and all visible air bubbles   have been removed.             

At   the end of the day:

Purge the tubing to reclaim the dispense fluid, then Prime   the tubing to flush it 
clean.

 1. Hold   the Purge button on the keypad until the tubing appears empty.             

 2. Replace   the supply vessel with the appropriate rinse fluid:             
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 l When dispensing water soluble   solutions, use deionized or distilled water.             

 l When dispensing protein   solutions, first prime the tubing with a buffered saline 
solution to remove   protein particles, then, prime with deionized or distilled water.             

 3. Hold   the Prime button on the keypad:             
 l 1 µL cassette = 5 seconds             

 l 5 µL cassette = 7 seconds             

 l 10 µL cassette = 10 seconds.             

Release the tension on the dispense cassette

 Important information about dispense   cassettes!

When not in use, BioTek recommends releasing the tension   on the cassette. This 
practice extends its life, preserving the tubing’s   integrity. 

To release the tension:

 

 
 1. Open the Pump Cover.     

 2. Pull out the Cassette Rest. 

 3. Release the spring-loaded   latch that holds in place the Tube   Tensioner 
attached to the pump’s stainless steel plate. It   will rest against the cassette 
rest.
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Peri-pump Dispense Step

 Add a Peri-pump dispense step to the protocol:

LHC Keypad

Click P-Dispense and define the   parameters Select PERI>DISP or HLF-D*

 If applicable, select which Peri-pump to use, Primary or Secondary.

* 0.5 µL dispensing is supported on certain late model instruments.
Define the Dispense Step 

The LHC and Keypad display these parameters in distinct sequences:

Dispense Volume: Enter   the per well volume in microliters.   The recommended 
values for each cassette type are:             

 o 1 µL cassette = 1 - 50 µL             or 0.5 µL for certain late-model instruments

 o 5 µL cassette = 5 - 2500 µL             

 o 10 µL cassette = 10 - 3000 µL             

Select the Flow   Rate
Cassette Type 1 μL 5 μL 10 μL
 (μL/sec/tube)
Low 50      120 140
Medium 60 140 160
High 64 160 180

When dispensing 0.5 µL with the 1 µL cassette the average flow rate values are:

1 μL Cassette 0.5 μL Dispense
 (μL/sec/tube)
Low 52      
Medium 54    
High 56    

Cassette Type Requirement    

LHC Keypad

 Optionally,  Require (a) specific cassette type to 
run this protocol.              
 l Fill   the checkbox to ensure users install the correct 

cassette type when running   this protocol.                   

 l Leave the checkbox empty   to allow any cassette type 
to be used.             

 l Select ANY to permit any 
cassette type to be used for 
this protocol; 

 l Select a cassette type to 
engage the Cassette 
Requirement Mode option.
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Note: Half-microliter (0.5 µL) dispensing requires a 1 µL cassette. The Cassette 
Requirement Mode behavior is implemented whenever a 0.5 µL volume is requested. 
Make sure a 1 µL cassette is installed and the Cassette Type setting matches it. 
When supported, only a 0.5 µL dispense volume can be requested, not 1.5 or 2.5 µL, for 
example. Perform two dispense steps, one for the half microliter and another at a full 
increment to achieve these volumes.

Pre-Dispense

When enabled, the Peri-pump primes into the priming trough   immediately 
before dispensing to the plate. Pre-dispense is recommended   for most 
applications. It normalizes the tips, to correct for evaporation, for example, to 
ensure precise fluid   distribution. 

See Protocol Parameters Tables on page 62 for details about the remaining 
parameters. 

Require a Specific Peri-pump Cassette

When defining a Peri-pump   step you can require a specific cassette type. Choose 
the   desired behavior when the required cassette is not   installed at runtime:
 l Prompt the user to confirm: provides the best protection   against an unintentional 

mismatch. If the cassette type itself has been   physically changed to match the protocol, 
but the instrument's setting   has not been updated, this option changes the MultiFlo's 
setting upon confirmation.   However, if the cassette has not been changed to match the 
protocol, users   are given a chance to cancel the run, fix the error, and rerun the 
protocol.               

 l Return an Error code: gives robotics programmers   the ability to design and run 
unattended processing routines without fear   of a message screen interrupting the 
operation.              

 l Automatically Set the cassette type: this option   changes the MultiFlo's setting without a 
confirmation. This option is for   advanced users only.             

 n No action is taken when the cassette   type setting matches the protocol's 
required cassette type.             

Note: The Cassette Requirement Mode is automatically enforced when a 0.5 µL 
dispense is requested. In this case, make sure a 1 µL cassette is installed.

LHC Keypad

 1. Select Tools>Instrument 
Utilities>Peri-pump 
Dispenser.

 1. Press Setup Menu (button in center of 
keypad).

 2. Select PERI and then g and then MODE.
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 2. Select the desired Cassette 
Requirement Mode behavior:

 o PROMPT

 o ERROR

 o SET

 3. Select the desired mode by pressing its Soft-
key: 

 o PROMPT

 o ERROR

 o SET

Settings for 0.5 µL Dispense

LHC: Tools>Instrument Utilities>Peri-pump Dispenser

Keypad: Setup Menu>PERI>PUMP>HALF

Do not alter these settings without precise instructions from BioTek. 

Peri-pump offsets are required to ensure precise and repeatable dispense 
performance when dispensing 0.5 µL. The default values were determined after 
thorough testing and should not be changed. This control is provided in 
anticipation of potential future changes to the 1 µL cassette tubing. In that case, 
specific instructions to alter the offsets will be provided.

Contact BioTek TAC for assistance if you have questions about dispense performance 
at 0.5 µL.
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Dual Syringe Dispenser

 n Some models do not include a Syringe dispenser. 

Quick Dispense

In addition to controlling the Syringe dispenser with defined protocol steps, the 
MultiFlo keypad offers a Quick Dispense menu. 

How it works

The Syringe dispenser uses two positive-displacement syringe-type pumps and 
distinct fluid paths to accurately deliver buffer, reagents, and other fluids.

See Syringe Dispenser- Autoclavable vs. Non-autoclavable on page 110 to learn 
the difference between these two options.

Prime the Tubing
 l How to Prime the Syringe dispenser below

 l Recommended prime volumes for the Syringe dispensers on next page

 l See also: Syringe Dispenser Maintenance on page 140

How to Prime the Syringe dispenser

Priming the tubing to remove all air bubbles is critical for accurate dispensing. 
There are several ways to make sure the tubing is primed:
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Quick Prime using the Keypad

 1. Select QUICK      at the main menu.

 2. Press PUMP until the Syr-A or Syr-B or Syr-BOTH menu appears, if necessary.

 3. Press PRIME as many times as necessary. 5000 µL is dispensed each time.

Add a Prime step to the Protocol

See Syringe Prime Step on page 1.

Similarly, always include a Pre-dispense (or tip prime) in a Dispense step.

Keep the tubing wet during idle time

Turn on AutoPrime for the Syringe Dispenser on page 116

Recommended prime volumes for the Syringe dispensers

The predefined maintenance protocols for the syringe dispensers   fully prime the 
system, pumping 40 mL through the tubing and pump:
 l S-DAY_RINSE_A&B - to fully prime both Syringe systems             

 l S-DAY_RINSE   - defined for Syringe A only             

Modify these protocols as needed when changing fluids and   performing other 
tasks. For example, make a copy of S-DAY_RINSE for Syringe   B or edit the protocol 
to add another prime cycle when changing fluids   to make sure all previously used 
fluid is expelled and replaced with the   new liquid.

 The approximate dead   volume for each Syringe dispenser system is 12 mL. Generally, 
three times   the dead volume completely primes the system. When using precious fluids,   
e.g., expensive reagents, you can change the prime parameters: reduce   the volume or 
number of cycles specified in the predefined protocols or create your own protocols. Use 
the priming trough inserts to capture expensive reagents when priming.
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Syringe Dispense Step

 Add a Syringe pump dispense step to the protocol:

LHC Keypad

Click S-Dispense and define the   parameters Select SYRNG>DISP

Define the Dispense Step 

The LHC and Keypad display these parameters in distinct sequences:

Select the Syringe   to dispense with:
 o A or B   or Both dispensers.

 n Both: When both Syringe dispensers are used, they simultaneously dispense 
the specified volume/well to two adjacent columns in a 96-well plate, to odd 
numbered and then even numbered rows in a 384-well plate, and every 5th 
column in a 1536-well plate. Remember to create two prime steps, one for 
each dispenser, to precede the dispense step.

 n 1536-well Flange Plates: Use both Syringe dispensers when processing 
153F plates.

Enter the Volume to dispense per well. The valid   values are 5-3000 µL depending 
on the plate type.             

Define the Flow   Rate: The rate at which the fluid is dispensed. Options   range from 
1-5, 1 is the slowest, 5 is the fastest. The valid rate is   volume dependent. Lower 
rates are recommended for viscous fluids.             
Rates are volume and plate-type dependent:

For example, rate 1 must be   used when dispensing between 10-19 µL to a 96-well 
plate. When dispensing   20-49 µL to a 96-well plate, you can use rates 1 or 2. And, 
when dispensing   50-59 µL to a 96-well plate, you can use rates 1, 2, or 3. And so 
on,   as shown in these tables.

96-well plate 16-Tube 8-Tube

Volume 
(µL)

Rate µL/sec/well

10-19 1 450 140
20-49 1-2 600 209
50-59 1-3 750 279
60-79 1-4 900 350

80-3000 1-5 1000 420
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384-well plate

Volume 
(µL)

Rate µL/sec/well

5 -9 1 225
10-24 1-2 300
25-29 1-3 375
30-39 1-4 450

40-1500 1-5 500

 n Note:   For 16-channel syringes the µL/sec/well rate accounts for   2 tubes/well 
when addressing 96-well plates and one tube/well for 384-well plates.             

1536-well plate

Volume (µL) 3-3000
The 32-tube manifold flow rates do 
not have minimum   volumes.
The µL/sec/well for each type of 
manifold, Small Bore (SB) and Large 
Bore (LB), is shown:

Rate SB LB

1 56 125
2 58 150
3 60 162
4 62 174
5 64 187

The default rate is 3. 

Enable  Pre-dispense to normalize the tips   before dispensing. Enter the volume and 
number of cycles.  

Define the Columns   to dispense to (aka the Plate Map):

 Each button represents a column.

Select the columns to dispense to using the buttons and   Set and Clear links.   The 
buttons, which represent each column, toggle on and off when clicked.   Toggle them 
on to dispense to the column or off to skip the column. 
 l Each button represents   a column. The Syringe dispenser   can only skip columns, not 

rows. 

 l The number of active   column buttons reflects the Plate Type selected in the main view, 
which   should match the plate you are dispensing to. 

 l Learn about Processing   Patterns for 384- and 1536-well plates. 
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Pump Delay

When dispensing highly viscous fluids, the tubing's check   valves perform more slowly. 
Delaying the syringe pump sufficiently to   allow the specified amount of fluid to pass through 
the check valves before   being pumped into the syringe has been shown to improve dispense 
accuracy.   
Begin by setting the delay to 500 msec. Experiment with   different settings to determine the 
optimal value for your fluid.

Change the Syringe Dispenser Manifold

Changing the Syringe manifold requires two steps:
 l Physically changing the Syringe dispenser manifold: See Install the Syringe 

Dispenser Component on page 33.

 l Updating the instrument's   manifold setting; as described below.             

After physically changing the manifold, perform these steps   to tell the instrument 
which one is installed.

 1. LHC: Select Tools>   Instrument Utilities> Syringe Dispenser
Keypad: Press the Setup Menu button, select SYR  and then MAN.

 2. LHC: Under Syringe Dispenser Assembly: Choose the option that represents the 
installed manifold. Look at the top of the manifold to identify its type, which is 
engraved on the top:

8-tube Dual 8-tube manifolds in a single block.

16-tube 16-channel

32-tube 1536-well plates only;
Model: Large Bore (LB) or Small Bore (SB) 

 3. LHC: Click Send   to send this setting to the instrument.

 4. Change the Calibration Data to correspond to the installed manifold: if you are 
changing an 8-tube manifold for a 16-tube manifold, or vice versa, revise the 
calibration data to match the installed manifold. This step is not necessary when 
using 32-tube manifolds. Find the labels on the bottom of the Syringe pump 
module, and enter the corresponding data:
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 o LHC: Enter the data and click Send.

 o Keypad: Select CAL at the Syringe Setup Menu and enter all the data points by 
pressing ENTER after each value.

Special Procedure for Magnetic Bead Assays

Before using the dual Syringe Dispenser to dispense magnetic beads, you must 
remove the magnets that normally hold the dispense manifolds on the instrument. 
Two thumbscrews are shipped with the instrument to replace the magnets. 

 1. Use the 1/16th hex wrench (PN 48713) to 
loosen the set screw on top of the 
manifold.

 2. Take advantage of the magnet’s attraction 
to the hex wrench to remove it from the 
manifold. 

 3. Locate the thumbscrews shipped with the 
instrument’s accessories. After sliding both 
manifolds onto the dispense arm, put the 
screws into the post to hold the manifolds 
in place.

 

 n Store the magnets in the plastic pouch for potential future installation.
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Syringe Dispenser Settings  

Syringe Dispenser Assembly

After installing the Syringe dispenser unit,   update the instrument's settings. The 
MultiFlo automatically detects which type of pump is installed. Select the manifold 
installed.
 l Non-Autoclavable (NATCLV): the black plastic casing of the non-autoclavable 

syringes are easy to distinguish from the glass and stainless steel autoclavable syringes. 

 l Autoclavable  (ATCLV): glass and stainless steel autoclavable syringes.

8-tube Dual 8-tube manifolds in a single block.

16-tube 16-channel

32-tube 1536-well plates only;
Model: Large Bore (LB) or Small Bore (SB) 

Look at the top of the manifold to identify its type, which is engraved on the top.

Calibration Data

Calibration data is critical to achieving expected performance   and it is unique to 
each individual syringe unit. BioTek prints the values   on the bottom of the unit, so 
you have a permanent record of the values.

When installing the Syringe dispenser, enter the values printed on the   unit.   

Syringe Dispenser Settings (Keypad)

When installing or making changes to the dual Syringe dispenser, you must update 
the instrument's settings to match the hardware.

Note: LHC users: select Tools>Instrument Utilities>Syringe

To change or review settings using the keypad:

 1. Press Setup Menu (button in center of keypad) and select SYR.

Manifold (MAN)

Select MAN to define the manifold setting. Select the option that matches the 
dispense manifold installed:

8-tube Dual 8-tube manifolds in a single block.
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16-tube 16-channel

32-tube 1536-well plates only;
Model: Large Bore (LB) or Small Bore (SB) 

Syringe Type (TYPE)

Select TYPE to define the type of Syringe dispenser installed:
 l Non-Autoclavable (NATCLV): the black plastic casing of the non-autoclavable 

syringes are easy to distinguish from the glass and stainless steel autoclavable syringes. 

 l Autoclavable  (ATCLV): glass and stainless steel autoclavable syringes.

Calibration Data (CAL)

Select CAL to enter (or modify) the calibration data for the Syringes.

Calibration data is critical to achieving expected performance   and it is unique to 
each individual syringe unit. BioTek prints the values   on the bottom of the unit, so 
you have a permanent record of the values.
See Update the Instrument to use the Syringe Dispenser on page 44

Syringe Dispenser- Autoclavable vs. Non-autoclavable

Two types of Syringe dispensers are available, autoclavable and non-autoclavable. 
It is easy to distinguish them:
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Autoclavable Non-autoclavable

Stainless steel and glass pump heads Black plastic pump heads

Glass supply bottles Plastic supply bottles

Amber, transparent check valves White, opaque check valves

Changing the Instrument's Settings

About the Onboard Settings

The instrument's onboard settings dictate its behavior. Certain settings, like Plate 
Clearance, can improve performance. Other settings are critical to its performance. 
For example, the manifold setting must match the installed manifold type. 

  LHC users: do not confuse the LHC's Target Instrument Settings assigned to each 
protocol with the onboard settings! Review the Help topic: LHC Protocols Explained to learn 
the distinctions.
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To change the onboard settings:

LHC Keypad

 1. Select Tools>Instrument 
Utilities

 2. Choose the applicable tab and 
modify settings as desired.

 3. Click Send after changing a 
setting to update the 
instrument. 

 1. Press the Setup Menu key (in the 
center of the keypad).

 2. Select the applicable device and the 
setting you want to change.

 l Alternatively, select UTILS at the main 
menu for AutoPrime, the Adjust Utility 
and system tests.

Adjust Utility

LHC: Tools>Instrument Utilities>General Information

Keypad: Select UTILS>ADJST from the main menu

The Adjust Utility   is a tool for determining the precise positioning of the dispense 
tubes when addressing the plate. Generally, the components' default   positions 
function perfectly, but certain assays may be improved by repositioning   the 
dispense tubes. For example, to minimize cell damage,   tubes can be positioned at 
the sides of the wells, rather than the center.   Use the utility to identify the offsets 
required, then, enter these offsets   when defining the protocol step.

The Adjust Utility puts the plate in its run position and   lets you position the plate 
in relation to the manifolds. You can:
 l Raise or lower the manifolds in the Z-axis, to determine the optimal dispense height, for 

example. The default   positions are based on the plate type.

 l Position the tubes in the X and Y axes by moving the plate carrier. The default position is 
the center of the well, 0 steps:       

 o Move the carrier left or   right in the X-axis. Negative offsets   move left of center; 
positive offsets are right of   center.

 o Move the carrier forward   and back in the Y-axis. Negative offsets move the plate 
backward from center; positive offsets place the plate forward of center.

Warning:   The Adjust Utility does not have limits to protect you from making bad   
choices. It is possible to identify dispense positions that   miss the wells, for example. If 
incorrect values are defined in the protocol,   you'll have a big mess on your hands.  

Positional Limits: 

The allowable ranges for positioning the devices for operation:
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 X Y Z
Dispensers -60 to 60

2.74 mm offset
-40 to 40

2.96 mm offset
1 to 585 steps
26.75 mm max

  

Run the Adjust Utility (Using the Keypad)

This page describes how to run the Adjust Utility using the keypad rather than the 
LHC. Find LHC instructions in the Help system.  

 l Learn about   the Adjust Utility on previous page.
 l Keep in   mind the positional limits of the devices during operation.

 1. Place a microplate on the carrier.

 2. Select UTILS at the main menu and then select ADJST.

 3. Select the PLATE TYPE. Only valid options for the installed hardware are 
presented for selection. 

 4. Select the device.

 5. Select a run position. Only one position may be viewed at a time.
 o for the Dispensers, choose FIRST column or LAST column to move the plate to that 

position.

 6. At the AXIS screen, choose an axis, Z, X or Y. The top line of the display 
indicates which axis is active, and the offset position of that axis:

Axis Options  

Z-axis (up/down) DISP Positions the dispense arm.

X-axis (left/right) CARX Positions the plate carrier.

Y-axis (front/back) CARY Positions thee plate carrier.

 7. Closely observe the position of the hardware. Use arrow keys:  t (reverse) and 
u (forward) to single-step the offset in either direction.

 8. When the desired offset position is found, record the position number to enter 
later when defining a wash, dispense, or aspirate step.

 9. To quit the Adjust Utility, press Main Menu. The carrier and manifolds return 
to their default positions.
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AutoPrime

LHC: Tools>Instrument Utilities> AutoPrime 

Keypad: Select      UTIL at the main menu, then     AUTPRM

Recommended for optimum performance, AutoPrime keeps the tubing wet in 
between runs and can be an essential part of your daily maintenance routine.

About AutoPrime

AutoPrime  automatically primes the tubing whenever the instrument is idle for a 
specified time. Keeping the tubes wet  prevents clogging and mitigates fluid 
evaporation at the tips. AutoPrime's   submerge feature lets you soak the tubes for 
extended   periods, which is an effective maintenance option.

The downtime interval is defined for all components, but each device supports 
distinct priming parameters. Devices are primed consecutively,   beginning with the 
syringe dispensers, not concurrently.

Important: Remove the Peri-pump cassette when the Syringe dispenser is set to 
"Submerge." 

"Submerge" is not offered for the Peri-pump because it is not a good practice for 
the dispense cassettes. However, because the cassette Tip Holder resides on the 
same dispense arm as the Syringe dispenser manifold, it will be moved into the 
submerge position when the Syringe tips are submerged. Either remove the cassette 
altogether when soaking the Syringe tips, or remove the prime trough inserts for 
the Peri-pump to prevent cross contamination of fluids or unintended wicking of 
fluid into the cassette.

 n Keep   in mind that any interaction with the MultiFlo will reset the interval clock.
   And,  AutoPrime only runs when the main menu, quick menu, or run 
completion message is displayed.               

 n When AutoPrime   is running you can press STOP   on the keypad to stop it. It 
will run again the next time the downtime   interval occurs.             

Specify the Interval and AutoPrime Parameters

AutoPrime runs when the instrument has been idle for a specified   interval. One 
interval setting is defined for all devices. 

To set the AutoPrime Interval:
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LHC: Keypad:

 1. Select   Tools>Instrument 
Utilities> AutoPrime tab.              

 2. Specify the idle-time 
interval that will trigger 
an AutoPrime; up to 24 
hours. 

 3. Enable and define the 
parameters for each 
device. Remember to set a 
Submerge Duration to 
employ this option.       

 4. Click   Send to transfer the 
settings to the instrument.
             

 1. Select UTILS at the main menu 
and select AUTPRM. 

 2. Specify the idle-time interval 
that will trigger an AutoPrime; 
up to 24 hours in minutes and 
press Enter.                 

 3. Set the Submerge Duration, if 
desired. You will select the 
device to submerge in a 
subsequent step.

 4. At the AutoPrime Device Menu, 
select the device you want to 
enable.

 5. "Enable AutoPrime."

 6.  For each device, define the 
AutoPrime parameters: rate, 
volume, and buffer valve, if 
applicable. Press Enter at each 
screen to advance to the next. 

 

Turn on AutoPrime for the Peri-pump Dispenser

LHC                     Keypad                     

 1. Select   Tools>Instrument 
Utilities>AutoPrime;

 2. Set the AutoPrime Interval: enter the 
downtime interval that will trigger   an 
AutoPrime.             

 3.  Fill the Enabled   checkbox  for the 
dispenser.               

 4. Set   the Volume and Rate.   The default 
settings are 50 µL/tube at the High flow rate.

 5. Click   Send. Wait   for a confirmation message.

 1. Select UTIL>AUTPRM.

 2. Set the AutoPrime Interval: 
enter the downtime interval that 
will trigger   an AutoPrime.             

 3. Select the dispenser.

 4. Set   the Volume and Rate.   The 
default settings are 50 µL/tube 
at the High flow rate.

 5. Press Main Menu, and look for 
AP in the display to confirm that 
AutoPrime is enabled.
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Details about Peri-pump AutoPrime

Important: Remove the Peri-pump cassette when the Syringe dispenser is set to 
"Submerge." 

"Submerge" is not offered for the Peri-pump because it is not a good practice for 
the dispense cassettes. However, because the cassette Tip Holder resides on the 
same dispense arm as the Syringe dispenser manifold, it will be moved into the 
submerge position when the Syringe tips are submerged. Either remove the cassette 
altogether when soaking the Syringe tips, or remove the prime trough inserts for 
the Peri-pump to prevent cross contamination of fluids or unintended wicking of 
fluid into the cassette.

 n Keep   in mind that any interaction with the MultiFlo will reset the interval clock.
   And,  AutoPrime only runs when the main menu, quick menu, or run 
completion message is displayed.               

 n When AutoPrime   is running you can press STOP   on the keypad to stop it. It 
will run again the next time the downtime   interval occurs.             

When the Peri-pump AutoPrime is Stopped

Because purging and priming the tubing is the best way to remove air bubbles and 
prepare the tubing for accurate dispensing, this routine is executed whenever 
AutoPrime for the Peri-pump is stopped:

 1. Purge: fluid is purged from the tubing, i.e. returned to the supply vessel. The 
volume depends on the cassette type.

 2. Prime: the tubing is primed with the optimal volume of fluid:

Cassette Type Purge Volume Prime Volume

10 µL 250 750

5 µL 150 450

1 µL 50 200

 

Turn on AutoPrime for the Syringe Dispenser

LHC                     Keypad                     

 1. Select   Tools>Instrument 
Utilities>AutoPrime;

 1. Select UTIL>AUTPRM.

 2. Set the AutoPrime Interval: 
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LHC                     Keypad                     

 2. Set the AutoPrime Interval: enter the 
downtime interval that will trigger   an 
AutoPrime.             

 3.  Fill the Enabled   checkbox  for the 
dispenser.               

 4. Set   the Volume and Rate.   The default 
settings are 400 µL at rate 3.

 5. Click   Send. Wait   for a confirmation message.

enter the downtime interval that 
will trigger   an AutoPrime.             

 3. Select the dispenser.

 4. Set   the Volume and Rate.   The 
default settings are 400 µL at 
rate 3.

 5. Press Main Menu, and look for 
AP in the display to confirm that 
AutoPrime is enabled.

Note: The Volume dispensed is actually double the input value. The Syringe dispenser 
always performs two prime cycles during AutoPrime, doubling the volume. For example, 
when 400 µL is entered, the dispenser actually primes the tubing with 800 µL.

You   can Submerge the   dispense tubes in the fluid after   the prime, if   desired. This 
requires filling the priming   trough inserts, one for each syringe. Each reservoir 
holds approximately   6.5 mL. More...

After the dispense tubes have been primed, the manifold   moves down into the 
priming trough inserts. When both Syringes are enabled,   the soak duration 
begins after both dispensers are primed. 

 n Important:   When using the submerge option, specify a volume that fills the 
priming   trough inserts with sufficient fluid to cover the tubes, e.g. 6000 µL.   
And, be sure to use the priming trough inserts when the option is enabled.   
Learn more about soaking the dispense tubes... 

Set the Submerge Duration and fill the Submerge checkbox to enable this option.

 n Remove the Peri-pump cassette or its priming trough insert when soaking the 
Syringe dispensers.

Important: Remove the Peri-pump cassette when the Syringe dispenser is set to 
"Submerge." 

"Submerge" is not offered for the Peri-pump because it is not a good practice for 
the dispense cassettes. However, because the cassette Tip Holder resides on the 
same dispense arm as the Syringe dispenser manifold, it will be moved into the 
submerge position when the Syringe tips are submerged. Either remove the cassette 
altogether when soaking the Syringe tips, or remove the prime trough inserts for 
the Peri-pump to prevent cross contamination of fluids or unintended wicking of 
fluid into the cassette.
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 n Keep   in mind that any interaction with the MultiFlo will reset the interval clock.
   And,  AutoPrime only runs when the main menu, quick menu, or run 
completion message is displayed.               

 n When AutoPrime   is running you can press STOP   on the keypad to stop it. It 
will run again the next time the downtime   interval occurs.             

Download Basecode (LHC Only)

Tools> Instrument Utilities>Software>  Download Basecode

Keypad users: Contact BioTek TAC for guidance. 

Use this feature when it is necessary to upgrade the instrument's   onboard software 
or basecode. BioTek provides the basecode (MultiFlo.bin)   file on the Customer   
Resource Center website. 

Important prerequisite:   Download the basecode from our website to perform the 
basecode upgrade.   Alternatively, you can request a CD of the basecode software. 

To download basecode   to the instrument:

 1. Put the instrument in download   mode:

 2. Turn off the MultiFlo.

 3. Press   and hold the Shift key while restarting the MultiFlo,   i.e. turn it on. 

The keypad display will appear   blank. If the main menu appears, start again.   

 4. Using   the LHC, select Tools> Instrument   Utilities, select the Software tab and 
click Download Basecode

 5. Click Browse to the   MultiFlo.bin file. 

 6. Click Start   Download.

 l Technical Note: Only one of the two communication ports (COM port) on the 
instrument can be used at a time. They cannot be used simultaneously. You can 
use either the USB or the RS232 serial port to connect the MultiFlo to a computer 
or to a BioStack or similar robotic device. But you cannot use both ports 
simultaneously. 

Upload-Download Protocols (LHC Only)

The LHC lets you transfer protocols from your computer to   your instrument and 
back again. 
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Limitation:   Protocols must contain only instrument-supported action steps to 
qualify   for download. That is, the protocol cannot contain any of the LHC provided
   steps like Delay and Loop (buttons in the left column of the Add   Step box in the 
main view). And, a Protocol   Name is required.

 n The instrument's   main menu must be displayed for the LHC to communicate 
with it.             

 1. Select   Tools>Transfer Protocols.             

 2. Make   sure the desired protocols are displayed: check the Protocol   Folder path 
for This computer. Refresh   the list of protocols onboard the Instrument   by clicking 
the Settings link.             

 3. Highlight   one or more protocols in a display box. (Hold the Ctrl or Shift key to   
simultaneously select multiple files.)             

 4. Optionally,   at the top left corner of the screen, choose to Disable Editing of 
transferred protocols   to lock the protocols from editing or deleting when they 
are onboard the   instrument.             

 5. Click   the applicable Upload or Download   button.              

The LHC will confirm the transfer or prompt you for more   information. When the 
transfer is complete, you can manipulate the files   as you normally would in their 
new location.
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Overview

A Preventive   Maintenance (PM) regimen for   the MultiFlo includes rinsing and 
soaking the fluid path and cleaning   and/or autoclaving the various components. 
The level of maintenance   required to keep the instrument performing as expected 
is dependent on   several factors, including the type of fluid dispensed, the 
frequency   of use, and the work habits employed.

The Recommended Maintenance Schedule on page 124 summarizes BioTek’s   
recommended maintenance tasks, and indicates approximately how often each   task 
should be performed. Daily and periodic routines and minimal guidelines   for 
frequency are listed. Beyond that, it is difficult for BioTek to recommend   a fixed 
frequency for each task to be performed. The frequency of conducting   these tasks 
must be based on the risk and performance factors of your   assays. 

Develop a maintenance schedule for your MultiFlo based on the characteristics of 
the fluids used and the activity level.   Here are some guidelines for each 
component:

Peri-pump
 o Purge the fluid at the   end of a dispense run and flush the tubing with water (or 

buffered saline   and then water). This is a good practice whenever the dispenser 
will be   idle for more than an hour, and at the end of the day.             

 o When using the 1 µL cassette,   filter fluids to 50 microns to reduce the chance of 
the tips clogging.             

 o When dispensing fluids   that can crystallize or harden after use, increase the 
frequency of maintenance   activities.  Autoclave the cassette as needed.             

 o Keep track of the number   of plates processed with a cassette to determine when 
the cassette has   reached its expected lifetime and is due for replacement or 
recalibration.             

Syringe Dispenser
 o Perform the daily maintenance   routines. Flush the dispenser with an appropriate 

reagent at the beginning   of the day (e.g., deionized water in the morning) and at 
the end of a   run.             

 o When dispensing fluids   that can crystallize or harden after use, increase the 
frequency of maintenance   activities. This is especially important for the 32-tube 
small bore (SB) dispensers.

 o Autoclave the Syringe heads and pistons, when applicable, and the 16-tube 
manifolds as needed. See Clean the Dispense Tubes on page 142.
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Recommended   Maintenance Schedule

The schedule recommends preventive maintenance tasks, the   frequency with which 
each task should be performed, and the predefined   onboard Maintenance program 
that should be run (if applicable). See Recommended Maintenance   Schedule on 
next page.

 n It is important   to note that the risk and performance factors associated with 
your assays   may require that some or all of the procedures be performed 
more frequently   than suggested in this schedule. 

 n Water: Daily maintenance is the key to keeping the liquid handler performing 
to specifications. In the maintenance procedures provided in this manual, the 
requirement to use distilled (dH2O) or deionized (DI) water can be met by 
numerous water purification methods, including MilliQ™. A minimum water 
purity of 2mOhm is expected.              
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Recommended Maintenance   Schedule

Tasks

Frequency

Daily Overnight/
Multi-Day

Weekly Periodic/
Monthly

Before 
storage/
shipment

Peri-pump

Flush   dispense cassette ü ü    

Record   number of plates 
processed with cassette

ü     

Syringe   Dispenser 

Run S-DAY_RINSE_A&B ü ü    

Run AutoPrime ü     

Components

Remove protein residuals and 
fungi growth, (if necessary)   

ü  ü ü  

Check/empty waste bottles ü    ü

Clean bottles    ü ü

Clean plate carrier system   ü  ü

Clean dispense tubes    ü ü

Clean exterior surfaces   ü   

Clean Syringe dispenser manifold    ü ü

Clean Syringe dispenser tubes    ü ü

Autoclave Syringe pumps    ü  

Decontaminate

Decontaminate external surfaces    ü ü

Run S-DECONTAMINATE    ü ü

Prepare   for Storage or Shipment

Run S-LONG_SHUTDOWN     ü
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Tasks

Frequency

Daily Overnight/
Multi-Day

Weekly Periodic/
Monthly

Before 
storage/
shipment

Replace/Repair   Components

Recalibrate   Peri-pump cassette 
Find the PDF folder on the 
operator's manual CD for detailed 
instructions for two methods of 
recalibrating the cassette.

As Needed

Replace Peri-pump dispense tips As Needed

Replace Peri-pump cassette tubing As Needed

Replace Syringe manifold check 
valves and plugs

As Needed
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Daily Maintenance

Daily maintenance involves flushing the dispensers   with an appropriate reagent or 
deionized water throughout the day.   Routine rinsing helps to prevent the tubes 
from   clogging between runs. Flushing the devices with deionized water is 
recommended   at the end of the day for most applications.

The recommended rinsing   frequency depends on the solutions currently in use:    

 l When a solution containing   surfactant is used throughout the day, perform 
the rinsing procedure when the device is idle for more than 3 hours.             

 l When the solution does not   contain surfactant, consider rinsing at least once 
an hour.             

 n The type of hardware also affects rinsing frequency. The 32-tube dispense 
manifolds require more diligence to keep them clog-free.

Run these protocols and enable AutoPrime   to satisfy the daily maintenance 
requirements:

 l S-DAY_RINSE_A&B             

 l P-#UL_CASS_RINSE  (# represents the cassette type)(P2 protocols are for the 
secondary Peri-pump)

Make sure the supply bottles contain sufficient rinse solution   and that the waste 
bottles are empty before running the protocols.     

 Also see the additional maintenance procedures required when dispensing protein 
solutions: Removing Protein Residuals and Fungi Growth on page 130. 

AutoPrime

AutoPrime automatically conditions   the  dispense tubes, priming them with the 
specified volume, after a user-specified   amount of idle time. See AutoPrime on 
page 114.

 l Press the STOP button  to interrupt the AutoPrime routine when it is 
underway.

 l Any interaction with the instrument via the keypad or the LHC resets the 
interval clock.

 l AutoPrime only runs when the main menu, quick menu, or run completion 
message is displayed on the keypad.
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Overnight/Multi-Day Maintenance

Overnight/multi-day maintenance involves flushing all solutions     out of the 
instrument, and then periodically rinsing and soaking the tubes    to keep them 
moist. Here are three recommendations for accomplishing the task. Employ the 
method that best suits your work flow: 

Maintaining 1536-well Hardware

The 32-tube-SB dispense manifolds can become easily clogged. It is especially 
important to perform one of the overnight maintenance procedures  with the 
suggested soaking periods to ensure trouble free startup at the beginning of the 
next day.

Submerge and Shutdown

An overnight/multi-day maintenance option for soaking the tips and turning off 
the instrument for overnight and weekend maintenance.

You can soak the MultiFlo dispense manifolds by filling the priming troughs and 
turning off the instrument after the soak begins. The tubes will soak in the priming 
troughs until the instrument is turned on again.

 1. First, run S-DAY_RINSE_A&B but do not empty the priming trough inserts.

 2. Turn off the instrument, and lower the manifolds into the priming trough.

 n Remove either the cassette or the Peri-pump priming trough from the 
instrument before performing this procedure.

32-tube Syringe Dispenser

When using the 32-tube dispense manifold, especially the small bore (SB) model, 
BioTek recommends using the following AutoPrime parameters to keep the 
manifold clog-free:

Volume: 1000 µL

Flow rate: 3

Submerge duration: 3 hours (requires priming trough inserts)

Overnight/Multi-day practice: After modifying the AutoPrime parameters to 
submerge the tubes for several hours:
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 1. Put the priming-trough-inserts into the priming trough.

 2. Use Quick Dispense to fill both inserts (prime cups): QUICK>PRIME (for both 
Syringe A and B). Run the Prime two or three times to fill the cups.

 3. When the priming troughs are filled, press Main Menu.

Soak the manifold tubes in cleaning fluid

Keeping the dispense tubes in a wetted condition   is required to keep them clog 
free. Soak the tubing in deionized or distilled water or a cleaning   fluid whenever 
the device is not being used to ensure trouble-free performance.

Prime Step

 

 1. Fill   a supply bottle with a cleaning agent.             

 2. Click S-Prime                  and define parameters to fully prime the tubing, for example:

Syringe Dispenser

Volume = 8000 µL

Flow Rate = 5

Cycles = 5

 Submerge   tips in fluid after prime: enable option and set Duration,   up to 24 hours.

 n For the   Syringe manifolds: Use the priming trough inserts to submerge the 
tips.             

 n Overnight Maintenance: You can turn   off the instrument after the tips are 
submerged to leave them soaking   in the priming trough for an extended 
duration.             

 3. Click   Run. Save the program with a memorable name   for future use.             

AutoPrime

Enable AutoPrime   to ensure the tubing is soaked during downtime intervals.

It is especially important when using the 32-tube SB dispense   manifolds to keep 
the tubes wet to prevent clogs. One option is to modify   the AutoPrime parameters 
used for idle periods during a regular work day   to soak the tubing for longer 
periods overnight and on the weekends.
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 n Be sure   to use the priming trough inserts when the submerge feature is 
enabled. And, remove either the Peri-pump cassette or its priming trough 
insert.             

Define the AutoPrime values to fill   the priming-trough-inserts,   e.g. 6000 µL, and 
then submerge the tubes for several hours.    When AutoPrime is enabled for both 
dispense manifolds, the   soak duration begins after both manifolds are primed, i.e. 
both priming-trough-inserts   have been filled. 

More about soaking the dispense tubes...

You can soak the Syringe dispenser's two manifolds, A and B, simultaneously or 
separately depending on how you define the prime routine. Two priming trough 
inserts are supplied, one for each manifold. The troughs can be used to preserve 
precious fluids and to soak the manifold tubes.

 n Be sure   to use the prime trough inserts   
to submerge the tips in fluid.             

Create a Prime protocol

As an alternative to AutoPrime, BioTek recommends creating a protocol with two 
prime steps   to soak the Syringe dispenser's tubes:
 l Do not enable the submerge   feature for Syringe A. Specify a volume that fills the prime 

trough insert,   e.g. 6000 µL.             

 l Create a second prime step   for Syringe B, with the same volume, and the submerge 
duration defined.   Both Syringe A and Syringe B dispense tubes will be submerged in their
   respective prime trough inserts. 
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Important: Remove the Peri-pump cassette when the Syringe dispenser is set to 
"Submerge." 

"Submerge" is not offered for the Peri-pump because it is not a good practice for 
the dispense cassettes. However, because the cassette Tip Holder resides on the 
same dispense arm as the Syringe dispenser manifold, it will be moved into the 
submerge position when the Syringe tips are submerged. Either remove the cassette 
altogether when soaking the Syringe tips, or remove the prime trough inserts for 
the Peri-pump to prevent cross contamination of fluids or unintended wicking of 
fluid into the cassette.

 n Keep   in mind that any interaction with the MultiFlo will reset the interval clock.
   And,  AutoPrime only runs when the main menu, quick menu, or run 
completion message is displayed.               

 n When AutoPrime   is running you can press STOP   on the keypad to stop it. It 
will run again the next time the downtime   interval occurs.             

Removing Protein Residuals and Fungi Growth

Important! Solutions containing   proteins, such as bovine serum albumin (BSA), will 
compromise the MultiFlo’s   performance over time unless a strict maintenance regime is 
adhered to.   Do not use isopropyl alcohol to flush out BSA.          

When using protein solutions or   similar fluids, BioTek   recommends performing the 
following additional Maintenance procedures   to thoroughly flush out protein 
particles and other contaminants from   the fluid path. 

Also note, some components can be autoclaved to sterilize them.

 n Four-liter   volumes specified in the following are approximate amounts.             

 n S-DECONTAMINATE     (S-DECON): this predefined protocol specifies Syringe 
A. Make a copy of the protocol and modify it for Syringe B.   

Daily Practice with buffer or deionized water:

If the MultiFlo will be idle between plates for longer than 45 minutes, flush the 
proteins:

 1. Fill a supply bottle with deionized water. Connect the bottle to the dispenser. 

 2. Run the applicable DAY_RINSE protocol.

 3. Enable AutoPrime for 60-minute intervals.
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At the end of the day:

 1. Fill a supply bottle with deionized water. Connect the bottle to the dispenser.

 2. Run the applicable DAY_RINSE protocol three times.

 3. Perform your regular Overnight/Multi-Day Maintenance routine.

Weekly or As Needed use NaOH and HCl to remove proteins:

 1. Flush the system with 0.1-0.5 N* NaOH (sodium hydroxide), followed by 
neutralization with an equivalent normality (0.1-0.5 N) of HCl (hydrochloride).

 2. Rinse well with deionized water to remove the HCl.

 3. Run the applicable DAY_RINSE protocol three times with deionized water if 
you plan to use the device immediately.

 n * N = Normal solution, which contains 1 ‘gram equivalent weight’ (gEW) of 
solute per liter of solution. The gram equivalent weight is equal to the 
molecular weight expressed as grams divided by the ‘valency’ of the solute.

Alternatively use an Enzyme-Active Detergent:

 1. Mix an enzyme-active detergent according to the manufacturer’s directions to 
fill a four-liter supply bottle. Connect the bottle to one of the Syringes. 

 2. Run S-DECONTAMINATE protocol, as appropriate.

 3. LHC users: Respond to the Delay message, “Connect a bottle of water…”, leave 
the detergent bottle connected and when ready, press          Continue.

 4. For the Syringes: connect a bottle with deionized or distilled water to the 
pump and REPEAT the protocol.

 5. When the protocol is completed, connect a bottle containing four liters of 
deionized water and run S-DAY_RINSE three times to flush the system.

 6. Repeat the procedure for the other Syringe dispenser.
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Periodic Maintenance

Periodic maintenance involves cleaning the components on   a regular basis to keep 
the instrument running efficiently and in compliance   with performance 
specifications.  The recommended frequency   for cleaning components is at least 
monthly. The risk   and performance factors associated with your assays may require 
that some   or all of the procedures be performed more frequently.

Warning!   Internal Voltage. Turn off and unplug the instrument for all cleaning   
operations.

 n Important: Do not apply lubricants to manifold O-rings, channel-end seals, 
bottle cover seals, any tubing connection, or any surface   that is a part of the 
fluid path. The use of any lubricant on the fluid   handling components will 
interfere with dispense performance,   and may cause irreparable damage to 
these components.

 n Water: Daily maintenance is the key to keeping the liquid handler performing 
to specifications. In the maintenance procedures provided in this manual, the 
requirement to use distilled (dH2O) or deionized (DI) water can be met by 
numerous water purification methods, including MilliQ™. A minimum water 
purity of 2mOhm is expected.

Important! 
 l Do not immerse the instrument, spray it with liquid, or use a ”wet”   cloth on it.

 l Do not allow the cleaning solution to run into the interior of the instrument.   (If this 
happens, contact the BioTek TAC.)

 l Do not expose any part of the instrument to the recommended diluted sodium   
hypochlorite solution (bleach) for more than 20 minutes. Prolonged contact   may damage 
the instrument surfaces.

 l Be certain to rinse and thoroughly wipe all surfaces.

 l Do not soak the keypad. Instead, moisten a clean cloth with deionized or   distilled water 
and wipe the keypad. Dry it immediately with a clean,   dry cloth.

Perform these preventive maintenance tasks regularly:

 l Clean the Bottles on the facing page

 l Clean the Plate Carrier on the facing page

 l Peri-pump Dispenser Maintenance on page 135

 l Syringe Dispenser Maintenance on page 140 
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Autoclavable Components

Autoclaving is an efficient method of sterilizing instrument components. For 
qualified items, it is a good alternative to some of the decontamination procedures. 

Do autoclave: Do NOT autoclave:

Peri-pump cassettes Plate carrier

16-Tube Syringe dispenser manifolds 32-Tube Syringe dispenser manifolds

Priming trough inserts 8-Tube Syringe dispenser manifolds (gray 
block holds two manifolds, 16 tubes total)

Autoclavable Syringe pump head 
(glass/stainless steel)

Non-autoclavable syringe pumps (black plastic)

Syringe module tubing with transparent 
amber check valves and glass bottles

Non-autoclavable syringe accessories, white 
check valves and plastic bottles

 l Autoclaving the cassette typically increases the tubes' capacity. Expect the cassette to 
dispense more fluid than expected immediately after sterilizing or disinfecting the 
tubing. (When the cassette is completely dry, dispense volumes return to normal.)

 l Autoclaving the dispense cassette does not diminish its expected life , See Peri-Pump 
Dispenser on page 11.

Clean the Bottles

 l Clean      and rinse the supply bottles with deionized water before the first use,      before each 
refill, and, periodically, as necessary, to prevent bacteria      growth.    

 l Empty      the waste bottle often (at least daily), and firmly seat the waste bottle      stopper.     

 l Rinse      the covers every time the wash or rinse bottles are filled.     

 l Accumulated      algae, fungi, or mold may require decontamination.    

Clean the Plate Carrier

If liquid has overflowed onto the plate carrier, transport     rail, or platform, some 
buildup may occur and prevent the microplate     from seating correctly on the carrier. 
This can interfere with plate transport.    Weekly cleaning is recommended.

 1. Turn      the instrument off.     

 2.   Loosen the thumbscrew on the left side of the carrier to release the little bracket 
that holds the carrier in place and remove the carrier.
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 3. Clean      the carrier, rails, and surface, using mild detergent and hot water,      70% 
isopropyl alcohol, or ethanol. Clean the priming trough, too.    

 4. If      detergent was used, wipe the components with a cloth moistened with water.      
Use a clean, dry cloth to dry the components.     

 5. Reinstall the carrier:
 l Clip the bottom bracket onto the transport rail, align the little bracket on the left rail 

to hold the carrier in place and tighten the thumbscrew.
 l If necessary, release the      spring-loaded microplate clamp in the back left corner of the 

carrier      to level the carrier on the base. 
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Peri-pump Dispenser Maintenance

The level of the maintenance required to keep the dispenser   performing as 
expected is highly dependent on several factors, including   the type of fluid 
dispensed, the frequency of dispensing, and the work   habits employed. For 
example, when dispensing fluids that can crystallize   or harden after use, 
maintenance activities are required more frequently. 

 When using the 1 µL cassette filter fluids  to 50   microns to reduce the chance of tips 
clogging.  

Daily maintenance includes purging the fluid at the end   of a dispense run and 
flushing the tubing with water (or buffered saline   and then water). This is a good 
practice whenever the dispenser will be   idle for more than an hour, as well as at 
the end of the day. 

Another important daily requirement is keeping track of   the number of plates 
processed with a cassette. This is necessary to determine   when the cassette has 
reached its expected lifetime and is due for replacement   or recalibration. 
Replacement Tubing Kits, a refurbishment service, and new cassettes are   available 
from BioTek Instruments. 

Monthly maintenance requires overall cleaning of the dispenser   and its accessories, 
and verifying performance to determine if the cassette   needs recalibration. 
Autoclaving or decontaminating the cassette is also   recommended.

Peri-pump Maintenance   Tasks:

 l Flush the Dispense Cassette on next page

 l Unclog the Dispense Tips on page 137

 l Record the Number of Plates Processed on page 138

 l Recalibrate the Peri-pump Dispense Cassette on page 151

 l Replace Peri-pump Dispense Cassette Tubing on page 151
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Flush the Dispense Cassette

Prime the tubing with an appropriate   reagent at the beginning of the day, and, 
flush the tubing to effectively   remove all contaminants at the end of the day. 

The type of rinse fluid to use is determined by the type   of fluid you are 
dispensing. Some dispense fluids require the use of enzyme-active   detergent, 
buffered saline, ethanol or isopropyl alcohol, rather than   deionized water alone.

Tools and Supplies

 l Deionized   or distilled water             

 l Buffered   saline solution or enzyme-active detergent for protein or cell based 
assays             

At the start of the day:

Prime the tubing to prepare for a dispense run.

 1. Reload   the cassette and fill the supply vessel:             

 l When dispensing solutions   not effected by water, simply prime with the 
dispense fluid.             

 l When dispensing protein   solutions, first prime the tubing with a buffered 
saline solution to remove   any traces of water in the tubing, then, prime with 
the dispense fluid.             

 2. Prime  the tubing until fluid flows into the priming trough and all   visible air 
bubbles have been removed.             

At the end of the day:

Purge the tubing to reclaim the dispense fluid, then Prime   the tubing to flush it 
clean.

 1. Purge the cassette until the tubing appears empty.             

 2. Replace   the supply vessel with the appropriate rinse fluid:             

 l When dispensing water soluble   solutions use deionized or distilled water.             

 l When dispensing protein   solutions, first prime the tubing with a buffered 
saline solution to remove   protein particles, then, prime with deionized or 
distilled water.             
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 3. Prime   the tubing for the specified duration:             
 l 1 µL cassette = 5 seconds             
 l 5 µL cassette = 7 seconds             
 l 10 µL cassette = 10 seconds.             

Unclog the Dispense Tips

The small diameter of the dispense tips makes them susceptible   to clogging. You 
may be able to visually identify a clogged tip, or inaccurate   dispense performance 
may signal a problem. Good work habits can prevent   clogging or reduce its 
occurrence:

 l When using   1 µL cassettes, filter fluids to 50 microns before dispensing.              

 l Thoroughly   flush the tubing after/in-between usage, especially when using 
liquids   that crystallize or harden.              

In case the need arises, BioTek ships a 10 cc plastic syringe   with special tubing and 
fitting for use unclogging tips. Installation   instructions recommend storing it in the 
pouch on the back of the instrument.   The remedy involves removing the dispense 
tip and flushing it with water.   Depending on the type of clog, soaking the tip 
holder in hot water with   mild detergent is recommended. 

  This task may be easier if you use   the cassette’s shipping container to hold the 
unaffected cassette   parts, keeping them out of your way. 
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Required Materials
 l 10 cc syringe with tubing   and fitting attachment shipped with dispenser             

 l Screwdriver shipped   with dispenser             

 l A sufficient quantity of   deionized (DI) water in a beaker             

Procedure

 1. Fill   the 10 cc syringe with water and set aside.             

 2. Remove   the cassette from the dispenser.             

 3. Use   the screwdriver to open the Tip   Holder. Put the top of the holder aside.             

 4. Lift   the affected dispense tube from the holder and pull its tip off the tube.             

 5. Slide   the tip, tapered end first, into the tubing on the end of the syringe.             

 6. With   the tip poised to expel the clog and the water into the beaker or a sink,   
discharge the syringe.             

 7. Fill   and discharge the syringe as many times as needed to flush the tip.             

 8. Reassemble   the cassette:             
 l Put the straight end of   the tip into the bottom of the tube (the tapered end of the dispense 

tip   is exposed).             

 l Reinsert the tube into the   Tip Holder. Seat the flared edges of the tip into the molded 
slots.             

 l Replace the Tip Holder cover   with its two screws. The etched BioTek label identifies the 
top of the   cover (except for 1536 cassettes’ steel cover plate).             

Record the Number of Plates Processed

To determine when a tubing cassette has reached the end   of its expected lifetime, 
make a habit of counting and recording the approximate   number of plates and 
volume dispensed per cassette.

Create a form similar to the example table below or estimate   your usage of the 
cassette and project a date for replacement or recalibration.

Cassette Expected Lifetime

Cassette Types Cassette Life Total Volume

1 µL 1000 384-well plates @ 5 µL/well 2,000 mL

5 µL 1000 96-well plates @ 50 µL/well 5,000 mL
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Cassette Types Cassette Life Total Volume

10 µL 1000 96-well plates @ 100 µL/well 10,000 mL

With strict adherence to best practices and maintenance recommendations, this is 
the typical longevity of the dispense cassettes.

Example table for recording cassette usage:

You may want to create a form similar to this table to keep   track of the volume 
dispensed with each cassette:

Cassette   serial #: 2178

Date #   Plates Plate   Type Volume/Well Total   Daily Vol. Total   Cassette Vol

10/10/08 26 384 5   µL 49920   µL 50   mL

10/11/08 33 96 10   µL 31680   µL 82   mL 
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Syringe Dispenser Maintenance

The level of the maintenance required to keep the dispenser   performing as 
expected is highly dependent on several factors, including   the type of fluid 
dispensed, the frequency of dispensing, and the work   habits employed. For 
example, when dispensing fluids that can crystallize   or harden after use, 
maintenance activities are required more frequently. 

32-tube small bore (SB) dispense manifold: If the fluid 
streaming from a dispense tube appears to be awry or skewed, 
it is most likely caused by minute particles of debris on the end 
of the tube. Brush away any particles from the end of the tube 
using a piece of silicon tubing. Silicon will not flake off and leave 
particles behind like other materials. 

Clean the Bottles and Tubes  
 l Clean the dispense   and rinse bottles and supply tubes with deionized water before   the 

first use, before each refill, and if they have been idle for   any length of time.             

 l Accumulated   algae, fungi, or mold may require decontamination.             

Syringe Dispenser Maintenance Tasks
 l Autoclave the Syringe Head on page 143

 l Clean the Dispense Tubes on page 142

 l Clean the Syringe Dispenser Manifold below

 l Clean or Replace the Check Valves on page 143

 l Run AutoPrime to soak the   dispense tubes             

Clean the Syringe Dispenser Manifold

Regular rinsing helps to keep the manifold clean and the   dispense tubing clear, 
and will increase the life of the tubing. Follow   the Decontamination   procedure to 
disinfect the manifold and tubing.

If you suspect a particular problem is related to the manifold   (for example, clogged 
tubes can result in uneven dispensing), you should   perform a thorough cleaning of 
the manifold. 
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To clean the manifold:

 1. Turn off and unplug   the instrument.             

 2. Pull the manifold off of   the dispense arm and disconnect the tubing from the 
manifold.              

 3. Remove the plugs from the   ends of the manifold. Using a lint-free disposable 
towel, thoroughly clean   the outside of the dispense tubes.              

 4. Run hot water through the   inlet fitting. Check to see if water comes out of all of 
the dispense   tubes. If not, soak the manifold in hot soapy water and repeat. 
Clean the Dispense Tubes on next page, if necessary.             
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Clean the Dispense Tubes

 n Do NOT  autoclave   the dual 8-tube and 32-tube dispense manifolds!

 n Note: The autoclavable 16-tube and non-autoclavable 8-tube  manifolds have 
removable dispense tubes. We do not recommend routinely removing   these 
tubes. In the case of a particularly difficult problem with any   one channel, 
however, a tube may be removed and cleaned individually,   or replaced.             

Clean the Tubes 

Unless there is a problem, the manifold dispense tubes do   not need special 
cleaning. Periodic rinsing is usually sufficient to keep   the tubes clean. However, if 
the regular maintenance is not completely   successful, try the following:
 l 8- and 16-tube manifolds:   clean the tubes with the stylus;             

 l 32-tube manifolds: flush   the tubing with the 10 mL syringe.             

 

 1. Remove the plugs   from the ends of the manifold.             

 2. Tip the manifold on end   and flush hot water through this open channel.             

 3. Using the supplied tool,   clean the insides of all of the dispense tubes.             
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 o 8- and 16-tube   manifold stylus: PN 2872304                 

 o 32-tube   manifold: 10 cc syringe and tubing                 

Let water flow through the open   channel while you probe or flush each tube, 
forcing any particles to be   washed away.

 4. Rinse the manifold   with deionized or distilled water. Check to see if water 
comes out of   all of the dispense tubes (except when working with the 32-tube 
SB manifold).   Reinsert the plugs into the ends of the manifold.             

 5. Remount the manifold and   replace the tubing.              

 6. Run a Prime protocol using   40 mL of deionized water.             

 7. Verify dispense performance   visually, or              Perform the Syringe Dispense Precision & 
Accuracy Test on page 175.             

Clean or Replace the Check Valves

 n The check valves do not twist open.             

If the check valves leak or become clogged, you can either   clean or replace them. 
Contact BioTek Customer Service to order replacement check valves.

To clean a check valve:

 1. Pull the tubing off the   check valve.             

 2. Insert the stylus into the   feed end of the valve to hold it open (observe arrow on 
valve indicating   flow direction).             

 3. Flush with hot water.              

 4. Replace the valve and the   tubing.              

Replace Syringe Dispenser Check Valve on page 152, if necessary.

Autoclave the Syringe Head

Certain models of the Syringe dispenser are not autoclavable. Be sure your dispenser 
is described as autoclavable before proceeding. See Syringe Dispenser- 
Autoclavable vs. Non-autoclavable on page 110.
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 1. Use the supplied 3/32”   (2.39 mm) hex wrench to remove the two mounting 
screws that hold the syringe   head in the unit.             

 2. Pull the syringe head straight   back and off of the piston             

 3. Use   the hex wrench to loosen the setscrew on top of the sleeve that holds   the 
piston and then remove the piston.             

Important! Autoclave the piston and syringe head separated from one another.   Keep 
the piston and syringe head unattached to each other when autoclaving.              

 4. Autoclave at 134°C and 216   kPa for 3 minutes, or 121°C and 115 kPa for 30 
minutes. The manifold,   tubing, autoclavable check valves, and supply bottles 
may also be sterilized   in the autoclave.             

 n Check valves (PN 68073) recommended   for use with organic substances 
cannot be autoclaved.             
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 5. Replace the components by   reversing the steps:             

 6. With the flat side of   the shaft facing up, slide the syringe   piston shaft into the 
piston   holder until it stops.                 

 7. Use the 3/32”   (2.39 mm) hex wrench to tighten the setscrew.                 

 8. Push the syringe head over the piston   until it is flush with the unit and use the 
hex wrench to attach the two   mounting screws.                    
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Decontamination

Any laboratory instrument   that has been used for research or clinical analysis is 
considered a biohazard   and requires decontamination prior to handling.

Decontamination minimizes the risk to all who come into   contact with the 
instrument during shipping, handling, and servicing.   Decontamination is required 
by the U.S. Department of Transportation regulations.   Persons performing the 
decontamination process must be familiar with the   basic setup and operation of the 
instrument.

The recommended frequency   for decontamination is at least monthly, and before 
shipment   of the instrument to BioTek for calibration or repair.

 n Important! BioTek Instruments, Inc. recommends the use of the following 
decontamination   solutions and methods based on our knowledge of the 
instrument and recommendations   of the Centers for Disease Control and 
Prevention (CDC). Neither BioTek   nor the CDC assumes any liability for the 
adequacy of these solutions   and methods.  Each laboratory must ensure that 
decontamination procedures   are adequate for the biohazards they handle.

Warning!   Internal Voltage. Turn off and unplug the instrument for all 
decontamination   operations.

 n Do not immerse the instrument, spray it with liquid, or use a ”wet”   cloth. Do 
not allow the cleaning solution to run into the interior of   the instrument. If this 
happens, contact the BioTek TAC.   Do not soak the keypad.

 n Wear prophylactic gloves when handling   contaminated instruments. 
Gloved hands should be considered contaminated   at all times; keep gloved 
hands away from eyes, mouth, nose, and ears.    Eating and drinking while 
decontaminating instruments is not advised.

 n Mucous   membranes are considered prime entry routes for infectious agents. 
Wear   eye protection and a surgical mask when there is a possibility of aerosol   
contamination. Intact skin is generally considered an effective barrier   against 
infectious organisms; however, small abrasions and cuts may not   always be 
visible. Wear protective gloves when performing the decontamination   
procedure.

MultiFlo™ Microplate Dispenser



Decontaminate Exterior Surfaces |  147

Tools and Supplies 

0.5% sodium hypochlorite   (NaClO, or bleach)

70% isopropyl alcohol (as   a bleach alternative)

Deionized or distilled water

Priming plate

Safety glasses

Surgical mask

Protective gloves

Lab coat

Biohazard trash bags

Clean cotton cloths

Step-by-Step Decontamination Instructions:

 l Decontaminate Exterior Surfaces below

 l Decontaminate Tubing and Manifold on page 149

Decontaminate Exterior Surfaces

Caution! Be sure to check the percentage NaClO of   the bleach you are using; this 
information is printed on the side of the   bottle. Commercial bleach is typically 10% 
NaClO; in this case,   prepare a 1:20 dilution. Household bleach is typically 5% NaClO; in 
this case, prepare a 1:10 dilution.             

The   bleach solution is caustic; wear gloves and eye protection when handling.  

 1. Turn off the instrument    and disconnect the power cord. Empty the waste bottle.             

 2. Unload the Peri-pump cassette   and the prime trough inserts, and remove the 
Syringe dispenser manifold   and tubing, if applicable.              

 3. Autoclave the cassette and   other autoclavable components.             

 4. Prepare an aqueous solution   of 0.5% sodium hypochlorite (NaClO, or bleach). 
As an alternative, 70%   isopropyl alcohol (or 70% ethanol) may be used if the 
effects of bleach   are a concern.              
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 n Isopropyl alcohol is not recommended for   removing proteins (such 
as bovine serum albumin).                             

 5. Moisten a cloth with the   bleach solution or alcohol. Do   not soak the cloth.             
 l Wipe the keypad (do   not soak). Wipe again with a clean cloth moistened with 

deionized or distilled   water. Dry immediately with a clean, dry cloth.                 

 l Wipe the plate carrier, top surface of the instrument’s   base, supply bottles and 
tubing, and all exposed surfaces of the instrument.                  

 6. Wait 20 minutes. Moisten   a cloth with DI or distilled water.             
 l Wipe the plate carrier, top surface   of the instrument’s base, supply bottles, tubing, 

bottle covers   and all exposed surfaces of the instrument that have been cleaned 
with   the bleach solution or alcohol.                 

 7. Use a clean, dry cloth to   dry all wet surfaces.             

 8. Reassemble the instrument   as necessary.             

 9. Discard the used gloves   and cloths using a biohazard trash bag and an 
approved biohazard container.             
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Decontaminate Tubing and Manifold

Predefined protocols to flush and soak the supply tubing and manifolds   with 
disinfectant, then flush the system with rinse fluid are installed onboard the 
instrument and on the host computer   during installation of the LHC:

 o S-DECONTAMINATE   (S-DECON onboard) for the Syringe dispenser             

 For the Syringe dispensers: copy this protocol and modify it to run on Syringe B.

When storing or shipping the instrument, the LONG_SHUTDOWN procedure (on 1) 
primes and soaks the instrument, and ends by pushing air through the system. The   
parameters can be edited for optimum cleaning. For example, consider using   
ethanol instead of air to complete the decontamination process.

 n Two supply   bottles are required for this procedure: one for disinfectant, and 
one   for rinse.             

 1. Empty the waste bottle.             

 2. Prepare an aqueous solution   of 0.5% sodium hypochlorite (NaClO, or bleach).             

 3. Fill one supply bottle with   at least 400 mL of bleach solution (disinfectant).             

 4. Fill another supply bottle with at least 800 mL of deionized water (rinse). 

 5. Reconnect the power cord   and turn on the instrument.             

 6. Run the decontamination   protocols.               

Preparing to run S-DECON or S-DECONTAMINATE:

Using 
the

Description

Keypad Connect the disinfectant bottle to the Syringe A port. When the protocol is 
finished, connect the rinse bottle to the port, and press REPEAT to rerun the 
protocol.
Make a copy of the protocol and modify the copy for Syringe B, assign an 
unique name, e.g. SB-DECON, and repeat the above procedure.

LHC Connect the disinfectant bottle to the Syringe A port. At the prompt, when the 
protocol is delayed, connect the rinse bottle to the inlet port, and press 
Continue to complete the protocol.
Copy the protocol, select File>Save As, assign it a unique name, e.g. SB-
DECONTAMINATE, and modify it for Syringe B. Then, replicate the procedure.
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Long Shutdown (Prepare for Storage or Shipment)

Before the MultiFlo is shipped or stored, the entire system   should be rinsed and 
soaked with disinfectant and then purged of all fluid.   Perform these steps when 
leaving the instrument unused for a long period   of time.

Predefined protocols are installed onboard the instrument and on the host 
computer   during installation of the LHC:

 o S-LONG_SHUTDOWN — for the Syringe dispenser             

The LONG_SHUTDOWN   protocol flushes and soaks the supply and manifold tubing  
with disinfectant, then flushes with rinse, and finally purges the system   of fluid.  

 For the Syringe dispensers: copy this protocol and modify it to run on Syringe B.

 n Three supply bottles are required for   this procedure: one for disinfectant, one 
for rinse, and one for air. 

Caution! Be sure to check the percentage NaClO of   the bleach you are using; this 
information is printed on the side of the   bottle. Commercial bleach is typically 10% 
NaClO; in this case,   prepare a 1:20 dilution. Household bleach is typically 5% NaClO; in 
this case, prepare a 1:10 dilution.             

 1. Turn   the instrument off and disconnect the power cord.              

 2. Unload   the Peri-pump cassette and the prime trough inserts, if applicable. 
Clean and store them   separately.             

 3. Empty   the waste bottle.             

 4. Prepare   an aqueous solution of 0.5% sodium hypochlorite (NaClO, or bleach).             

 5. Fill   one supply bottle with at least 400 mL of bleach solution (disinfectant).             

 6. Fill   another supply bottle with at least 800 mL of deionized water (rinse).             

 8. Turn   on the instrument and run S-LONG_SHUTDOWN.             

Storing the Instrument

After performing the Long Shutdown (Prep for Storage or Shipment) above   protocols:
 l Turn off the instrument   and disconnect the power cord.             

 l Store it on a flat surface   that is relatively free of vibration, in a dust-free and particle-
free   environment.             
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 l Protect the instrument from   temperature extremes that can cause condensation within 
the unit and from   corrosive fumes and vapors.             

 l Store the instrument under   the following environmental conditions:              

Temperature: 20° to 50°C (-4° to 122°F)

Relative   humidity:                    10% to 85% (non-condensing)

 n Important:  Allow the instrument to reach room temperature before use after 
storage.             

 

Replace Components

Some components of the MultiFlo must be replaced   periodically to maintain 
specified performance levels. 

Peri-pump Components

 l Replace Peri-pump Dispense Cassette Tubing below

 l Recalibrate the Peri-pump Dispense Cassette below

Syringe Dispenser Components

 l Clean or Replace the Check Valves on page 143

 l Calibrate the Backlash for Syringe Dispenser on page 153

Replace Peri-pump Dispense Cassette Tubing

BioTek provides replacement tubing kits as an alternative   to buying a new cassette. 
Purchase the replacement tubing kits from BioTek   and follow the instructions 
shipped with the kit or on the MultiFlo Operator’s   Manual CD in the "Cassette 
Calibration" folder, titled:   7171017_(current Rev)_Replacing the tubing_
8x14.PDF.   For the best experience with these instructions print them on legal size   
paper (8½” x 14”).

Recalibrate the Peri-pump Dispense Cassette

Calibration Kit

BioTek offers an accessory for recalibrating dispense cassettes.   The Calibration Kit 
(PN 7170017) speeds up the recalibrating process and is useful   for verifying 
performance.

Follow the instructions shipped with the kit or find them   on the MultiFlo 
Operator’s Manual CD in the "Cassette Calibration" folder, titled: 7171009_
(current Rev)_Calibration Kit   Instructions.PDF. 
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Gravimetric Method                                       

The alternative and most precise method for calibrating   a cassette is the gravimetric 
method. Find the instructions on the MultiFlo Operator’s   Manual CD in the 
"Cassette Calibration" folder: it is titled:   7171024_(current Rev)_Calibrating 
Gravimetrically.PDF.

Replace Syringe Dispenser Check Valve

You can order replacement check valves from BioTek Customer   Care if your check 
valves become clogged and cleaning them does not solve   the problem:
 l PN   68083 — Autoclavable valves for use with non-organic substances.               

 l PN   68073 — Check valves recommended for use with organic substances.              

 n If you observe   a decline in performance after changing the check valves, 
Calibrate the Backlash for Syringe Dispenser on the facing page.             
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Calibrate the Backlash for Syringe Dispenser

If you have replaced a check valve and subsequently noticed   a decline in 
performance, recalibrating the backlash is recommended to   restore accuracy in 
dispense volumes.  

Equipment Required

 l Microplates: 384-well plates for testing the 16-tube dispensers (which can be 
replaced with 96-well plates if more applicable for your lab); 1536-well plates 
for testing the 32-tube dispensers; and 96-well plates for testing the 8-tube 
dispensers. 

 l Precision   balance with minimum capacity of 100 g and readability of 0.001 g 
resolution               

 l Supply bottle   with deionized water             

Setup

While calibrating and testing, try to maintain a steady   liquid level in the supply 
bottle, keeping it half full. Start with more   fluid to allow for priming. Connect the 
supply bottle to the Syringe under   test. Make sure the   supply bottle is at the same 
level as the dispenser.

Create a Dispense Protocol

Create a protocol that dispenses the correct volume for the manifold under test:    
 l 16-tube manifold: 20 µL per well   to a 384-well   plate at Flow Rate 2.

 l 32-tube manifold: 6 µL per well   to a 1536-well   plate at Flow Rate 2.

 l 8-tube manifold: 20 µL per well   to a 96-well   plate at Flow Rate 2.

Prime and Dispense

 1. Run   a Prime protocol, for example, S-DAY_RINSE   or S-DAY_RINSE_A&B   when 
both Syringe pumps need calibration, to remove air bubbles from the   tubing.            

 2. Place   the  plate on the balance, and tare the balance.             

 3. Place   the plate onto the carrier and run the dispense protocol created above.             

 4. Upon   completion, carefully remove and reweigh the plate to determine the 
Actual Weight.               

 5. The   Expected Weight is:
 o 16 tube = 7.680 grams

 o 32 tube = 9.216 grams
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 o 8 tube = 1.920 grams

 6. Calculate   the volume (weight) error and the backlash adjustment that needs to 
be   made:              
 o 16 tube: (7.680 - Actual Weight ÷ 24 ÷ [.0033 or .0031*]) = backlash   setting

 o 32 tube: (9.216 - Actual Weight ÷ 48 ÷ [.0033 or .0031*]) = backlash   setting

 o 8 tube: (1.920 - Actual Weight ÷ 12 ÷ [.0033 or .0031*]) = backlash   setting
* use .0033 for autoclavable units; use .0031 for non-autoclavable units.

 l Subtract the Actual Weight   from the Expected Weight and divide by 
the number of columns dispensed   to.              

 l Divide the result by 0.0033   and round to the nearest whole number.              

Example: 7.680 - 7.550 = 0.130, 0.130/24 = 0.00542,   0.00542/0.0033 = 1.64 
rounded to 2. The backlash setting needs to be adjusted   by 2.

 7. Adjust   the backlash as necessary: select Tools>Instrument   Utilities> Syringe 
Dispenser and enter the number of steps in   the applicable Backlash fields in 
the Calibration   Data group box.             

 8. Repeat   steps 1 through 4 until the volume dispensed is within one backlash 
unit   of being exact: ±   0.119 mL.             
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Qualification        

This chapter provides instructions for periodically testing the 
instrument to verify that it meets performance specifications. 
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 Qualification Overview

Instrument verification for the MultiFlo involves three   activities:  qualification of 
installation and setup, qualification   of routine capability, and qualification of long-
term stability.  These activities are called Installation Qualification   (IQ),   
Operational Qualification (OQ),   and Performance Qualification (PQ),   respectively. 

Review the Qualification Schedule on the facing page.

Verification testing includes: 
 l The System   Self Test verifies system components, such as the manifold   and carrier 

positioning. The Checksum   Test verifies the basecode software against internal 
checksum   values to ensure that no corruption has occurred.              

Peri-pump and Syringe Dispensers
 l Dispense Precision is a measure of the   variability of volumes dispensed from tube to 

tube across the manifold   or tip holder. The optical density of the solution in a well is 
proportional   to the total volume of the solution in the well. When the % Coefficient   of 
Variation (%CV) is calculated, the result is a measure of the uniformity   of the 
distribution of dispensed volumes across the manifold. It is the   ratio, expressed in 
percent, of the standard deviation of the distribution   of fluid volumes in the wells to the 
mean value of volume per well. The   uniformity of distribution across the manifold 
improves as the %CV is   lowered.              

 l Dispense Accuracy is a measure of the average volume dispensed per well. It is   
independent of precision. The volume per well may vary greatly over a   plate, yet the 
accuracy may be exact because it is an average of the volumes.             

Peri-pump   Qualification Tests:
 l Performing the Peri-Pump Precision and Accuracy Tests on page 164

Syringe   Dispenser Qualification Tests:
 l Perform the Syringe Dispense Precision & Accuracy Test on page 175
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Qualification Schedule

The following schedule defines the factory-recommended intervals for   verification 
tests for an instrument used two to five days a week. The schedule assumes that 
the MultiFlo is properly maintained as outlined   in the Recommended Maintenance 
Schedule on page 124.

 n Note: An instrument qualification package (PN 7210512)  is available for 
purchase. The package contains thorough procedures for   performing 
Installation Qualification, Operational Qualification and Performance   
Qualification (IQ-OQ-PQ) and preventative maintenance (PM). Extensive   
Checklists and Logbooks are included for recording results. Contact your   local 
dealer for more information.

Tests   
IQ OQ PQ

Initially Annually Monthly

Unpacking, Installation,   and Setup ü    

System Self Test and   
Checksum Test 

ü ü ü

Shake   Test  ü  

Peri-pump Dispense   Precision and Accuracy 
Test

 ü ü

Syringe Dispense Precision   and Accuracy Test  ü ü

Run Assay    ü

 n Important! The   risk factors associated with your assays may require that the 
Operational   and Performance Qualification procedures be performed more or 
less frequently   than shown above. 

System Self-Test, Verify Information

Perform these steps to verify software information and run a system self-check:

Prerequisite: When controlling the instrument with the LHC, ensure that it is 
attached to the host computer and turned on, and then launch the LHC software. 

To run   the System Self-Test:
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LHC Keypad

Select   Tools>Instrument
Utilities>General Settings. 
Under Instrument Functions, click 
Perform Self-check.

 1. Select             UTILS at the main menu.

 2. Select TESTS.

 3. Select SLFCHK.

Test Results:

 l If the test passes, a “passing” message appears.

 l If the test fails, an error code displays. If this happens, find the error code in 
the MultiFlo Operator’s Manual to determine its cause. If the problem is 
something you can fix, turn off the instrument, fix the problem, and then turn 
the instrument back on and re-run the test. If the problem is not something 
you can fix, contact BioTek’s Technical Assistance Center.

Record Basecode

Record the software part number and version installed on the MultiFlo.

LHC Keypad

 1. Select Tools>Instrument 
Utilities

 2. Select the             Software tab and from 
the Basecode Software 
Information section record the

 l Software Version and part 
number

 l Data Version

 l Checksum values UI and MC

 1. Select UTILS

 2. Select TESTS

 3. Select CHKSUM

 4.  Reveal and record the checksum 
values one at a time for UI and MC. 
Also record the Software part 
number and version.

Checksum Test

The Checksum Test compares the on-board software with an   internally recorded 
checksum value to ensure the program has not become   corrupted. 
To run   the Checksum Test:

LHC Keypad

 1. At the LHC main view, 
select   Tools>Instrument

 1. Select           UTILS at the main menu.
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Utilities>Software.

 2. Click the Retrieve All 
onboard settings link at the   
top of the window.

 2. Select TESTS.

 3. Select CHKSUM.

 4. One at time, display the UI and MC 
checksums.

Liquid Testing the MultiFlo™ Microplate Dispenser

Which Tests to Perform?

We recommend that you perform these routine tests before first use (after the 
IQ) and then monthly:

Peri-pump Dispenser
 l Dispense Precision and Accuracy Test. For each Peri-pump installed perform two 

tests, one at the volume that matches the cassette type and another that best represents 
the cassette type and dispense volume most common to your applications.

Syringe Dispenser
 l Dispense Precision and Accuracy Test. Perform two tests for each syringe using the 

tests that best represent the plate type and dispense volume most common to your 
applications.

If you have: Run Liquid 
Test(s)

8-tube manifolds (1 unit) Test 1 and 
Test 2

16-tube manifolds Test 1 and 
Test 2

32-tube manifolds Test 3 (twice)

Important Recommendations for All Liquid Tests

Test Solutions

 l Using pure deionized water in place of the test solutions is not 
recommended and will likely result in the failure to meet specifications.             

 l Prepare the solutions the day before you plan to run the tests. This will 
allow any foam caused by the agitation of solutions containing Tween® 20 to 
settle.             
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 l BioTek determined the pass/fail specifications for the instrument tests using 
the recommended test solutions. You may use your own buffer solution 
instead, but if any tests fail using your own buffer, retry the tests using the 
recommended solutions.             

Plate Reading

 l If you are using one of BioTek’s keypad-based readers, such as the ELx800 or
 ELx808, ensure that the reader is not running in Rapid mode. To check the 
setting, select UTIL à READ and cycle through the options until READ IN  

RAPID MODE? appears. Set it to NO.             

 l The absorbance of blue dye solutions should be measured at 630/450 (or 
405) nm. The BioTek blue dye solution part number is 7773001.             

 l The final absorbance for all dye solution concentrations should be in a range 
between 0.700 and 1.600 OD.             

Recording Test Results

 l Use the Liquid Test Worksheets at the end of this section for recording data 
reduction results. If your tests are failing, this information will be useful for 
BioTek TAC to help diagnose any problems.             
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Peri-pump Dispense Precision and Accuracy Tests

Dispense Precision and Accuracy Specifications

Cassette Precision Accuracy

1 µL
 

10%CV  @ 1 µL per well ± 10% @ 1 µL per well 

5%CV  @ 2 µL per well* ± 5% @ 2 µL per well*                     

10%CV  @ 0.5 µL per well n/a

5 µL
 

5%CV  @ 5 µL per well                     ± 4% @ 5 µL per well                    

2.5%CV  @ 10 µL per well*                     ± 2% @ 10 µL per well*                     

10 µL                    
 

4%CV  @ 10 µL per well                    ± 4% @ 10 µL per well                     

2%CV  @ 20 µL per well*                     ± 2% @ 20 µL per well*                     

* These specifications   are for these dispense volumes and higher.                     

 n Note:   For IQ/PQ/OQ purposes you can   add 1.0% additional tolerance to the 
Precision %CV to accommodate various   test solutions, off-peak wavelengths, 
reader errors, and pipette errors.             

Peri-pump Precision and Accuracy   Testing Methodology 

Tare an empty plate on a balance. Use the Peri-pump   to dispense a quantity of 
fluid with a known dye concentration to the   wells. Weigh the plate to obtain the 
weight of the fluid dispensed.   Pipette deionized water on top of the dye to bring 
the wells up to a more   optically measurable volume. Read the wells in a 
microplate reader and   determine the percentage Coefficient of Variance (%CV) 
among all wells,   and the accuracy of the volume dispensed in each well (% 
Accuracy Error).

BioTek recommends performing two tests, one at the volume   that matches the 
cassette type and another that best represents the cassette   type and dispense 
volume most common to your applications:

Tests – Solutions
Cassette Types

1 µL 1 µL 1536 5 µL 10 µL

1 µL √ √   

5 µL   √  
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Tests – Solutions
Cassette Types

1 µL 1 µL 1536 5 µL 10 µL

10 µL √    √

50 µL   √  

100 µL    √

1536  √   

 l 1   µL Test: Confirms the performance of the 1 µL   cassettes when dispensing a single 
aliquot (1/4 turn of pump) into each   well of the plate. It dispenses 1 µL   into each well 
using the 1 µL   Solution, and requires an additional 150 µL of deionized or distilled water 
to raise the   fluid level for optimal reading.              

 n A single aliquot for a cassette type   is the smallest volume unit recommended 
for it. 1 µL for the 1 µL cassette,   5 µL for the 5 µL cassette, and 10 µL for the 
10 µL cassette (except that later model instruments can dispense 0.5 µL/well 
using a 1 µL cassette).             

 l 5   µL Test: Confirms   the performance of the 5 µL   cassettes when dispensing a single 
aliquot (1/4 turn of pump) into each   well of the plate. It dispenses 5 µL   into each well 
using the 5 µL   Solution, and requires an additional 150 µL of deionized or distilled water 
to raise the   fluid level for optimal reading.              

 l 10   µL Test: Confirms   the performance of the 1 µL   cassettes when dispensing 10 aliquots 
(2 1/2 turns of pump) and the 10   µL cassettes when dispensing   a single aliquot (1/4 turn 
of the pump) into each well of the plate. It   dispenses 10 µL into each well   using the 10 µL 
Solution,   and requires an additional 100 µL of deionized or distilled water to raise the 
fluid level   for optimal reading.              

 l 50   µL Test: Confirms the   performance of the 5 µL cassettes   when dispensing 10 aliquots 
(2 1/2 turns of pump) into each well of the   plate. It dispenses 50 µL into   each well using 
the 50 µL   solution, and requires an additional 100 µL of deionized or distilled water to 
raise the   fluid level for optimal reading.              

 l 100   µL Test:  Confirms   the performance of the 10 µL   cassettes when dispensing 10 
aliquots (2 1/2 turns of pump) into each   well of the plate. It dispenses 100 µL   into each 
well using the solution called 100 µL   solution, and requires an additional 50 µL of 
deionized or distilled water to raise the   fluid level for optimal reading. 

 l 1536 Test: Confirms the alignment of the tips; that the cassette is firing straight into 
the wells. Dispenses 6 µL into columns 2, 4, 19-30, 45, 47 of a 1536-well plate using the 
"1536 solution." Also requires performing the 1 µL Test described above.           

MultiFlo™ Microplate Dispenser



Peri-pump Dispense Precision and Accuracy Tests |  163

Peri-pump Dispenser Test Materials

 l 96-well plates: Corning® Costar   #3590 or equivalent 

 l 1536-well plates: Nunc #264710             

 l Precision balance with readability   of 0.0001 g resolution is preferable, 0.001 g resolution 
is acceptable,   and capacity of 100 g minimum             

 l Pipettes and graduated beakers             

 l Microplate absorbance reader   capable of dual wavelength reading at 630 and 
 450 (or 405) nm              

 l BioTek   blue dye solution, PN 7773001, or equivalent to create the Peri-pump Dispense 
Precision and Accuracy Test Solutions below. 

 n See Important Recommendations for All Liquid Tests on page 159.             

Peri-pump Dispenser Precision and Accuracy Test Solutions

Unique concentrations of the test fluid are described here,   each one corresponds to 
a specific dispense volume. Prepare the solutions   you will need to validate the 
cassette types and dispense volumes used   most commonly in your applications.

 n The 5 µL Solution is used to make the   higher volume test solutions.             

1 µL Solution

Using BioTek’s 10X concentrated blue dye solution   (PN 7773001), mix 5 mL of 
deionized or distilled water with 8 mL of the blue dye solution.

5 µL Solution

Using BioTek’s 10X concentrated blue dye solution   (PN 7773001), mix 100 mL of 
deionized or distilled water with 10 mL of the blue dye solution.

10 µL Solution

Mix 25 mL of DI or dH2O water with 20 mL of the 5 µL Solution (described above).

50 µL Solution

Mix 45 mL of DI or dH2O water with 5 mL of the 5 µL Solution.

100 µL Solution

Mix 40 mL of DI or dH2O water with 2 mL of the 5 µL Solution.
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1536 Solution

Mix 5 mL of 70% isopropyl alcohol with 3 mL of the 5 µL Solution and 35 mL of DI 
H2O.

Perform the Peri-Pump Precision and Accuracy Tests

Prerequisite:
 l Gather the required   materials.             

 l Prepare the test solutions.             

 l Make a copy of the applicable   worksheets. You will find them on the operator's manual 
CD in the Qualification   chapter PDF.

Procedure:

 1. Install the cassette to   be tested.              

 2. Turn on the MultiFlo and make sure the cassette (CASS) type setting is correct.             

 3. Turn on the balance.             

 4. Fill a beaker or other vessel   with the test solution.             

 5. Define a Protocol   and save it for reuse. Set the parameters based on the desired 
test volume: 

 n A predefined protocol for the 1536 Test is shipped with the instrument and 
installed on your PC when you install the LHC: P-1536_DISP_TEST (P2 
protocols are designed for the Secondary Peri-pump). 

 l  Add a  dispense step to the protocol: PERIP>DISP.                 

 l Set the Dispense Volume to match the   Test:                 

Test Volume

1   µL 1   µL

5   µL 5   µL

10   µL 10   µL

50   µL 50   µL

100   µL 100   µL

1536 6 µL

 l Set the Flow Rate to:                 
 l 1 µL cassette =   Medium                     
 l 5 µL cassette =    High                     
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 l 10 µL cassette =   High                     

 l Optionally, choose to   Require   the specific cassette type under test.                 

 l LHC users: click the Advanced options link; retain   the default Positioning   
settings.                 

 l Define a Pre-dispense: set the volume   to 10 µL and the Number   of Pre-dispenses 
(cycles) to 2.                 

 6. Place a clean/new microplate   on the balance and tare the balance.              

 7. Put the Tube Organizer into   the test fluid vessel and Prime   the tubing until any 
large air bubbles are removed.             

 8. Run the dispense protocol.             

 9. Place the plate on the balance   and record the Total   Dispense Weight in the 
worksheet.             

 10. Using a calibrated hand   pipette or the Peri-pump, add the specified amount of 
deionized water to each well to raise   the fluid level to approximately 150 µL.

Test Volume

1   µL 150   µL

5   µL 150   µL

10   µL 100   µL

50   µL 100   µL

100   µL 50   µL

1536 0 µL

 11. Read the plate in an absorbance   reader using the dual-wavelength method: read 
the plate at 630 nm and   450 nm.              

 12. Calculate the Delta OD: (630 nm - 450   nm), Mean Absorbance,   Standard 
Deviation,   and the %CV   for the wells under test. %CV   = (Standard Deviation ÷ 
Mean)   * 100.             

 13. Print the report, obtain   required signatures, and store it according to regulatory 
guidelines. 

If one or more of your tests are failing, make sure the   dispense tubes are not 
clogged, (follow instructions to                                   Unclog the Dispense Tips on page 137). If that doesn’t 
work, recalibrate   the cassette and repeat the test(s). If your tests continue to fail, 
contact   BioTek’s Technical Assistance Center (TAC).
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Documenting Test Results

Dispense Precision & Accuracy Test Worksheets are provided   on the Operator's 
Manual CD in the Qualification chapter PDF. We recommend   you make copies of 
the appropriate pages and use them to record your calculations   and test results. 

Alternatively, you can purchase the instrument qualification package, which   
contains additional tools for conducting test procedures and recording   the results, 
including logbooks and Excel®   spreadsheets. 
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Peri-pump Dispense Precision & Accuracy Test Worksheet
1 µL Test for 1 µL Cassette

 

1 µL Dispense Precision Test

Standard Deviation (SD):       

Mean Absorbance (sum of all wells ÷ 96)       

% CV (SD ÷ Mean x 100)      %

% CV must be < 11.0%      c Pass    c Fail      

 

1 µL Dispense Accuracy Test

Total Dispense (Actual) Weight: grams

Expected Weight:
(mL/well x number of wells dispensed)      

grams

% Accuracy Error: 
(Actual Weight – Expected Weight) ÷  Expected Weight x 100
      

%

% Accuracy Error must be < 10.0% c Pass    c Fail      

Visual verification that no well varies 
considerably from the others      

c Pass    c Fail      

 

Cassette Serial Number:  

Tests Performed By:
Date:

 

 

Reviewed/Approved By:
Date:
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10 µL Test for 1 µL Cassette

 

10 µL Dispense Precision Test

Standard Deviation (SD):       

Mean Absorbance (sum of all wells ÷ 96)       

% CV (SD ÷ Mean x 100)      %

% CV must be < 6.0%      c Pass    c Fail      

 

 

10 µL Dispense Accuracy Test

Total Dispense (Actual) Weight: grams

Expected Weight:
(mL/well x number of wells dispensed)      

grams

% Accuracy Error: 
(Actual Weight – Expected Weight) ÷  Expected Weight x 100
      

%

% Accuracy Error must be < 5.0% c Pass    c Fail      

Visual verification that no well varies 
considerably from the others      

c Pass    c Fail      

 

 

Cassette Serial 
Number:

 

Tests Performed By:
Date:

 

 

Reviewed/Approved 
By:
Date:
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1536 Test

 

1536 Dispense Precision Test

Standard Deviation (SD):       

Mean Absorbance (sum of all wells ÷ 384)       

% CV (SD ÷ Mean x 100)      %

% CV must be < 6.0%      c Pass    c Fail      

 

1536 Dispense Accuracy Test

Total Dispense (Actual) Weight: grams

Expected Weight:
(mL/well x number of wells dispensed)      

grams

% Accuracy Error: 
(Actual Weight – Expected Weight) ÷  Expected Weight x 100
      

%

% Accuracy Error must be < 5.0% c Pass    c Fail      

Visual verification that no well varies 
considerably from the others      

c Pass    c Fail      

 

Cassette Serial 
Number:

 

Tests Performed By:
Date:

 

 

Reviewed/Approved 
By:
Date:
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5 µL Test

 

5 µL Dispense Precision Test

Standard Deviation (SD):       

Mean Absorbance (sum of all wells ÷ 96)       

% CV (SD ÷ Mean x 100)      %

% CV must be < 6.0%      c Pass    c Fail      

 

5 µL Dispense Accuracy Test

Total Dispense (Actual) Weight: grams

Expected Weight:
(mL/well x number of wells dispensed)      

grams

% Accuracy Error: 
(Actual Weight – Expected Weight) ÷  Expected Weight x 100
      

%

% Accuracy Error must be < 4.0% c Pass    c Fail      

Visual verification that no well varies 
considerably from the others      

c Pass    c Fail      

 

Cassette Serial 
Number:

 

Tests Performed By:
Date:

 

 

Reviewed/Approved 
By:
Date:
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Peri-pump Dispense Precision & Accuracy Test Worksheet
50 µL Test for 5 µL Cassette

 

50 µL Dispense Precision Test

Standard Deviation (SD):       

Mean Absorbance (sum of all wells ÷ 96)       

% CV (SD ÷ Mean x 100)      %

% CV must be < 3.50%      c Pass    c Fail      

 

50 µL Dispense Accuracy Test

Total Dispense (Actual) Weight: grams

Expected Weight:
(mL/well x number of wells dispensed)      

grams

% Accuracy Error: 
(Actual Weight – Expected Weight) ÷  Expected Weight x 100
      

%

% Accuracy Error must be < 2.0% c Pass    c Fail      

Visual verification that no well varies 
considerably from the others      

c Pass    c Fail      

 

Cassette Serial 
Number:

 

Tests Performed By:
Date:

 

 

Reviewed/Approved 
By:
Date:
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Peri-pump Dispense Precision & Accuracy Test Worksheet
10 µL Test for 10 µL Cassette

 

10 µL Dispense Precision Test

Standard Deviation (SD):       

Mean Absorbance (sum of all wells ÷ 96)       

% CV (SD ÷ Mean x 100)      %

% CV must be < 5.0%      c Pass    c Fail      

 

10 µL Dispense Accuracy Test

Total Dispense (Actual) Weight: grams

Expected Weight:
(mL/well x number of wells dispensed)      

grams

% Accuracy Error: 
(Actual Weight – Expected Weight) ÷  Expected Weight x 100
      

%

% Accuracy Error must be < 4.0% c Pass    c Fail      

Visual verification that no well varies 
considerably from the others      

c Pass    c Fail      

 

Cassette Serial 
Number:

 

Tests Performed By:
Date:

 

 

Reviewed/Approved By:
Date:

 

 

 

MultiFlo Qualification Procedures
© 2012, BioTek® Instruments, Inc.



Peri-pump Dispense Precision & Accuracy Test Worksheet
100 µL Test

 

100 µL Dispense Precision Test

Standard Deviation (SD):       

Mean Absorbance (sum of all wells ÷ 96)       

% CV (SD ÷ Mean x 100)      %

% CV must be < 3.0%      c Pass    c Fail      

 

100 µL Dispense Accuracy Test

Total Dispense (Actual) Weight: grams

Expected Weight:
(mL/well x number of wells dispensed)      

grams

% Accuracy Error: 
(Actual Weight – Expected Weight) ÷  Expected Weight x 100
      

%

% Accuracy Error must be < 2.0% c Pass    c Fail      

Visual verification that no well varies 
considerably from the others      

c Pass    c Fail      

 

Cassette Serial 
Number:

 

Tests Performed By:
Date:

 

 

Reviewed/Approved 
By:
Date:
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Syringe Dispenser Liquid Tests

Dispense Precision and Accuracy Specifications

 n  Important: For IQ/PQ/OQ testing purposes 1.0% tolerance has been added 
to some of the published specifications for  Precision %CV to accommodate 
variations in test solutions,   off-peak wavelengths, reader errors, and pipette 
errors. % Accuracy Error is calculated for the dispense volume specified in the 
respective test procedure in adherence to the published specifications.

Test # Plate Type-Manifold Precision Accuracy

2 384-well plate < 3% CV @ 80 µL/well < 1.25% @ 80 µL/well

1 16-tube manifold < 6% CV @ 20 µL/well < 5% @ 20 µL/well

2 96-well plate < 3% CV @ 160 µL/well < 1.25% @ 160 µL/well

1 8- & 16-tube manifold < 6% CV @ 40 µL/well < 5% @ 40 µL/well

3 1536-well plate < 12% CV @ 6 µL/ well < 5% @ 6 µL/well

 32-tube manifold   

Syringe Dispenser Test Materials

 l Microplates: 384-well plates for testing the 16-tube dispensers (which can be replaced 
with 96-well plates if more applicable for your lab); 1536-well plates for testing the 32-
tube dispensers; and 96-well plates for testing the 8-tube dispensers. 

 l Precision balance with readability   of 0.0001 g resolution is preferable, 0.001 g resolution 
is acceptable,   and capacity of 100 g minimum             

 l Pipettes and graduated beakers             

 l Microplate absorbance reader   capable of dual wavelength reading at 630 and 405 (or 
450) nm              

 l The test   solutions: Syringe Dispenser Test Solutions on the facing page. 

 n See also Important Recommendations for All Liquid Tests on page 
159.
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Syringe Dispenser Test Solutions

20 µL Solution

 o Mix 10 mL of BioTek’s   blue dye solution with 100 mL of deionized or distilled water 
to create a dilution of the   concentrate. Mix 160 mL of deionized or distilled water 
with 20 mL of the diluted concentrate.             

80 µL Solution

 o Mix 120 mL of deionized or distilled water   with 40 mL of the 20 µL Solution.             

1536 µL Solution

 o Mix 21 mL of 70% Isopropyl Alcohol with 13 mL of the 20 µL Solution and 150 mL 
of DI H2O.    

Perform the Syringe Dispense Precision & Accuracy Test

Prerequisites:
 l Gather the required   materials: Syringe Dispenser Materials on previous page.             

 l Prepare the test solutions: Syringe Dispenser Test Solutions above.             

 l Make a copy of the applicable   worksheets. You will find them on the Operator's Manual 
CD in the Qualification   chapter PDF. 

Test Protocols

Two predefined QC protocols are provided for qualifying the 32-tube dispensers. 
Skip the protocol development steps in the procedure when testing these 
dispensers:

Onboard Name Description

SA-1536_DISP_TEST Dispense precision test protocol for 32-tube Syringe A 
manifold.

SB-1536_DISP_TEST Dispense precision test protocol for 32-tube Syringe B 
manifold.

These predefined protocols dispense 6µL/well into 512 wells of a 1536-well 
plate (columns 2, 4, 19-30, 45, 47). For speed, efficiency and to reduce the 
amount of alcohol needed, the test is designed for visual inspection of the two 
columns at each end of the plate, while the block of columns at the center of the 
plate is used for evaluating dispense precision.  
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Procedure: 

Perform two tests for each syringe: use two plates of the applicable type, 384-well 
for the 16-tube manifolds (unless only 96-well plates are used in your lab), 1536-
well for the 32-tube manifolds, and 96-well for the dual 8-tube manifold, and two 
dye solutions.   

 1. Prepare the syringe dispenser   to be tested:             
 l Test 1: Use the 20 µL solution

 l Test 2: Use the 80 µL solution

 l Test 3: Use the 1536 solution

 2. Prime the Syringe using your preferred method: run S-DAY_RINSE_A (or B) or 
use the Quick Dispense menu to remove any air bubbles from the system.

 3. Create and save protocols for the tests,   two for each Syringe, A and B,  as 
follows:              

Skip these protocol development steps for the 32-tube dispensers. And, 
because you will save the protocols, you only need to create them one 
time for the other manifolds.

 1. Define a Dispense step for   each test for each manifold, A and B: 

 Manifold Type Plate Type Volume (µL/well)

Test 1:                             16-Tube 384                             20                             

 8-Tube 96                             40                             

Test 2: 16-Tube 384 80

 8-Tube 96 160

 2. Set Flow Rate to 2   for all tests.

 3. Save the protocol.

 4. Place a clean, empty microplate on the balance and tare the balance.             

 5. Place the microplate on   the carrier and run the protocol (created in step 3 or 
predefined).            

 6. Place the plate on the balance   and record the Total   Dispense Weight.  This value 
will be used to calculate the % Accuracy Error. 

 6. For Test 1 Only: Use a calibrated   hand pipette or the Peri-pump to dispense 
deionized water on top of the dye solution in   the wells.              
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 l 384-well: Pipette 60 µL/well   (resulting in 80 µL/well)                 

 l 96-well: Pipette 120 µL/well   (resulting in 160 µL/well)                 

 7. Shake the plate using the MultiFlo, an orbital   shaker or in a microplate reader 
for 15 seconds, or lightly tap the side   of the plate with your finger to agitate the 
contents of the wells.              

 8. Read the plate in an absorbance   reader using the dual-wavelength method, to 
reduce the influence of scratches   and foreign particles that could be in the well.  
See   the recommended wavelengths.  Print or export the results.               

 9. Calculate and report the   Mean absorbance, Standard Deviation, and the %CV for 
the wells under test.   %CV = (Standard Deviation ÷ Mean) * 100.             

 10. The %   Accuracy Error calculation is: (Actual   Weight - Expected Weight) ÷ 
Expected Weight x 100

Subtract the expected dispense weight (see below) from   the Actual (Total) 
Dispense Weight (from step 5), and divide the result   by the expected weight. 
Multiply the result by 100.

The Expected   Dispense Weight is the volume dispensed per well in mL 
multiplied   by the number of wells dispensed. For example, if 40 μL is 
dispensed to   96 wells, the expected weight is 0.040 x 96 = 3.84 grams. We 
have calculated   some expected dispense weights for you:

Test # of wells Volume
μL/well

Expected 
Weight

Test 1: 384 wells 20 7.68 grams

 96 wells 40 3.84 grams

Test 2: 384 wells 80 30.72 grams

 96 wells 160 15.36 grams

Test 3: 512 wells (of a 1536-well 
plate)

6 3.012 grams

 11. Analyze your test results.   The following is the Pass criteria for each test:                 

 %CV % Accuracy Error

Test 1: < 6.0% ± 5.0%

Test 2: < 3.0% ± 1.25%

Test 3: < 12.0% ± 5.0%
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If one or more of your tests are failing, clean the dispense   tubes with the stylus, re-
prime the manifold, and repeat the test(s).   If your tests continue to fail, contact 
BioTek’s Technical Assistance   Center.

Documenting Test Results 

Dispense Precision & Accuracy Test Worksheets are provided   on the Operator's 
Manual CD in the Qualification chapter PDF. We recommend   you make copies of 
the appropriate pages and use them to record your calculations   and test results.

Each Worksheet records calculations and pass/fail test results   for an individual 
test. 
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Syringe Dispenser Precision & Accuracy Test Worksheet

Test 1 / 96-Well Microplate/40 µL Dispense 

 

40 µL Dispense Precision Test

Standard Deviation (SD):                      

Mean Absorbance (sum of all wells ÷ 96)                      

% CV (SD ÷ Mean x 100)                     %

% CV must be < 6.0%      c Pass    c Fail      

 

40 µL Dispense Accuracy Test

Total Dispense (Actual) Weight: grams

Expected Weight:
(mL/well x number of wells dispensed)      

grams

% Accuracy Error: 
(Actual Weight – Expected Weight) ÷  Expected Weight x 100
      

%

% Accuracy Error must be < 5.0% c Pass    c Fail      

Visual verification that no well varies 
considerably from the others      

c Pass    c Fail      

 

Serial Number:  

Tests Performed By:
Date:

 

 

Reviewed/Approved 
By:
Date:
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Syringe Dispenser Precision & Accuracy Test Worksheet

Test 2 / 96-Well Microplate/160 µL Dispense         

 

160 µL Dispense Precision Test

Standard Deviation (SD):  

Mean Absorbance (sum of all wells ÷ 96)       

% CV (SD ÷ Mean x 100)      %

% CV must be < 3.0%      c Pass    c Fail      

 

160 µL Dispense Accuracy Test

Total Dispense (Actual) Weight:                     grams

Expected Weight:
(mL/well x number of wells dispensed)      

grams

% Accuracy Error: 
(Actual Weight – Expected Weight) ÷  Expected Weight x 100
      

%

% Accuracy Error must be < 1.25% c Pass    c Fail      

Visual verification that no well varies 
considerably from the others      

c Pass    c Fail      

 

Serial Number:  

Tests Performed By:
Date:

 

 

Reviewed/Approved By:
Date:
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Syringe Dispenser Precision & Accuracy Test Worksheet

Test 1 / 384-Well Microplate / 20 µL Dispense

 

20 µL Dispense Precision Test

Standard Deviation (SD):                      

Mean Absorbance (sum of all wells ÷ 384)                      

% CV (SD ÷ Mean x 100)                     %                 

% CV must be < 6.0%                  c Pass    c Fail                     

 

20 µL Dispense Accuracy Test

Total Dispense (Actual) Weight: grams

Expected Weight:
(mL/well x number of wells dispensed)                     

grams

% Accuracy Error: 
(Actual Weight – Expected Weight)÷ Expected Weight x 100                     

%

% Accuracy Error must be < 5.0% c Pass    c Fail                      

Visual verification that no well varies 
considerably from the others                     

c Pass    c Fail                       

 

Serial Number:  

Tests Performed By:
Date:

 

 

Reviewed/Approved 
By:
Date:
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Syringe Dispenser Precision & Accuracy Test Worksheet

Test 2 / 384-Well Microplate / 80 µL Dispense         

 

80 µL Dispense Precision Test

Standard Deviation (SD):                      

Mean Absorbance (sum of all wells ÷ 384)                      

% CV (SD ÷ Mean x 100)                     %

% CV must be < 3.0%                     c Pass    c Fail      

 

80 µL Dispense Accuracy Test

Total Dispense (Actual) Weight: grams

Expected Weight:
(mL/well x number of wells dispensed)                     

grams

% Accuracy Error: 
(Actual Weight – Expected Weight) ÷  Expected Weight x 100
                     

%

% Accuracy Error must be < 1.25% c Pass    c Fail      

Visual verification that no well varies 
considerably from the others      

c Pass    c Fail      

 

Serial Number:  

Tests Performed By:
Date:

 

 

Reviewed/Approved By:
Date:
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Syringe Dispenser Precision & Accuracy Test Worksheet

Test 3 / 1536-Well Microplate / 6 µL Dispense

 

6 µL Dispense Precision Test

Standard Deviation (SD):       

Mean Absorbance (sum of all wells ÷ 384)       

% CV (SD ÷ Mean x 100)      %

% CV must be < 12.0%      c Pass    c Fail      

 

6 µL Dispense Accuracy Test

Total Dispense (Actual) Weight: grams

Expected Weight:
(mL/well x number of wells dispensed)      

grams

% Accuracy Error: 
(Actual Weight – Expected Weight) ÷  Expected Weight x 100
      

%

% Accuracy Error must be < 5.0% c Pass    c Fail      

Visual verification that no well varies 
considerably from the others      

c Pass    c Fail      

 

Serial Number:  

Tests Performed By:
Date:

 

 

Reviewed/Approved By:
Date:
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Chapter 6

Troubleshooting        

This chapter provides guidelines for error recovery and 
troubleshooting performance problems. 

Troubleshooting 186
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Troubleshooting

Error recovery:

First Response:   Run a System   Test (restart the instrument) to give the instrument 
an opportunity to restore its   initial settings and communication capability. 

LHC Users: Reboot your Computer and   Instrument: When you cannot run a 
system test, e.g. LHC is not   responding, or when running a system test doesn't 
resolve the issue, turn   off your computer and MultiFlo, check all the cabling, i.e. 
make sure your   serial or USB cable is in good condition and is properly connected 
to   the PC and instrument, and then, power them on. This should refresh the   devices 
and reset communication parameters.

Error Codes

To find a specific error code:
 l Software Error Codes on page 201 (6000-6100) - protocol errors             

 l System Error Codes on page 194 (0000-A500) - hardware errors             

Most error conditions generate an error message that is   displayed on the computer 
screen or keypad.

The most common error for new MultiFlo users is easily fixed:

306 Peri-pump Pump Cover is open. Close the pump   cover and re-run protocol.

To run the   Peri-pump, its pump cover must be closed, protecting both the pump 
and   the operator.

6045 Serial write error

LHC Users: A potentially   common error, especially when using the Predefined 
Protocols, a "serial   write" error, is easily fixed by correcting the COM   port setting 
defined in the protocol. 

810D To communicate, instrument must be at main   menu/Home screen.

LHC Users: Similarly,   the 810D message appears when the instrument is busy, for 
example when   AutoPrime is running. The LHC can only talk to the instrument 
when its main menu is displayed. Press the Stop   button, if desired, to end the 
current process and reestablish communication with the LHC. 

Technical Note: Only one of the two communication ports (COM port) on the  
instrument can be used at a time. They cannot be used simultaneously. You 
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can use USB  to connect the MultiFlo to the computer or the RS232 serial port to 
connect to a BioStack or similar robotic device. But you cannot use both ports 
simultaneously, i.e. make sure only one cable is plugged in at a time.

Keypad Control: When the BioStack is connected to your  MultiFlo, you are 
controlling both instruments using the keypad. Before connecting the MultiFlo to 
your computer to download basecode or for other reasons, you must first 
disconnect the BioStack from the MultiFlo and change the Instrument Setting for 
the BioStack:  Press Setup Menu> g> BIOSTK> CONF>MANUAL.

Syringe Dispenser Troubleshooting

Startup

Problem Possible Cause What To Do

Syringe or 
manifold 
position 
error.  

Syringe or manifold is 
being obstructed.

Remove obstruction.

Motor, sensor, or 
electrical problem.

Turn instrument off, wait at least 15 seconds, turn 
it back on and run a Quick Dispense routine, e.g. 
Prime. If the problem persists, contact BioTek 
TAC.

Syringe piston not seated 
all the way to the bottom 
before fastening set 
screw.

Reinstall the syringe head.

Syringe Movement

Problem Possible Cause What To Do

Syringe 
position 
error.

Syringe movement is blocked. Ensure the 26-pin high-density cable 
shipped with the Syringe is connected to the 
MultiFlo’s rear panel.

Contact BioTek TAC.

Syringe piston not seated all the 
way to the bottom before 
fastening set screw.

Reinstall the syringe piston and syringe 
head.

BioTek Instruments, Inc.
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Fluid Delivery

Problem Possible Cause What To Do

Unable to dispense 
fluid.

Inlet tube not connected 
at manifold or at bottle.

Check all tubing.

  Supply tube inside the 
supply bottle is kinked or 
disconnected.

Straighten or connect supply tube. 
Optimize Performance on page 57

  Clogged dispense tubes on 
the manifold.

Remove and clean the manifold.

  Inlet tube is not connected 
to the bottom port of the 
syringe.

Connect the inlet tube to the lower 
port of the syringe pump.

  Outlet tube is not 
connected to the top port 
of the syringe.

Connect the outlet tube to the top 
port of the syringe pump.

  Check valve flow direction 
is incorrect.

Compare the flow direction of the 
check valves, See Syringe 
Dispenser Check Valves on page 
41.

  Check valves are stuck 
closed.

Clean or Replace the Check Valves 
on page 143

  No fluid. Fill bottles with appropriate fluid.

  System not primed. Run S-DAY_RINSE for once or twice 
for one or both syringes.

  Faulty syringe pump. Contact BioTek TAC.

  Set screw not tightened 
on the syringe pump 
piston.

Reinstall the syringe head.

Plate overfills 
(floods).

Dispense height too high. Change the Dispense Z-axis position 
(height).

  Volume too large for the 
vessel. 

Define a smaller volume.

  Dispense rate too fast for 
volume selected.

Define a slower dispense rate or 
lower volume.

Uneven dispensing of Clogged dispense tubes on Clean the Syringe Dispenser 
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Problem Possible Cause What To Do

fluid; 
wells not filled.
 

the dispenser manifold. Manifold on page 140

  Manifold or tubing not 
adequately primed (air in 
fluid lines).

Run a Prime using 20 mL. Follow 
with a Dispense: 20 µL per well for 
24 strips. 

  Dispense flow rate too 
low.

Define a higher flow rate.

  Setscrew not tightened on 
the syringe pump piston.

Reinstall the syringe head as 
described in Autoclave the Syringe 
Head on page 143

  32-tube dispense 
manifolds are not 
dispensing accurately.

Calibrate the Backlash for Syringe 
Dispenser on page 153 

Dripping dispense 
tubes.

Dispense tubing routed 
incorrectly.

The supply bottle tube must connect 
to the Syringe’s bottom port.

Fluid jet is off-center 
or skewed from 32-
tube SB manifold.

Minute particles of debris 
on the end of the tubes.

Brush away any particles from the 
end of the tube using a piece of 
silicon tubing. Silicon will not flake 
off and leave particles behind like 
other materials.

Fluid Leakage

Problem Possible Cause What To Do

Fluid leaking from manifold.                                           Defective seals.                     Maintaining the Syringe Dispenser 

Check valves are 
leaking.                     

Clean or Replace the Check 
Valves on page 143

Fittings to manifold are 
leaking.                     

Reconnect/reseat the fittings.                     

Fluid leaking from underneath 
the unit.                     

Defective syringe cup.                     Contact BioTek TAC.                     

Leaking syringe seal.                     

Defective syringe 
piston.                     

Fluid leaking from external 
tubing connector.                     

Worn tubing.                     Replace tubing.                     

Defective connector.                     Contact BioTek TAC.                     

BioTek Instruments, Inc.
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Microplate Carrier Movement

Problem Possible Cause What To Do

Dispense tubes not 
entering well correctly.

Microplate not properly seated or 
strips not level.

Reseat microplate 
carrier, or the plate or 
strips in holder. 

Make sure the carrier 
is clean.

Horizontal dispense position does not 
align the tubes in the wells.

Change the X-axis 
(horizontal) Position 
in the protocol.

Dispense tube(s) bent. Push the supplied 
stylus into the tube 
and then gently 
attempt to straighten 
the tube using your 
fingers. If it remains 
bent, contact BioTek 
TAC.

Manifold tilted. Check tubing for 
twists.

Carrier position error. Carrier movement is blocked. Check for/remove any 
obstruction.

Dirty carrier or carrier rail. Clean carrier and/or 
carrier rail.

Dispense Manifold Movement

Problem Possible Cause What To Do

Manifold position 
error.

Manifold movement is 
blocked.

Check the dispense height or Z-axis 
positioning. Allow at least 1 mm clearance 
above plate.

Check for/remove any obstructions.

Contact BioTek TAC.

MultiFlo™ Microplate Dispenser



Troubleshooting |  191

Peri-pump Troubleshooting

Problem What To Do

Fluid stream 
missing wells

Check Tip Holder, make sure it is properly seated in the Dispense 
Arm.
Select the correct Plate Type. 

Fluid splashing out 
of the wells

Select the correct Plate Type.
Reduce the Flow Rate.
Lower the Dispense Height.

Uneven dispensing Make sure all cassette components are properly seated in their 
respective positions.  
Tips are clogged. (See the Preventive Maintenance chapter.)
Recalibrate the cassette.
Replace the tubing. 
(On the Operator’s Manual CD, in the PDF folder, find instructions for 
recalibrating the cassette and replacing the tubing.)

Dispenser skipping 
columns

Check/define the Plate Map.

Tips clogging Filter the dispense fluid to 50 microns before dispensing.
Replace the tubing.

Viscous fluids 
sticking to tips

Vary the Flow Rate: experiment with different flow rates to determine 
which setting best forces fluid to break from the tip.

Cannot 
communicate with 
computer

Check the cabling. (See previous section.)
Select the correct COM Port.
Turn on dispenser; display Main Menu.

Foaming in the 
wells

Reduce the dispense step’s Flow Rate.

Communication Errors

Here are some guidelines for troubleshooting communication   errors between the 
MultiFlo and the computer.

6045: A potentially   common error, 
especially when using the Predefined 
Protocols, a "serial   write" error, is easily 
fixed by correcting the COM   port setting.
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BioStack communication error: when controlling the BioStack with the LHC, make 
sure the onboard configuration setting is Manual. 

810D:   Similarly, the 810D message appears when the instrument is busy, for 
example   when AutoPrime is running. The   LHC can only talk to the instrument 
when its main menu is displayed. Press   the Stop button on the keypad,   if desired, 
to end the current process and return to the main menu. 

Safety first

 n To   prevent damage to the instrument, always turn OFF the MultiFlo or the 
computer   before removing or inserting a communications (serial or USB) 
cable.             

When the computer (PC) won't communicate with the instrument:

 1. Run the system   self-test. All BioTek instruments perform a self-test when 
turned   on. The MultiFlo will not communicate if it fails an internal system test.   
An error message will be displayed when a test fails.             

 2. Make sure the serial or USB cable is in perfect   condition and properly 
attached to the port defined in the Instrument   Settings dialog (e.g. COM 1). 
Review the LHC   Help Topic Select Help&gt;Help Topics and search for "About 
COM Ports." "About COM Ports" to learn about virtual COM   ports when using 
a USB cable. Correct and reboot both PC and instrument.   Test communication.             

 3. Confirm that the serial/USB cable was obtained   from BioTek. Serial/USB 
cables are not universal. Contact BioTek   customer service to purchase a factory 
tested cable. After installing   a known, good cable, reboot both PC and 
instrument.              
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Error Codes    

A listing of potential error codes and possible solutions for 
resolving them. 

System Error Codes 194
MultiFlo-LHC Software Error Codes 201
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System Error Codes

Most of these error conditions require technical expertise   to correct. Error code 306 
and few other exceptions to this rule are listed   with remedies in the 
Troubleshooting section. A few other errors may be   caused by an obvious 
obstruction to a device's movement or insufficient   fluid in a supply vessel. Fix 
these kinds of errors and restart your instrument   to give it an opportunity to clear 
the error code.

Contact BioTek Technical   Assistance Center (TAC) for assistance.  

Code                    Message                       What   to do                     

100 Task was aborted Restart instrument if this   message is 
unexpected.

210, 220 Carrier X motor didn’t   find 
home opto sensor transition
Carrier X motor didn’t   find 
autocal jig opto sensor 
transition

Clean the plate carrier,   rails, and glide 
strips, using mild detergent and hot water, 
70% isopropyl   alcohol or ethanol. Restart 
the instrument. If the error occurs again,   
contact BioTek TAC.

211, 221 Carrier Y motor didn’t   find home 
opto sensor transition
Carrier Y motor didn’t   find 
autocal jig opto sensor 
transition

Run self test. If error reoccurs, contact 
BioTek   TAC.

212, 222 Dispense head motor didn’t   find 
home opto sensor transition,
Dispense head motor didn’t   find 
autocal jig opto sensor 
transition

Run self test. If error reoccurs, contact 
BioTek   TAC.

213, 223 Secondary Peri-pump motor 
didn’t   find home opto sensor 
transition,
Wash head motor didn’t   find 
autocal jig opto sensor 
transition

Run self test. If error reoccurs, contact 
BioTek   TAC.

214 Syringe A motor didn’t   find 
home opto sensor transition

Run self test. If error reoccurs, contact 
BioTek   TAC.

215 Syringe B motor didn’t   find 
home opto sensor transition

Run self test. If error reoccurs, contact 
BioTek   TAC.
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Code                    Message                       What   to do                     

216 Peri-pump motor didn’t   find 
home opto sensor transition

Run self test. If error reoccurs, contact 
BioTek   TAC.

300 Carrier X motor interlock   safety 
switch open

Service Only.
Contact BioTek TAC. 

301 Carrier Y motor interlock   safety 
switch open

Service Only.
Contact BioTek TAC. 

302 Dispense head motor interlock   
safety switch open

Service Only.
Contact BioTek TAC. 

303 Secondary Peri-pump motor 
interlock   safety switch open

Service Only.
Contact BioTek TAC. 

304 Syringe A motor interlock   
safety switch open

Service Only.
Contact BioTek TAC. 

305 Syringe B motor interlock   
safety switch open

Service Only.
Contact BioTek TAC. 

306 Peri-pump Pump Cover is   open Close the pump cover door   and rerun the 
protocol.

400 Carrier X motor failed positional
   verify

Run self test. If error reoccurs, contact 
BioTek   TAC. 

401 Carrier Y motor failed positional
   verify

Run self test. If error reoccurs, contact 
BioTek   TAC. 

402 Dispense head motor failed   
positional verify

Run self test. If error reoccurs, contact 
BioTek   TAC. 

403 Secondary Peri-pump motor 
failed positional   verify

Service Only.
Contact BioTek TAC. 

404 Syringe A motor failed 
positional   verify

Service Only.
Contact BioTek TAC. 

405 Syringe B motor failed 
positional   verify

Service Only.
Contact BioTek TAC. 

406 Peri-pump motor failed 
positional   verify

Service Only.
Contact BioTek TAC. 

600-606 Specified motor currently   in use Service Only.
Contact BioTek TAC. 

700   -
70F

Invalid motor number specified Service Only.
Contact BioTek TAC. 
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Code                    Message                       What   to do                     

900 Calibrationon failed.   The 
measured or calculated autocal 
value is out of tolerance 

Service Only.
Contact BioTek TAC. 

A00 Invalid plate type selected The currently selected plate type is not 
supported with the currently installed or 
requested hardware. If this is not the case, 
contact BioTek TAC. 

C01   Configuration or autocal   data 
missing

Service Only.
Contact BioTek TAC. 

C02   Checksum mismatch -calculated 
checksum didn’t   match saved 
checksum

Service Only.
Contact BioTek TAC. 

C03 Configuration   parameter out of 
range

Service Only.
Contact BioTek TAC. 

1001 Bootcode powerup checksum   
test failed

Contact BioTek TAC. 

1002 Unknown error in bootcode Contact BioTek TAC. 

1003 Bootcode page program error Contact BioTek TAC. 

1004 Bootcode block size error   (not 
256)

Contact BioTek TAC. 

1005 Invalid processor signature   (not 
1280,1281,2560,2561)

Contact BioTek TAC. 

1006 Bootcode memory exceeded Contact BioTek TAC. 

1007 Invalid slave port Contact BioTek TAC. 

1008 Invalid response from slave Contact BioTek TAC. 

1009 Invalid processor detected Contact BioTek TAC. 

1010 Checksum error downloading   
basecode

Contact BioTek TAC. 

1250 Internal RAM test error   on the 
UI processor

Contact BioTek TAC. 

1251 Internal RAM test error   on the 
MC processor

Contact BioTek TAC. 

1300 Invalid syringe selection Contact BioTek TAC. 
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Code                    Message                       What   to do                     

1301 Syringe module not connected Make sure the Syringe module   is correctly 
connected using the new BioTek-provided 
serial cable. 1302 Syringe initialization error

1303 Syringe sensor not cleared   
error

1304 Invalid syringe dispense   volume See error 1308 below.

1305 Invalid syringe operation Contact BioTek TAC. 

1306 FMEA error on syringe A Contact BioTek TAC. 

1307 FMEA error on syringe B Contact BioTek TAC. 

1308 Invalid Syringe pre-dispense   
volume

Protocol may have been written for a 
different type   of dispense manifold. Make 
sure the Instrument Settings represent the  
installed hardware. Modify the protocol to 
match. 

1309 Invalid Syringe prime volume

1310 Invalid Syringe manifold

1350 Peri-pump (PP) invalid dispense
   volume

Contact BioTek TAC.

1351 PP invalid cassette type Change the cassette type to match the 
protocol requirement   and rerun the protocol.

1352 PP invalid pre-dispense   volume Contact BioTek TAC.

1353 Multiple required cassettes Make sure every Peri-pump step in the 
protocol calls   for the same cassette type. A 
conflict was found. 

1354 PP pump cover (safety door)   
open

Close the pump cover door   and rerun the 
protocol.

1355 PP not installed If you are trying to run a Secondary Peri-
pump, check the cabling in the back of the 
instrument. Otherwise Contact BioTek TAC.

1356 PP Invalid dispense position Contact BioTek TAC. 

1357 PP two dispensers are expected Contact BioTek TAC. 

1404 Plate type restricted This instrument model or the requested 
device does not support the selected plate 
type. Edit the protocol to change the plate 
type.
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Code                    Message                       What   to do                     

1405 Z-axis out of range The requested travel/dispense height cannot 
be reached. The conflict may be caused by a 
combination of variables, plate type, Plate 
Clear or other height settings. Review the 
protocol parameters and instrument settings 
to identify a correction.       

1407 Invalid step type The protocol may have been created for a 
different instrument, it is not compatible 
with this instrument.

1408 Invalid plate geometry Contact BioTek TAC. 

1409 Invalid plate carrier type Contact BioTek TAC. 

1412 Tip clearance error Contact BioTek TAC. 

1413 AutoPrime in progress Contact BioTek TAC. 

1414 AutoPrime aborted Contact BioTek TAC. 

1415 AutoPrime value out of range Contact BioTek TAC. 

1600-
160C

The onboard storage space   
allocated for this function has 
been used up.

Use the LHC ”Manage   Memory” control to 
reallocate space.

160D Not a valid step Contact BioTek TAC.

2400 Parameter limit exceeded Contact BioTek TAC. 

4000 Program locked so operation   
denied

Contact BioTek TAC. 

4010 Program cannot be erased so   
delete denied

Contact BioTek TAC. 

4020 Bad checksum when reading   
program from EEPROM

Contact BioTek TAC. 

4030 Program not found Contact BioTek TAC. 

4040 Can’t save program   because no 
space available

Contact BioTek TAC. 

4050 Program run canceled by   user Restart instrument if this   message is 
unexpected.

8100 Communications NAK Contact BioTek TAC. 
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Code                    Message                       What   to do                     

8101 Timeout while waiting for   serial 
message data

Contact BioTek TAC. 

8102 Instrument busy and unable   to 
process message

Contact BioTek TAC. 

8103 Receive buffer overflow   error Contact BioTek TAC. 

8104 Checksum error Contact BioTek TAC. 

8105 Invalid structure type in   
byMsgStructure header field

Contact BioTek TAC. 

8106 Invalid destination in 
byMsgDestination   header field

Contact BioTek TAC. 

8107 Request object received   not 
supported by instrument

Contact BioTek TAC. 

8108 Message Body size exceeds   
max limit

Contact BioTek TAC. 

8109 Max number of requests 
currently   running and cannot 
run the latest request

Contact BioTek TAC. 

810A No request running when   
response request issued

Contact BioTek TAC. 

810C Response for outstanding   
request not ready yet

Contact BioTek TAC. 

810D To communicate with the   LHC, 
the instrument must be at its 
main menu

The LHC can only talk to   the instrument 
when its main menu is displayed. When the 
instrument is   busy, for example when 
AutoPrime is running, press the Stop button 
on   the keypad, if desired, to end the current 
process and return to the main   menu.

810E One or more request 
parameters   are not valid

Contact BioTek TAC. 

810F The command was received   
while the software was not 
ready to accept that command

Contact BioTek TAC. 

A00 Invalid plate type requested Service Only.
Contact BioTek TAC. 
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Code                    Message                       What   to do                     

A100 -
A10F

Software device not available   Service Only.
Contact BioTek TAC. 

A200 Version strings for multiple   
microprocessors do not match

Service Only.
Contact BioTek TAC. 

A301 +5v logic power supply level   
error

Service Only.
Contact BioTek TAC. 

A302 +24v system/motor power   
supply level error

Service Only.
Contact BioTek TAC. 

A303 +42v   Peri-pump motor power 
supply level error

Service Only.
Contact BioTek TAC. 

A305 +42v Secondary  Peri-pump 
motor power supply level error

Service Only.
Contact BioTek TAC. 

A400 Malloc failed Service Only.
Contact BioTek TAC. 

A500 Multiple tasks attempted   to use 
display simultaneously

Service Only.
Contact BioTek TAC. 

A600 Serial EEPROM access error Service Only.
Contact BioTek TAC. 

A700 Motor truncation error Service Only.
Contact BioTek TAC. 
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MultiFlo-LHC Software Error Codes

Generally,   these errors are caused by protocol parameters that conflict with the   
instrument's onboard settings. The protocol may have been originally created   for a 
different hardware configuration. 

Quick Fix: Make sure your Instrument Settings   accurately reflect your 
instrument’s hardware configuration and   then, modify the protocol to fix any 
invalid parameters. With the MultiFlo   connected to and communicating with your 
computer and its main menu displayed   on the keypad:

 1. Click   the Settings link in the main view.             

 2. In   the Instrument Settings dialog, click the instrument link to get the settings   
from the instrument.             

 3. Modify   the protocol step that generated the error message.             

Error 
Code                    Description                    Help                     

6000 General   communication error during 
download.

See   Communication Errors on page 191 

6001 COM   port created by USB converter 
no longer active

See Communication Port

6002 Invalid   basecode part number; 
instrument is not an MultiFlo

Service   Only.
Contact   BioTek TAC.

6003 Invalid   Basecode Data Version; 
basecode needs to be updated

Contact   BioTek to obtain latest basecode. 

6004 No rows are selected for the specified 
plate type

Modify the protocol to select a row.

6005 Invalid row selection value (must be 
0 or 1)

Contact BioTek TAC.

6006 This instrument can only process 96-
well plates

The protocol may have been created for 
another instrument, change the plate type 
or select another protocol.
 6007 This instrument can only process 

1536-well plates

6008 The 8-tube Syringe Manifold can only 
be used with 96-well plates

Mismatch between installed hardware and 
protocol parameters: change the plate 
type or correct the instrument settings to 
match the currently installed hardware.
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Error 
Code                    Description                    Help                     

 
6009 The 96-tube singe wash manifold can 

only be used with 96-well plates

6010 The   data is invalid or out-of-range. Service   Only.
Contact BioTek TAC.

6011 This   step type cannot be 
downloaded.

Review   the limitations to transferring 
protocols to the instrument, See the LHC   
Help Topic: Transferring Protocols.  

6012 Illegal   characters in protocol name See   the LHC Help topic: Define a 
Protocol.

6013 The   protocol name length must be 
16 characters or less. 

6014 A   1536 well plate is not supported 
by this instrument.

Service   Only.
Contact BioTek TAC. 

6015 The   specified volume exceeds the 
cassette maximum limit.

Modify   the volume or change the 
cassette type.

6016 The   volume is out-of-range. Modify   the volume or change the 
cassette type.

6017 Invalid   flow rate. Learn   about the Syringe Dispense Step  

6018 Invalid   number of 
pre-dispenses.

 
Service   Only.
Contact BioTek TAC.
These   codes indicate an unexpected 
software error that cannot be fixed 
without   BioTek support.
 
 
 
 

6019 Invalid   horizontal dispense position.

6020 Invalid   dispense height.

6021 Invalid   plate clear height.

6022 Invalid   column selection value 
(must be 0 or 1).

6023 Invalid   protocol step type.

6024 The   Definition String contains 
invalid data.

6025 Manifold   conflict between protocol 
requirements and instrument 
configuration.

Change   the Washer Manifold or change 
the Instrument Setting. See Appendix   B 
in the operator's manual.

6026 Valve   module conflict between 
protocol requirements and 

Make   sure the Buffer Switching setting 
matches your instrument; see 
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Error 
Code                    Description                    Help                     

instrument configuration. Instrument   Settings.  

6027 Syringe   module conflict between 
protocol requirements and 
instrument configuration.

Make   sure the Syringe dispenser setting 
matches your instrument: see 
Instrument   Settings.  

6028 Filter   washer conflict between 
protocol requirements and 
instrument configuration.

Service   Only.
Contact BioTek TAC.

6029 Required   cassette does not match 
installed cassette.

Change   the cassette type to match the 
protocol requirement and rerun the 
protocol.

6030 Invalid   cassette type was specified. Service   Only.
Contact BioTek TAC.

6031 Cannot   use a 96-well plate with a 
192-tube manifold.

Modify   the Plate Type or Change the 
Washer Manifold.

6032 Downloading   Protocols is not 
supported.

Service   Only.
Contact BioTek TAC.

6033 This step is not supported for 1536-
well plates.

Fix the plate type or the Instrument 
Settings. A   conflict between the plate type 
and installed hardware devices has been   
detected. 
Change the Plate Type to one supported by 
the washer/dispenser.   Or, click the 
Instrument Settings link and   make sure 
they match the physical hardware: Get 
settings from instrument.

6034 The 32-tube Syringe Manifold is 
required for 1536-well   plates.

6035 The 16-tube Syringe Manifold is 
required for 96-   and 384-well plates.

6036 The 128-tube Washer Manifold is 
required for 1536-well   plates.

6037 The 128-tube Washer Manifold can 
only be used for   1536-well plates.

6038 This step only applies to 1536-well 
plates.

6039 Conflicting column selection Fix the plate map (selected columns to 
dispense   to). A protocol parameter may 
have been changed after a partial plate   
dispense was defined.
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6040 Invalid baud rate Service   Only.
Contact BioTek TAC.
These   codes indicate an unexpected 
software error that cannot be fixed 
without   BioTek support.

 

6041 Invalid data bits selection

6042 Invalid stop bits selection

6043 Invalid parity selection

6044 Serial port error Fix the COM port setting. Check the 
cabling. Click   the Port link and use the 
drop-down menu   to see all active ports. 
Customize the Predefined Protocols to 
avoid   this error in future.
When controlling the BioStack with the 
LHC, make sure the instrument's BioStack 
setting is Manual.

6045 Serial write error

6046 Serial read error

6047 Checksum error Contact BioTek TAC.

6048 Serial NAK error Make sure the COM port setting is correct 
and the   cable is properly connected. 
Restart the instrument. If error reoccurs,   
contact BioTek TAC.

6049 Excess data, or not enough data, 
received.

To correct these errors:

 l Reset the instrument. 

 l Check cables, plug in only one 
communication cable  at a time: 
USB or serial.

 l Try running a different protocol. 
If error reoccurs, contact BioTek TAC. 

6050 Invalid message header

6051 Invalid message object

6052 Invalid message body size

6053 Serial message timeout

6054 Port handle error

6055 Read timeout value is invalid.
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6056 Unauthorized to open the COM port Make sure the COM port setting is correct 
and the   cable is properly connected. 
Restart the instrument. If error reoccurs,   
contact BioTek TAC.

6057 Out-of-range parameter for the open 
port function.

6058 Unable to open the COM port.

6059 Unable to clear the transmission 
buffer.

6060 Unable to close the port.

6061 Port is no longer available.

6062 Unhandled exception while 
transmitting message

Contact BioTek TAC

6063 The selected plate type is not allowed 
with this protocol step

Modify the protocol to change the plate 
type.

6064 The protocol specifies more Peri-
pumps than are available

The protocol may have been created for a 
different instrument. Make sure the 
instrument settings match the current 
instrument and modify the protocol. 

6065 Too few data bytes received from the 
instrument

Contact BioTek TAC.

6066 Ultrasonic cleaning assembly is not 
installed

The protocol may have been created for a 
different instrument. Make sure the 
instrument settings match the current 
instrument and modify the protocol.

6067 The type of Syringe pump is not 
compatible with the syringe manifold

Contact BioTek TAC.

6070 Invalid Syringe specified. Service   Only.
Contact BioTek TAC.
 
These   codes indicate an unexpected 
software error that cannot be fixed 
without   BioTek support.

 

6071 Invalid number of syringe prime 
cycles

6072 Invalid syringe Aspirate Delay value

6073 Invalid X-axis offset value
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6074 Invalid Y-axis offset value Service   Only.
Contact BioTek TAC.
These   codes indicate an unexpected 
software error that cannot be fixed 
without   BioTek support.

 

6075 Invalid Z-axis offset value

6076 Vacuum filtration not allowed with 
1536-well plates.

Modify the protocol to change the plate 
type.

6080 Invalid Peri-pump prime duration Service       Only.
Contact BioTek TAC.
 
These        codes indicate an unexpected 
software error that cannot be fixed 
without       BioTek support.

6085 Invalid minutes:seconds value

6086 Invalid hours:minutes value

6087 'Move carrier home' is required when 
duration exceeds 1 minute.

Contact BioTek TAC

6088 Invalid Shake/Soak options selected Service       Only.
Contact BioTek TAC.
 
These        codes indicate an unexpected 
software error that cannot be fixed 
without       BioTek support.

6089 Invalid Shake Intensity selected

6090 Invalid Washer buffer selected

6091 Invalid Washer Aspirate Delay value

6092 Invalid Washer Aspirate Travel Rate 
value

6093 Invalid Wash Cycles value

6094 Invalid Wash format selected

6095 Invalid Wash Sectors selected

6096 
   

Wash Aspirate Delay value is 
required.

6097 Syringe Dispense Volume must be an 
integer.

6098 Peri-pump cannot run with the pump 
cover open.

Close the pump cover door   and rerun the 
protocol.

6099 Peri-pump assembly not installed. Physically install the Peri-pump and/or 
make sure the instrument settings reflect 
the current state.
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Code                    Description                    Help                     

6100 This functionality requires the 
software to be registered.

You must register the   software with 
BioTek. Select Help>Register 
Software.
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